Notice

The material contained in this manual is believed adequate for the intended use of this instrument. If the instrument or procedures are used for purposes other than those specified herein, confirmation of their suitability must be obtained from TA Instruments. Otherwise, TA Instruments does not guarantee any results and assumes no obligation or liability. This publication is not a license to operate under or a recommendation to infringe upon any process patents.

TA Instruments Instrument, Data Analysis, and Utility Software and their associated manuals are proprietary and copyrighted by TA Instruments, Inc. Purchasers are granted a license to use these software programs on the instrument and controller with which they were purchased. These programs may not be duplicated by the purchaser without the prior written consent of TA Instruments. Each licensed program shall remain the exclusive property of TA Instruments, and no rights or licenses are granted to the purchaser other than as specified above.
This License Agreement is your proof of license. Please treat it as valuable property.

This is a legal agreement between you (either an individual or an entity) and TA Instruments. By breaking the seal on your disk package, you agree to abide by the terms and conditions of this agreement. Failure to comply with the terms of this license terminates the agreement and your rights to use this software.

**TA Instruments Software License**

1. **GRANT OF LICENSE.** This TA Instruments License Agreement ("License") permits you to use one copy of the specified version of the TA Instruments software product identified above ("SOFTWARE"), provided the SOFTWARE is in use on only one computer at any time. If you have multiple Licenses for the SOFTWARE, then at any time you may have as many copies of the SOFTWARE in use as you have Licenses. If the anticipated number of users of the SOFTWARE will exceed the number of applicable Licenses, then you must have a reasonable mechanism or process in place to assure that the number of persons using the SOFTWARE concurrently does not exceed the number of Licenses.

2. **COPYRIGHT.** The SOFTWARE is owned by TA Instruments or its suppliers and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or musical recording).

3. **OTHER RESTRICTIONS.** This TA Instruments License Agreement is your proof of license to exercise the rights granted herein and must be retained by you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License Agreement on a permanent basis provided you transfer this License Agreement, the SOFTWARE, security key(s), and all accompanying written materials and retain no copies, and the recipient agrees to the terms of this Agreement. You may not reverse engineer, decompile, or disassemble the SOFTWARE. Any transfer of the SOFTWARE must include the most recent update and all prior versions.

4. **NO WARRANTY:** The software and documentation are provided on an "as is" basis and all risk is with you. TA Instruments makes no warranties, express, implied, or statutory, as to any matter whatsoever. In particular, any and all warranties of merchantability, fitness for a particular purpose or non-infringement of third parties rights are expressly excluded. Further, TA Instruments makes no representations or warranties that the software and documentation provided are free of errors or viruses or that the software and documentation are suitable for your intended use.

**LIMITATION OF LIABILITY:** In no event shall TA Instruments or its suppliers be liable to you or any other party for any incidental, special, or consequential damages, loss of data, or data being rendered inaccurate, loss of profits or revenue, or interruption of business in any way arising out of or related to the use or inability to use the software and/or documentation, regardless of the form of action, whether in contract, tort (including negligence), strict product liability or otherwise, even if any representative of TA Instruments or its suppliers has been advised of the possibility of such damages.

This License Agreement represents the entire agreement concerning SOFTWARE between you and TA Instruments. It supersedes any prior proposal, representation, or understanding between the parties.
Table of Contents

TA Instruments License Agreement ........................................ iii
TA Instruments Software License ......................................... iii

Table of Contents ................................................................... iv

Hotlines to TA Instruments ..................................................... xiv

Notes, Cautions, and Warnings .............................................. xv

Chapter 1: Introducing the
Universal Analysis 2000 Program .................................. 1-1

Introducing Universal Analysis ............................................. 1-3

Learning the Parts of the Windows ................................. 1-4

Understanding the Tool Bar ............................................... 1-6
Customizing the Tool Bar .................................................... 1-6

Understanding the Main Menu .......................................... 1-7

Using the File Menu ......................................................... 1-9

Using the Edit Menu ....................................................... 1-12

Chapter 2: Handling Data Files ........................................... 2-1

Opening a Data File ......................................................... 2-3

Entering Data File Information .............................................. 2-4
Choosing an Exotherm Direction ......................................... 2-8

Switching Between Open Files .......................................... 2-9

Selecting Signals .............................................................. 2-10

Selecting Units ..................................................................... 2-12
Units and Unit Conversion ................................................. 2-13
Unit Conversions ............................................................... 2-13
DSC Area Units ................................................................. 2-13
DTA, TGA, TMA, DMA, DEA, μTA Area
and Data Type Units ......................................................... 2-13

Thermal Advantage Universal Analysis Operator's Manual
Modifying Instrument Parameters ........................................... 2-14
Poisson's Ratio ....................................................................... 2-15
Performing MDSC® Phase Correction .................................... 2-15
What is Phase Correction? .................................................... 2-15
How Do I Perform MDSC Phase Correction? ....................... 2-15
Choosing the Phase Correction Range ................................. 2-16

Setting Up Your Data for Analysis ......................................... 2-18
Choosing Data Limits ............................................................ 2-18
  Full Range (Data Limits) .................................................. 2-19
  Cursor (Data Limits) ..................................................... 2-19
  Time (Data Limits) ...................................................... 2-19
  Temperature (Data Limits) ............................................. 2-19
  Cycle (Data Limits) ..................................................... 2-19
Excluding Certain Data .......................................................... 2-20
Selecting a Frequency, Amplitude, Location, or Cycle .......... 2-22

Adding/Subtracting Baseline Files .......................................... 2-23
Saving Analyses ................................................................. 2-25
Exporting Data Files ........................................................... 2-25
Saving Program Sessions ..................................................... 2-28
  Saving a Session ......................................................... 2-28
  Recalling a Session ..................................................... 2-28
Editing Parameter Blocks ..................................................... 2-29

Setting Up Windows for Display .......................................... 2-31
  Sizing Windows ......................................................... 2-31
  Arranging Windows ..................................................... 2-31
  Using the Windows Menu ............................................... 2-31

Chapter 3: Setting Program Parameters ............................... 3-1
Introduction .......................................................................... 3-3
Setting Up Your Own Tool Bar ............................................... 3-3
Customizing the Pop-up Menu ............................................... 3-6
Changing Fonts ...................................................................... 3-8
Selecting Program Colors ..................................................... 3-12
  Selecting Individual Colors ............................................ 3-12
  Selecting Color Schemes ................................................ 3-13
Choosing Data Handling Options .................................................. 3-14
    Using the Data Compression Window ..................................... 3-17
Selecting More Options .............................................................. 3-18
Setting Up Export Options ........................................................ 3-20
Choosing Program Directories ..................................................... 3-22
Setting Program Initialization Options ....................................... 3-24
Setting Up Print Options ........................................................... 3-26
Saving Program Parameters ....................................................... 3-27

Chapter 4: Customizing the Graphs .............................................. 4-1
Introduction ................................................................................ 4-3
Using the Zoom Box to Rescale .................................................... 4-3
Rescaling in the X/Y Direction ...................................................... 4-4
Using the Rescale Menu .............................................................. 4-5
    Manual Rescaling ..................................................................... 4-7
Adding a Scale Bar ......................................................................... 4-8
Using the Graph Menu ................................................................. 4-9
Using the Spreadsheet View ........................................................ 4-13
    Characteristics of the Spreadsheet View: ................................ 4-13
Selecting a Y Axis ......................................................................... 4-14
Annotating Graphs ....................................................................... 4-15
    Using the Annotation Pop-Up Menus ....................................... 4-17
Changing Colors, Line Types, Symbols, etc. ............................... 4-19
Adding a Plot Header ..................................................................... 4-21
Creating Plot Legends ................................................................... 4-22
Using Symbols in Curves .............................................................. 4-25
Creating an Inset View ......................................................... 4-26
    Inset View Characteristics ............................................ 4-26
    Setting Up an Inset View .............................................. 4-28

Using the Tools Menu .......................................................... 4-31
    Smoothing Curves .................................................... 4-32
    Shifting Curves ..................................................... 4-33
    Rotating Curves .................................................... 4-35
    Linear Transformation .............................................. 4-37

Overlaying Curves ............................................................ 4-38
    What is Curve Overlay? .............................................. 4-38
    Configuring the Auto Overlay Functions ...................... 4-39
        Step 1: ............................................................ 4-39
        Step 2: ............................................................ 4-39
        Step 3: ............................................................ 4-43
        Step 4: ............................................................ 4-43
    Setting Up the Curve Overlay Options ....................... 4-44
        Configuring the Curves Page ................................. 4-44
        Configuring the Axes Page .................................. 4-47
        Configuring the Plot Heading Page ....................... 4-48
        Configuring the Legend Page ............................... 4-49
    Configuring the Grid Page ......................................... 4-50
    Configuring the Auto Page ........................................ 4-51
    Results of Offset Selections ..................................... 4-52

Exporting Plots ............................................................. 4-54

Printing Plots ............................................................... 4-57
        Print .............................................................. 4-57
        Print Preview .................................................. 4-57
        Print Setup ................................................... 4-57

Chapter 5: Analyzing the Data ........................................... 5-1

Introduction ................................................................. 5-3
        Basic Analysis Steps ........................................... 5-3

Using the Analyze Menu .................................................. 5-4

Using the Analysis Pop-Up Menu ..................................... 5-5

Setting the Analysis Range ............................................ 5-7
        Using the Full Range .......................................... 5-7
        Entering Limits .................................................. 5-7
        Selecting a Cycle ............................................... 5-8
        Selecting a Multiplex Value ................................. 5-9
Tips on Using Markers ................................................................. 5-10
  Active vs. Inactive Markers .................................................... 5-10
  Moving Active Markers ....................................................... 5-11
  Activating a Marker ............................................................. 5-11

Step/Glass Transition Analysis ................................................. 5-12

Weight Change .......................................................................... 5-14

Temp/Time at Weight % ............................................................ 5-16

Weight At Temp/Time ............................................................... 5-17

Weight Loss Temp/Time ............................................................ 5-17

Residue ...................................................................................... 5-18

Modify Size ................................................................................ 5-19
  Using Manual Limits to Modify Size ........................................ 5-20
  Using Graphic Limits to Modify Size ........................................ 5-21
  Using Graphic Start to Modify Size ......................................... 5-22
  Using Graphic Finish to Modify Size ....................................... 5-23

Alpha At X ................................................................................. 5-24

Alpha X1 to X2 ........................................................................... 5-25

Alpha Fit X1 to X2 ...................................................................... 5-26

Dimension Change ...................................................................... 5-27

Integrate Peak ........................................................................... 5-28
  First Peak Integration .......................................................... 5-28
  Additional Peak Integration Analyses ...................................... 5-28
  Result of the Integration Analyses ......................................... 5-29
  Linear Baseline ...................................................................... 5-30
  Description of Sigmoidal Baselines ........................................ 5-31
    Sigmoidal Horizontal Baselines .......................................... 5-31
    Sigmoidal Tangent Baselines .............................................. 5-32
  Extrapolated Baseline .......................................................... 5-33
  Perpendicular Drop Analysis ................................................. 5-34
  Tangent Analysis ................................................................... 5-35
  Deleting Peak Integrations .................................................... 5-36
  Running Integral Analysis ...................................................... 5-36

Peak Max .................................................................................... 5-38
Getting Results Information ........................................ 6-4
  Results Report ..................................................... 6-4
  Results in Spreadsheet Form .................................... 6-5
  Setting Up Results Options ...................................... 6-6

Viewing Data Table Information ................................ 6-7
  Data Table Report ................................................. 6-7
  Data Table in Spreadsheet Form ................................. 6-8

Viewing the Parameter Block ...................................... 6-9

Viewing a Method Log .............................................. 6-10

Looking at the Current Macro ..................................... 6-11

Viewing an Autoqueue Report .................................... 6-12

Viewing an Autoqueue Log ......................................... 6-13

Using the Report Editor ........................................... 6-14
  File Menu (Report Editor) ....................................... 6-14
  Edit Menu (Report Editor) ....................................... 6-16
    Finding Text .................................................. 6-17
    Replacing Text ............................................... 6-17
    Text .......................................................... 6-18
    Space Separators With Tabs ................................ 6-18
    Space Separators With Commas .............................. 6-19
  Insert Menu (Report Editor) .................................... 6-19
  Report Heading (Report Editor) ............................... 6-20
  Help Menu (Report Editor) ..................................... 6-20

Opening the Spreadsheet Program ............................... 6-21

Creating a Custom Report Template ............................ 6-21
  Starting the Custom Report Editor Program ................... 6-22
  Basic Instructions on Creating a Template ................. 6-23
  Setting Up Options ............................................. 6-25
  Using the Custom Report Editor File Menu ................... 6-27
    Setting Up the Custom Report Options ..................... 6-29
  Using the Custom Report Editor Edit Menu .................. 6-33
    Editing Box Properties for the Report Objects .......... 6-34
    Editing Fonts for the Report Objects .................... 6-36
    Editing Parameters for the Report Objects ............... 6-36
      Editing Parameter-Type Report Objects ................ 6-37
      Editing Plot-Type Report Objects ....................... 6-38
      Editing Text-Type Objects ............................... 6-39
    Editing the File Number of a Report Object ............. 6-40
Chapter 7: Getting Help .......................................................... 7-1

Introduction ........................................................................... 7-3

Context-Sensitive Help .......................................................... 7-3

Help Menu Options ............................................................... 7-3

Obtaining a Printed Manual ................................................... 7-6

Contacting TA Instruments ................................................... 7-7
  United States: ................................................................. 7-7
  Overseas: ........................................................................ 7-7

Chapter 8: Autoanalysis .......................................................... 8-1

Introducing Autoanalysis ........................................................ 8-3
  Description of Macros ......................................................... 8-3
  What is a Macro Variable? .................................................. 8-5
    Naming Variables ............................................................ 8-5
    Defined Variables ........................................................... 8-5
  Using the Macros Menu ...................................................... 8-6
  Creating a New Macro ........................................................ 8-10
  Toggling Between Capture On/Off ...................................... 8-12
  Tips on Capturing Macros .................................................. 8-13
  Editing a Macro ................................................................ 8-15
Using the Macro Edit Menu ........................................... 8-16
  Cutting a Step ....................................................... 8-16
  Copying a Step ..................................................... 8-16
  Pasting a Step ..................................................... 8-17
  Deleting a Step .................................................... 8-17
  Deleting Steps From a Certain Position to the End .......... 8-18
  Deleting All Steps ................................................ 8-18
  Modifying a Step ................................................... 8-18
  Watching the Macro List ......................................... 8-20

Using the Macro Insert Menu ....................................... 8-22
  Inserting an Initialization Step .................................. 8-22
  Inserting Dialogs .................................................. 8-23
  Inserting an Assign Clipboard Step ......................... 8-27
  Inserting an Assign Variable Step ............................ 8-28
    Operations ....................................................... 8-29
  Inserting a Test Variable Step ................................ 8-30
  Inserting Jumps .................................................. 8-32
  Inserting a File Name ............................................ 8-32
  Inserting Beeps ................................................... 8-34
  Inserting Delays ................................................ 8-34
  Inserting a Wait OK Step ....................................... 8-35
  Inserting a Wait Accept Limits Step ....................... 8-35
  Inserting a Close All Files Step ............................. 8-35
  Inserting a Stop Macro Step ................................... 8-36
  Inserting an Exit Program Step ................................. 8-36

Running a Macro ...................................................... 8-37

Stopping a Running Macro ......................................... 8-38

Debugging a Macro .................................................. 8-38

Managing Macros .................................................... 8-39
  Selecting/Opening a Macro ..................................... 8-39
  Copying a Macro ................................................ 8-39
  Deleting a Macro ................................................ 8-40
  Importing Macros ................................................ 8-41
  Saving a Macro .................................................. 8-42
  Loading a Different Macro File ............................... 8-42

What is an Autoqueue? .............................................. 8-43
  How the Autoqueue Works ....................................... 8-43
  How Autoanalysis Affects the Universal Analysis Program .................................................. 8-44
  What is the Autoqueue Log? ..................................... 8-44
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How is an Autoqueue Made?</td>
<td>8-45</td>
</tr>
<tr>
<td>Creating an Autoqueue Automatically</td>
<td>8-45</td>
</tr>
<tr>
<td>Creating an Autoqueue Manually</td>
<td>8-46</td>
</tr>
<tr>
<td>Using the Autoqueue File Menu</td>
<td>8-48</td>
</tr>
<tr>
<td>Running the Autoqueue</td>
<td>8-48</td>
</tr>
<tr>
<td>Automatically Running the Autoqueue</td>
<td>8-48</td>
</tr>
<tr>
<td>Importing an Autoqueue File</td>
<td>8-49</td>
</tr>
<tr>
<td>Exporting an Autoqueue File</td>
<td>8-50</td>
</tr>
<tr>
<td>Printing the Autoqueue</td>
<td>8-50</td>
</tr>
<tr>
<td>Print Setup for the Autoqueue</td>
<td>8-50</td>
</tr>
<tr>
<td>Clearing the Autoqueue Log</td>
<td>8-50</td>
</tr>
<tr>
<td>Using the Autoqueue Edit Menu</td>
<td>8-51</td>
</tr>
<tr>
<td>Cutting Autoqueue Records</td>
<td>8-51</td>
</tr>
<tr>
<td>Copying Autoqueue Records</td>
<td>8-52</td>
</tr>
<tr>
<td>Pasting Autoqueue Records</td>
<td>8-52</td>
</tr>
<tr>
<td>Pasting Autoqueue Records at the End</td>
<td>8-53</td>
</tr>
<tr>
<td>Deleting Autoqueue Records</td>
<td>8-53</td>
</tr>
<tr>
<td>Selecting All Autoqueue Records</td>
<td>8-54</td>
</tr>
<tr>
<td>Modifying Autoqueue Records</td>
<td>8-54</td>
</tr>
<tr>
<td>Appending Autoqueue Records</td>
<td>8-55</td>
</tr>
<tr>
<td>Using the Autoqueue Help Menu</td>
<td>8-56</td>
</tr>
<tr>
<td>Appending/Modifying Autoqueue Records</td>
<td>8-57</td>
</tr>
<tr>
<td>Index</td>
<td>I-1</td>
</tr>
</tbody>
</table>
Hotlines to 
TA Instruments

For Technical Assistance ........ (302) 427-4070

To Order Instruments, Software, 
and Supplies .......................... (302) 427-4040

For Service Inquiries ............... (302) 427-4050

Sales ................................. (302) 427-4000
Notes, Cautions, and Warnings

The following conventions are used throughout this guide to point out items of importance to you as you read through the instructions.

**NOTE:**  
A NOTE highlights important information about equipment or procedures.

♦ **CAUTION:**  
A CAUTION emphasizes a procedure that may damage equipment or cause loss of data if not followed correctly.

❗ **WARNING**  
A WARNING indicates a procedure that may be hazardous to the operator or to the environment if not followed correctly.
Chapter 1
Introducing the Universal Analysis 2000 Program

Introducing Universal Analysis .................................................. 1-3
Learning the Parts of the Windows ........................................... 1-4
Understanding the Tool Bar ..................................................... 1-6
  Customizing the Tool Bar ...................................................... 1-6
Understanding the Main Menu ............................................... 1-7
Using the File Menu .............................................................. 1-9
Using the Edit Menu .............................................................. 1-12
Introducing Universal Analysis

The TA Instruments Universal Analysis program for Windows NT® and Windows 95/98/2000® is a powerful data analysis program that can be used to analyze data from any of the following instruments:

- DSC (Differential Scanning Calorimeter)
- High-Temperature DTA (Differential Thermal Analyzer)
- SDT (Simultaneous Differential Technique) Analyzer
- TGA (Thermogravimetric Analyzer)
- DMA (Dynamic Mechanical Analyzer)
- TMA (Thermomechanical Analyzer)
- DEA (Dielectric Analyzer)
- μTA (Micro Thermal Analysis).

Any combination of signals can be plotted and analyzed using Universal Analysis, with the signal type and units easily selected.

The program allows you to select the type and number of curves, region to be graphed and analyzed, the type of transition analysis, and which transitions to be analyzed. Each time you select a graphing or analysis option, the program performs the necessary calculations and displays the graph.

Windows 95® and Windows NT® are a registered trademarks of the Microsoft Corporation.
Introducing Universal Analysis for Windows NT®

Learning the Parts of the Windows

When you open the Universal Analysis program, the first window that appears contains an abbreviated menu and tool bar. After you open one or more data files, the full menu, tool bar, etc. are displayed as shown in the figure below. You can open up to ten Data File windows and one curve overlay plot in Universal Analysis at one time.

To learn more information about the parts of the window, refer to the table shown on the next page.

Figure 1.1
Parts of the Window
## Table 1.1

### Parts of the UA Window

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title Bar Icon</strong></td>
<td>Use this icon to display a drop-down menu that gives you control over the entire window. Double-click on this icon to close a window.</td>
</tr>
<tr>
<td><strong>Window Title Bar</strong></td>
<td>Displays the title of the window and program.</td>
</tr>
<tr>
<td><strong>Minimize/Maximize/Close Buttons</strong></td>
<td>The Minimize button allows the window to remain open, but hides it from view (restore the window from the <strong>Windows</strong> menu). The Maximize button is used to size a window to its maximum size (defined by the size of the controller window). The Close button is used to shut the window.</td>
</tr>
<tr>
<td><strong>Tool Bar</strong></td>
<td>The tool bar buttons perform various functions that can also be found in the menus. They are a quick way to access the operation desired. Position the mouse over the button to display the fly-over button title.</td>
</tr>
<tr>
<td><strong>Data File Title Bar</strong></td>
<td>The title bar of the <strong>Data File</strong> window displays the name of the data file.</td>
</tr>
<tr>
<td><strong>Data File Graph Area</strong></td>
<td>The graph area displays the plot of the points contained in the data file. You can right-click in this area to display a pop-up menu.</td>
</tr>
<tr>
<td><strong>Main Menu</strong></td>
<td>The main menu contains the drop-down menu items needed to operate the program.</td>
</tr>
<tr>
<td><strong>Pop-Up Menu</strong></td>
<td><em>(Not shown)</em> To display a pop-up menu click the right mouse button. There are several different menus available throughout the program.</td>
</tr>
</tbody>
</table>
Understanding the Tool Bar

At the top of the Universal Analysis main window is a tool bar that allows you to perform the same operations found in the menus with the click of a button.

![ToolTip Bar Image]

**Figure 1.2**
*General Tool Bar Buttons*

The figure above shows the general tool bar setup. If you have trouble remembering what the icons represent, just position the cursor over the button and a small rectangle with the name of the button is displayed. This is called “fly-over help,” and is also set up on the Main Options window.

Customizing the Tool Bar

You can customize the tool bar to reflect those options that you use most frequently by selecting File/Options from the menu (or click the button) to display the Main Options window. Click on the Tool Bar page and set up the desired tool bar items. See page 3-3 for detailed information.
Understanding the Main Menu

The main menu is used to access the various functions that can be performed on the data file. When you first open Universal Analysis, a limited menu (shown here) is available.

After you have opened a data file, the rest of the main menu options, shown in the figure and listed in the table below, are available.

**Figure 1.3**
Main Menu

**Table 1.2**
Main Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Use the File menu to open a data file and perform various functions such as closing any open windows, saving analyses, exporting data, printing, etc.</td>
</tr>
<tr>
<td>Edit</td>
<td>Use the Edit menu to perform various editing functions on the current graph such as deleting and adjusting results, adding a scale bar and annotating graphs.</td>
</tr>
<tr>
<td>Rescale</td>
<td>Use the Rescale menu options to change the axis scaling and zoom in on the portion of the graph that will be analyzed.</td>
</tr>
<tr>
<td>Graph</td>
<td>Use the Graph menu to select options that allow you to set up your graphs by changing signals, units, parameters, data limits, overlaying curves, etc. You can also switch to spreadsheet view.</td>
</tr>
</tbody>
</table>

*(continued on next page)*
Table 1.2 (continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze</td>
<td>Use the Analyze menu to choose the type of analysis that you want to perform on the current data file. This menu reflects the type of analyses available for the particular type of data file and curve that is currently active.</td>
</tr>
<tr>
<td>Tools</td>
<td>Use the Tools menu to select from a list of different types of functions that can be performed on the current graph. You can smooth, shift, and/or rotate the curve and perform a linear transformation on either axis. If you change your mind you can remove the curve shifts. You can also select a baseline file using this menu.</td>
</tr>
<tr>
<td>Macros</td>
<td>This menu item is only available if the Auto-analysis option is installed. Use the Macro menu to choose from a menu of functions that can be used to create and edit macros, which are used to perform data analysis automatically. See also: Using the Macros Menu.</td>
</tr>
<tr>
<td>View</td>
<td>Use the View menu to view and edit reports.</td>
</tr>
<tr>
<td>Window</td>
<td>Use the Windows menu to arrange the currently open windows in different configurations.</td>
</tr>
<tr>
<td>Help</td>
<td>Use the Help menu to access help topics, an online manual, and product information.</td>
</tr>
</tbody>
</table>

The first two items on the main menu, the File and Edit menus will be discussed in this chapter. For information on the remaining menus, refer to the appropriate chapter (see the Table of Contents on page v).
Using the File Menu

The File menu (shown here) is used to open a data file and perform various functions, such as closing any open windows, saving analyses, remove analysis results, etc.

For further information on each item contained on the File menu, refer to the table below.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Use the Open menu item to open a TA Instruments data file for analysis using the Universal Analysis program. See Chapter 2 for details.</td>
</tr>
<tr>
<td>Reopen</td>
<td>Use the Reopen menu item to reopen a data file that was recently closed.</td>
</tr>
<tr>
<td>Close</td>
<td>Use the Close option to close the current window.</td>
</tr>
<tr>
<td>Close All</td>
<td>Use the Close All option to close all of the open windows.</td>
</tr>
<tr>
<td>Remove Analysis</td>
<td>Use the Remove Analysis option to delete the saved analysis record stored in the data file. See Chapter 5 for more information.</td>
</tr>
<tr>
<td>Save Analysis</td>
<td>Use the Save Analysis option to save the current analyses in the data file for future recall. See Chapter 5 for more information.</td>
</tr>
<tr>
<td>Save Session</td>
<td>Use the Save Session option to save the current state of the Universal Analysis program to a file for future recall (i.e., curve overlay plot can be saved). See Chapter 2 for more information.</td>
</tr>
</tbody>
</table>

(continued on next page)
### Table 1.3
**File Menu Options (continued)**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Param Block</td>
<td>Use the Edit Parameter Block function to open a window that allows you to edit the data file parameter block, then create and save it as a new data file. We recommend that you do not overwrite the original data file after editing the parameter block information. The altered file may not open properly if you edit the parameter block information incorrectly. If the file is not overwritten, you can go back to the original data file without a problem.</td>
</tr>
<tr>
<td>Options (Main)</td>
<td>Use the Options function to set up the main program options available. See Chapter 3 for more information.</td>
</tr>
<tr>
<td>Export Plot</td>
<td>Use the Export Plot option to export the current graph to the clipboard for retrieval in another program, or to export the graph to a file, plotter, or printer. See Chapter 4 for more information.</td>
</tr>
<tr>
<td>Export Data File</td>
<td>Use the Export Data File option to export the file signals and/or the plot signals in the form of a binary data file, an ASCII data file, or a spreadsheet text file. See Chapter 2 for details.</td>
</tr>
<tr>
<td>Print</td>
<td>Use this command to print a document. This command presents a Print dialog box where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options. The format of the printed plot is determined by the current settings for the printer destination on the Export Plot window. See “Exporting Plots” in Chapter 4 for more details.</td>
</tr>
<tr>
<td></td>
<td>When the Print button, <img src="image" alt="Print Icon" />, is used, the Print dialog box is not shown. The print job is sent directly to the system default printer.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you specify the printer and its connection.</td>
</tr>
</tbody>
</table>

*(continued on next page)*
### Table 1.3
**File Menu Options**
*(continued)*

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print Preview</strong></td>
<td>Use this command to display the active document as it would appear when printed. When you choose this command, the <strong>Print Preview</strong> window is displayed. You can print from this window using the <strong>File/Print</strong> command or close the window without printing it.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Use this command to end your Universal Analysis session.</td>
</tr>
</tbody>
</table>
Using the Edit Menu

The **Edit** menu (example shown here) is used to perform various editing functions on the current graph. The items appearing in the menu will vary depending upon the signals plotted on the graph.

For further information on each item contained on the **Edit** menu, refer to the table below.

<table>
<thead>
<tr>
<th><strong>Menu Item</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Plot</td>
<td>Use the Copy Plot option to copy the plot displayed to the clipboard for retrieval by other applications. The format for the copied plot is determined by the current settings for the clipboard destination on the <strong>Export Plot</strong> window. See “Exporting Plots” in Chapter 4 for more information.</td>
</tr>
<tr>
<td>Select All Labels</td>
<td>Use the Select All Labels option to highlight all of the analysis result labels displayed. You can then move them as a group to a different position on the graph or delete them.</td>
</tr>
<tr>
<td>File Information</td>
<td>Use the File Information option to modify the parameters on the <strong>Data File Information</strong> window. If only text items are changed, the data in memory is not reloaded (i.e., current analyses are not lost). If any other items are changed, the data is reread from the file so the new values (e.g., size, cell constant) can be applied. These changes are not saved to the original data file.</td>
</tr>
<tr>
<td>Annotate</td>
<td>Use the Annotate option to access the <strong>Annotation</strong> window, which allows you to place text on the graph. See Chapter 4 for more information.</td>
</tr>
</tbody>
</table>

*(continued on next page)*
Table 1.4  
*Edit Menu Options*

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Scale Bar</strong></td>
<td>Use the Add Scale Bar function to add a labeled I-bar to denote a unit of distance to the plot. When you select this item the Scale Bar window is displayed.</td>
</tr>
<tr>
<td><strong>Adjust Results</strong></td>
<td>Use the Adjust Results option to fine tune the position of the analysis tangent lines. This option is available after you have performed one of the following analyses: Integrate Peak, Glass Transition, Step Transition, Onset Point, Slope, Oxidation Time/Temperature, or Alpha Fit X1 to X2. See Chapter 5 for details.</td>
</tr>
<tr>
<td><strong>Delete Results</strong></td>
<td>Use the Delete Results option to remove analysis results from the graph displayed. See Chapter 5 for more information.</td>
</tr>
<tr>
<td><strong>/Last</strong></td>
<td>Use the Delete Results/Last option to delete the last data analysis results placed on the plot.</td>
</tr>
<tr>
<td><strong>/Select</strong></td>
<td>Use the Delete Results/Select option to select an analysis result for deletion. A dialog box is displayed for each analysis performed, allowing you to decide whether or not you want to delete that particular analysis.</td>
</tr>
<tr>
<td><strong>/All</strong></td>
<td>Use the Delete Results/All option to delete all of the current analysis results from the plot.</td>
</tr>
<tr>
<td><strong>/Axis-1,2,3...</strong></td>
<td>Use this Delete Results option to remove all of the analysis results from the selected (active) Y axis.</td>
</tr>
<tr>
<td><strong>Exclude Data</strong></td>
<td>Use the Exclude Data option to remove or replace the selected range of data points from the data used for your analysis. It does not alter the data file. Exclude Data can provide a way to create very small data breaks between thermal cycles, which allows each cycle to be distinguished using a different symbol. See Chapter 2 for details.</td>
</tr>
</tbody>
</table>

(continued on next page)
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong>/Frequency/Amplitude/Location/Cycle List</td>
<td>Use this menu item to select the frequencies (DMA and DEA), amplitudes (DMA), locations (μTA), or cycles from the list of those contained in the data file. The list of frequencies, amplitudes, or locations are displayed on the <strong>Frequency/Amplitude/Location Selection</strong> window. See Chapter 2 for more information.</td>
</tr>
</tbody>
</table>
Chapter 2
Handling Data Files

Opening a Data File ................................................................. 2-3
Entering Data File Information .............................................. 2-4
Choosing an Exotherm Direction ........................................... 2-8
Switching Between Open Files ............................................. 2-9
Selecting Signals .................................................................... 2-10
Selecting Units ...................................................................... 2-12
Units and Unit Conversion ................................................... 2-13
Unit Conversions ................................................................. 2-13
DSC Area Units .................................................................... 2-13
DTA, TGA, TMA, DMA, DEA, μTA Area and Data Type Units .... 2-13
Modifying Instrument Parameters ......................................... 2-14
Poisson's Ratio ...................................................................... 2-15
Performing MDSC® Phase Correction .................................... 2-15
What is Phase Correction? .................................................... 2-15
How Do I Perform MDSC Phase Correction? ....................... 2-15
Choosing the Phase Correction Range .................................. 2-16
Setting Up Your Data for Analysis ......................................... 2-18
Choosing Data Limits ........................................................... 2-18
Full Range (Data Limits) ...................................................... 2-19
Cursor (Data Limits) ........................................................... 2-19
Time (Data Limits) ................................................................ 2-19
Temperature (Data Limits) .................................................. 2-19
Cycle (Data Limits) ............................................................. 2-19
Excluding Certain Data ....................................................... 2-20
Selecting a Frequency, Amplitude, Location, or Cycle .......... 2-22
Adding/Subtracting Baseline Files ........................................ 2-23
Saving Analyses .................................................................... 2-25
Exporting Data Files ........................................................... 2-25
Saving Program Sessions ..................................................... 2-28
Saving a Session .................................................................... 2-28
Recalling a Session ............................................................. 2-28
Handling Data Files

Editing Parameter Blocks ................................................................. 2-29

Setting Up Windows for Display ......................................................... 2-31
  Sizing Windows ........................................................................ 2-31
  Arranging Windows ................................................................. 2-31
  Using the Windows Menu ......................................................... 2-31
Opening a Data File

The first step that must be performed when using the Universal Analysis program is to open at least one data file or a session file. If you open a session file, any files that are currently open will be replaced with those contained in the session file.

**NOTE:** Demonstration data files, located in the TAI\Data folder (default directory), have been included with the software to allow you to practice using the program.

Follow the instructions below to locate and open a data or session file.

1. Click on the button or select File/Open from the main menu. The Open Data File window is displayed, see the figure below.

![Open Data File Window](image)

**Figure 2.1** Open File Window

2. Click on the arrow next to the “Look in” drop-down list. Scroll through the available folders until you locate the TAI\Data folder (the default directory), then select the desired instrument type folder.

3. Click on a data filename or hold down the Ctrl key and click on multiple files to open more than one data file. (You can also hold down the Shift key while clicking on files to select a block of files to open.) NOTE: If you choose to open more than one file at a time, the files are all opened using the Quick open option—skip step 4.

4. Select from three checkboxes on the top right side of the window to display information about the selected file in the area below the checkboxes:
   - **Preview** – This option displays a brief list of parameter block entries from the selected (highlighted) data file.
   - **All Text** – This option is used to display a complete list of the parameter block entries from the selected (highlighted) data file.
The information displayed will include all data file information plus signal and calibration information, etc. If the data file chosen was stored in a spreadsheet format, the data points from the file will also be displayed when All Text is selected. If the file chosen is not a TA Instruments data file, Universal Analysis will display any text found in the file up to the first form feed character encountered.

- **Quick Open** – This option is used to open and plot the data file immediately after the Open button is clicked, without first viewing the Data File Information window for that file.

5. Click Open. The **Data File Information** window is displayed, allowing you to confirm the information contained in the data file or the session file is initiated, which replaces any currently open files with those contained in the session file.

**Tip:** You can sort your files in this window by clicking on the button at the top of the window to display the file details and a heading bar (seen below). Click on any of the heading title buttons and the files will be sorted by that classification. The sorting will toggle between ascending order and descending order each time the button is clicked.

### Entering Data File Information

The first window displayed, after you select a data file to open, is the **Data File Information** window, shown in the figure below.

![Figure 2.2 Data File Information Window](image)
Successful analysis of the data is dependent upon the information contained in this window. You need to verify and/or correct this information before beginning the analysis.

Follow the steps below to use this window:

1. Verify or edit the sample name, sample size, operator, method used, and comments on this file.

2. Click on the drop-down list to choose the direction desired for the exotherm, if applicable.

3. Enter or edit the cell constant, if applicable.

4. If the data file contains saved analysis results, you can check the Restore analysis checkbox to return the data file back to the state it was in when Save Analysis was selected—it cancels any analysis and rescale conditions selected after the analysis was saved.

5. Click on any of the buttons at the top of the window to change the: Signals, Units, Instrument Parameters, or Data Limits.

6. Click the OK button when completed.

The following table provides a brief description of each item displayed on the Data File Information window.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Information</td>
<td>This is a display-only field that shows the data file name and date the file was generated.</td>
</tr>
<tr>
<td>Module Type</td>
<td>This is a display-only field that shows the type of instrument used to gather the data.</td>
</tr>
<tr>
<td>Sample Name</td>
<td>Enter the identification of the sample material used in this experiment. Up to 32 characters may be entered. This information will appear in the plot header of the printed graph.</td>
</tr>
<tr>
<td>Sample Size</td>
<td>Enter the sample weight in the appropriate units. This information will appear in the plot header of the printed graph.</td>
</tr>
<tr>
<td>Operator</td>
<td>Enter the name used to identify the person conducting the thermal analysis experiment. Up to 25 characters may be entered. This information will appear in the plot header of the printed graph.</td>
</tr>
</tbody>
</table>

(continued on next page)
### Table 2.1

#### Data File Information Items

**Item** | **Description**
--- | ---
Comments | Enter additional text to help describe the experiment, for example, sample treatment or experimental conditions could be included. Up to 64 characters may be entered. This information will appear in the plot header of the printed graph.

Method | Use this field to enter a short description of the method used to gather this data file. A method file contains an ordered list of segments that will instruct the instrument's functions throughout the course of the experiment. This information will appear in the plot header of the printed graph.

Exotherm Up/Down | Select Exotherm Up to plot your heat flow or temperature difference data in the traditional TA Instruments format, with the exothermic portion of the curve in the upward direction. Select Exotherm Down to plot your data with the exothermic portion of the curve in the downward direction. (See the next section for an example.)

Cell Constant | Cell Constant is a calibration factor used to adjust the calorimetric response of a DSC cell or the thermal expansion of a TMA. The cell constant is the ratio of the known value to the measured experimental variable. Typically, either the heat of fusion of indium (DSC) or the expansion coefficients of aluminum or copper (TMA) are used. The calibration is based on a run made in the calibration mode using the experimental conditions to be used in subsequent measurements.

Restore analysis | Check this box to return the data file back to the state it was in when Save Analysis was selected—it restores any analysis and rescale conditions selected if the analysis was saved.

OK Button | Use OK to save the information entered on the window.

*(continued on the next page)*


### Table 2.1

**Data File Information Items (continued)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel Button</td>
<td>Use the Cancel button to abort the operation.</td>
</tr>
<tr>
<td>Help Button</td>
<td>Use Help to access Help information for the window shown.</td>
</tr>
<tr>
<td>Previous Button</td>
<td>Use the Previous button to return back to the <strong>Open Data File</strong> window, which allows you to select and open a different data file.</td>
</tr>
<tr>
<td>Units Button</td>
<td>Use the Units button to access the <strong>Unit Selection</strong> window, which allows you to specify the units to be used when the data is graphed.</td>
</tr>
<tr>
<td>Instr Params Button</td>
<td>Use the Instrument Parameters button, when available, to access the <strong>Instrument Parameters</strong> window for the data file displayed. This option is only available when a DMA or Modulated DSC file is opened.</td>
</tr>
<tr>
<td>Signals Button</td>
<td>Use the Signals button to access the <strong>Signal Selection</strong> window, which allows you to specify signals from the data file to be graphed.</td>
</tr>
<tr>
<td>Data Limits Button</td>
<td>Use the Data Limits button to access the <strong>Data Limits</strong> window, which allows you to specify a region of the data to be graphed using either Full Range, Time Limits, or Temperature Limits.</td>
</tr>
<tr>
<td>Same As Button</td>
<td>Use the Same As button to copy the settings used in another file to the current file. The settings that are copied include the signals and units selected, graph options, baseline file (if applicable), smoothing, and X-axis scaling.</td>
</tr>
</tbody>
</table>

**NOTE:** The Same As button is only available when multiple files are open.
Choosing an Exotherm Direction

The Exotherm list box, located on the Data File Information window can be used to display the exothermic portion of your heat flow or temperature difference curve in an upward or downward position. See the examples below.

Figure 2.3
Example: Exotherm Up

Figure 2.4
Example: Exotherm Down
Switching Between Open Files

When you have opened more than one data file, you can switch back and forth between them by using any one of the following methods:

- Click on any exposed portion of the desired window to bring it to the front.
- Use the Windows menu to display a list of the open files, then click on the desired file to bring it to the front.
- Rearrange the windows so that they are all in view by using the Windows/Tile option.
Selecting Signals

When a data file is plotted, the graph displayed reflects the signal and signal type for the x and y axes chosen. You can change the signals and signal type before analyzing the file, if desired.

To select signals follow these steps:

1. Select Graph/Signals from the main menu (or the Signal button from the Data File Information window). The Signal Selection window (shown below) is displayed.

![Signal Selection Window]

2. Click on the arrow to the right of the Signals field, then click on the desired signal for the Y1 axis. (You can choose “None,” if you do not want to plot a Y1 axis).

3. Click on the arrow to the right of the Type field, then click on the desired signal type for the Y1 axis.

4. Repeat steps 2 and 3 for each remaining Y-axis.
5. Click on the radio button next to the desired signal for the X axis. You can choose from time, temperature, or from a drop-down list of signals. If you make a selection from the Signals drop-down list, you need to choose a Type as well.

**NOTE:** You can switch between the X-axis signals specified here (time, temperature, or signal) using the **Graph/X Axis** function.

6. Click the **Save** button, if you want to use these as your new default settings the next time a file of the same type is opened or click the **OK** button to use these settings for this session only.

All derivative curves are automatically smoothed when the curve is drawn. You can change the smoothing interval with **Tools/Smooth**. See Chapter 4 for further information.

**NOTE:** If a file has already been opened and analyzed, selecting signals rereads the data file and erases analysis results.
Selecting Units

When graphing signals, you can change the units displayed. To select units, follow these steps:

1. Select Graph/Units from the main menu (or the Units button from the Data File Information window). The Units Selection window (shown below) is displayed. This window is used to change the units used for the selected signals.

![Units Selection Window](image)

Figure 2.6
Units Selection Window

2. Click on the arrow to the right of the field to display a drop-down list of available units for each type of instrument signal. You can click on the Default button to have all units fields set to their default units selection.

3. Click the Save button, if you want to use these as your new default settings for the current instrument type or click the OK button to use these settings for this session only.

NOTE: If the default units are normalized units, and a zero sample size is specified, the program will automatically plot the data using the units that are not normalized.
Units and Unit Conversion

The Universal Analysis program can convert most primary signal units to other units. Available unit conversions are shown on the Units Selection window.

Unit Conversions

<table>
<thead>
<tr>
<th>Unit Conversion</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temp(°F) to Temp(°C)</td>
<td>Temp(°C) x 9/5 + 32</td>
</tr>
<tr>
<td>Temp (K) to Temp(°C)</td>
<td>Temp(°C) + 273.15</td>
</tr>
<tr>
<td>Area(mcal/sec) to Area(mW)</td>
<td>Area(mW)/4.184</td>
</tr>
<tr>
<td>Area(W/g) to Area(mW)/size(mg)</td>
<td>Area(mW)/size(mg)</td>
</tr>
<tr>
<td>Area(cal/sec/g) to Area(mW)/4.184/size(mg)</td>
<td>Area(mW)/4.184/size(mg)</td>
</tr>
<tr>
<td>Area(°C/mg) to Area(°C)/size(mg)</td>
<td>Area(°C)/size(mg)</td>
</tr>
<tr>
<td>Area(%) to Area(mg) x 100%(mg)</td>
<td>Area(mg) x 100%(mg)</td>
</tr>
<tr>
<td>Area(mm) to Area(μm)/1000(μm/mm)</td>
<td>Area(μm)/1000(μm/mm)</td>
</tr>
<tr>
<td>Area(%) to Area(μm) x 100%/10000(μm)/size(mg)</td>
<td>Area(μm)/1000(μm/mm)/size(mg)</td>
</tr>
<tr>
<td>Area(μm/m) to Area(μm) x 1E6(μm/m)/size(mm)</td>
<td>Area(μm)/1E6(μm/m)/size(mm)</td>
</tr>
<tr>
<td>Area(ppm) to Area(μm) x 1E6(ppm)/size(mm)</td>
<td>Area(μm)/1E6(ppm)/size(mm)</td>
</tr>
</tbody>
</table>

DSC Area Units

<table>
<thead>
<tr>
<th>Units</th>
<th>Area Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>mw</td>
<td>mJ</td>
</tr>
<tr>
<td>mcal/sec</td>
<td>mcal</td>
</tr>
<tr>
<td>W/g</td>
<td>J/g</td>
</tr>
<tr>
<td>Cal/sec/g</td>
<td>cal/g</td>
</tr>
</tbody>
</table>

DTA, TGA, TMA, DMA, DEA, μTA Area and Data Type Units

<table>
<thead>
<tr>
<th>Area Units</th>
<th>yt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>y</td>
</tr>
<tr>
<td>Derivative</td>
<td>y/x</td>
</tr>
<tr>
<td>2nd Derivative</td>
<td>y/x²</td>
</tr>
<tr>
<td>3rd Derivative</td>
<td>y/x³</td>
</tr>
</tbody>
</table>

where:  x = current X-axis units
        y = current Y-axis units
        t = time units

3rd derivative units are the slope units for the 2nd derivative curves.
Modifying Instrument Parameters

When you analyze DMA or MDSC data files you can modify the instrument parameters that are used to calculate the data as follows:

1. Select Graph/Instrument Params. The DMA Instrument Parameters or MDSC Instrument Parameters window, appropriate for the instrument data file, is displayed.

![Figure 2.7 DMA 2980 Instrument Parameters Window](Image)

2. Select or edit instrument parameters displayed. See page 2-15 for information on Poisson’s Ratio and for information on the MDSC phase correction.

3. Click on the OK button when completed.
**Poisson’s Ratio**

Poisson’s ratio is a DMA parameter that defines the ratio of transverse contraction per unit dimension to the elongation per unit length, when the sample is subjected to a tensile stress. You can select Poisson’s ratio by selecting **Graph/Instrument Params** from the Universal Analysis program’s main menu. The recommended parameters are:

- 0.5 for rubber materials
- 0.33 for metals
- 0.44 for most plastics.

Enter the value needed for the type of material being analyzed by the program.

**Performing MDSC® Phase Correction**

**What is Phase Correction?**

Modulated DSC (MDSC®) analysis has generally been used to measure the heat capacity (Cp) of a material. However, the MDSC technique can also be used to calculate phase lag and its contribution to the measured heat capacity signal. The **Thermal Advantage** Universal Analysis program contains algorithms that allow you to calculate the Reversing Heat Capacity and Nonreversing Heat Capacity signals, as well as the phase corrected Reversing Heat Flow and Nonreversing Heat Flow signals. Total heat flow is not affected by deviations in the heat flow phase.

**How Do I Perform MDSC Phase Correction?**

MDSC phase correction can be done using the automatic calculations as follows:

1. Gather the data. When you are gathering data to be analyzed for MDSC phase correction, make sure that certain signals have been saved to the data file. Use the **Thermal Advantage Mode Parameters** window in the DSC Instrument Control program to save the following signals: Heat Flow, Reversing Heat Flow, Nonreversing Heat Flow, Complex Heat Capacity (Cp), and Heat Flow Phase.

   If the Complex Heat Capacity and Heat Flow Phase signals are contained in the data file, the MDSC phase correction options will be available during the use of the program.
2. Start Universal Analysis and open the MDSC® data file.

3. Plot these signals using the **Signal Selection** window: Heat Flow, Complex Heat Capacity (Cp), and Heat Flow Phase.

**NOTE:** There are additional heat capacity signals, labeled "Reversing Cp" and "Kinetic Cp." Reversing Cp is identical to Complex Cp and Kinetic Cp is equal to zero, until the phase correction is performed.

4. Determine where you wish to place the phase correction limits by examining the signals. Use the **Analyze/Curve Value** function, if necessary, to determine point values.

5. Select **Graph/Instrument Params**, then select the MDSC phase correction mode and the start and stop limits on the **Instrument Parameters** - MDSC window. The following phase corrections will be performed on the curve:

   - The Heat Flow Phase signal is shifted and rotated to zero baseline as specified on the **Instrument Parameters** - MDSC window.

   - The Reversing Heat Capacity and Kinetic Heat Capacity signals are calculated.

   - The original Reversing Heat Flow and Nonreversing Heat Flow signals are recalculated with phase correction applied.

### Choosing the Phase Correction Range

Part of the MDSC phase correction procedure involves choosing the phase correction range. When selecting the limits to define the phase correction range, you should consider the following factors:

- **Transition of Interest** - Phase lag is generally more predominant during a transition, but negligible in the baseline region. Transitions containing large kinetic (nonreversing) heat flows tend to contain the highest degree of phase lag.

- **Baseline and Purge Gas** - The phase correction algorithm uses the Heat Flow Phase signal to calculate the Reversing Cp and Kinetic Cp signals. The accuracy of these signals depends on a flat Heat Flow Phase baseline.
If you use helium as the purge gas, the Heat Flow Phase baseline will be flat with a slight positive slope. If you use nitrogen as the purge gas, the decreased thermal conductivity of nitrogen can cause some baseline curvature.

Narrow temperature ranges will also minimize the total degree of curvature across the selected region.

Therefore, for the best phase correction results, select a narrow phase correction range that contains a flat Heat Flow Phase baseline.
Handling Data Files

Setting Up Your Data for Analysis

The data contained in a data file can be selected for use in analyses in many different configurations. You can select to use all or just part of the data by setting limits on the data, choosing a certain amplitude or frequency (if applicable), excluding particular data, etc. This section provides information on ways to select the data you want to include in your graph for analysis.

Choosing Data Limits

You can use the entire contents of the data file for analysis, or you can place constraints on the amount and type of data used for analysis by choosing specific data limits.

- If you are starting from the Data File Information window, click the Data Limits button to display the Data Limits window, shown in the figure below. Select the radio button desired, then select the desired values (when applicable) to place limits on the data.

![Data Limits Window](image)

*Figure 2.9 Data Limits Window*

- If you are starting from an open data file, select Graph/Data Limits from the main menu to display the Data Limits menu (shown here). Choose from one of the options shown here and described in further detail below.

After you have selected the desired data limits, the graph is redrawn using the limits chosen. From that point you can proceed to customize or analyze the data, etc.
When new data limits are selected, any existing analysis results or data modification (Shift, Rotate, Linear Transformation, or Excluded Data) will be discarded.

Only data points that fall within the specified data limits are read from the data file and stored in the program data buffer. All other data points are unavailable for plotting and analysis.

**Full Range (Data Limits)**

The **Full Range** data limits option is used to provide the entire range of data points that are available in the data file for analysis. This option is also used to update the data displayed from an active experiment.

**Cursor (Data Limits)**

The **Cursor** option is used to display markers that allow you to manually select the data points that will be used for analysis.

1. Position the first marker at the beginning of the region you wish to select.
2. Position the next marker at the end of the region you want to select.
3. Right click to display the pop-up menu and select **Accept Limits** (or press the Enter key). The selected data range is read from the data file and displayed.

**Time (Data Limits)**

The **Time Limits** option is used to limit the data used for analysis to a specific time range of the data.

**Temperature (Data Limits)**

The **Temperature Limits** option is used to limit the data used for analysis to a specific temperature range of the data.

**Cycle (Data Limits)**

The **Cycle Limits** option is used to limit the data used for analysis to a specific data cycle range. This option is valid if you have any data breaks or markers in your file, these can include the following:

- Cycle marks (due to Mark Cycle End segments in a procedure)
- Data breaks due to gas switch or event mark (selected on the Main Options – Data Page), or other data breaks.
Excluding Certain Data

Removing or adjusting a range of data points can be used to correct explainable anomalies in the data, or to provide a way to create very small data breaks between thermal cycles, which allows each cycle to be distinguished using a different symbol. For example, gas composition changes, heat/cool steps, etc. can be distinguished using symbols. Use the Edit/Exclude Data option to remove the selected range of data points from the data used for your analysis. It does not alter the data file.

To remove data points, follow these steps:

1. Select Edit/Exclude Data from the main menu. Markers will be displayed on the graph.

2. Position the first marker at the beginning of the region you wish to remove.

3. Position the next marker at the end of the region you want to remove.

4. Right click to display the pop-up menu and select Accept Limits or press Enter. The curve is displayed with the selected data excluded.

5. Click on one of the following options:

   • **Marked as invalid data**: Use this option to remove the selected data from the graph. When you click on this option on the Exclude Data window, it results in the removal of the selected data range from the graph, creating a discontinuous data region between the selection limits.

   This option provides a way to create very small data breaks between thermal cycles, which allows each cycle to be distinguished using a different symbol.

   • **Fitted to a straight line**: Use this option to remove the selected data from the graph and have a straight line fitted in its place. When you click on this option on the Exclude Data window, it results in the removal of the selected data range from the graph and the program draws a straight line between the data points adjacent to the deleted data.

   • **Smoothed and blended**: Use this option to smooth and blend the data chosen for exclusion. When you click on this option on the Exclude Data window, the program smooths and blends the selected data limits with the data adjacent to it. The range of blending is approximately equal to the data exclusion range.
• **Removed and blended**: Use this option to remove the data chosen for exclusion, then blend the adjacent data remaining. When you click on this option on the Exclude Data window, the program deletes the selected data limits, then blends that gap in the graph with the data adjacent to it.

**NOTE:** Use caution when selecting the data exclusion range for all "blended" options. The blending region extends over a range that is approximately three times the width of the exclusion range. Transitions that are in close proximity to the exclusion range may be altered. If necessary, perform multiple smaller exclusions or select the *Fitted to a straight line* option and then smooth and blend the region around the straight line end points.

6. Select OK. The results will be displayed.

**NOTE:** To restore the graph to the original data, use Graph/Data Limits/Full Range.

After you have excluded the desired data, the graph is redrawn using the data chosen. From that point you can proceed to customize or analyze the data, etc.
Selecting a Frequency, Amplitude, Location, or Cycle

When a data file contains either breaks in the data, gas switch and event markers, or multiplexed data (i.e., a family of curves within the data file, such as multifrequency, multiamplitude, or multilocation curves), you may want to selectively display one or more curves. This function is particularly useful when performing data analysis.

Follow these steps to select a specific multiplex value:

1. Select Edit/Frequency List or Edit/Amplitude List or Edit/Location List or Edit/Cycle List from the main menu. The appropriate window is displayed. Use this window (example shown below) to select the frequencies, amplitudes, locations, or cycles that you want to use for analysis from the list of those contained in the data file.

   ![Frequency Selection Window]

   Cycles are defined by any breaks in the data (Data on/off regions) or gas switch and event markers, if enabled on the Main Options – Data Page.

2. Select the desired value from the list displayed. At least one multiplex value must be selected. You can use one of these methods:
   
   - Click on the box next to the values desired.
   - Click the All button to select all of the values contained in the list.
   - Click the None button to clear all values, then check the one(s) desired.

3. Click on the OK button when finished.

After you have selected the desired data, the graph is redrawn using the data chosen. From that point you can proceed to customize or analyze the data, etc. Analyses performed on unselected values are not lost. They are restored when that value is selected again.
Adding/Subtracting Baseline Files

You can use two data files that have been obtained from the same instrument and combine their data (by addition or subtraction) in a way that enables you to create a new modified sample signal. File addition or subtraction requires the use of two data files, a sample and a baseline reference file, to create a modified sample signal(s).

Follow the steps below to either subtract or add the baseline:

1. Open the baseline reference file and plot the signals that will be used to perform operations on the new data file.

2. Open the desired sample file and select the desired signals that will be used to perform operations with the baseline file. (Or use Graph/Params Same As to copy the parameters.)

3. Make sure that the sample data file window is currently active.

4. Select Tools/Baseline from the main menu. A list of the open, compatible files will be displayed as shown here. (None is displayed when no baseline file is used.)

5. Click on the desired reference file to be used as the baseline. The Baseline File window is displayed as shown in the figure on the next page.

6. Check the desired signal(s) from those shown.

7. Click on the desired base: time or temperature (see below).

   - **Time Base** enables the operation to be performed using data values from the same point in time. If data values do not have times that correspond exactly, the data points are interpolated. This option is useful for cyclic data.

**NOTE:** Because this operation matches signal values on the basis of time alone, the sample and reference baseline files should have the same time/temperature profile; that is, they should have been created using the same method.
Handling Data Files

- **Temperature Base** enables the operation to be performed using data values that have the same temperature. If data values do not have temperatures that correspond exactly, the data points are interpolated. This option is useful for the majority of data files.

**NOTE:**

The best results are obtained when heating rates are the same.

8. Click on the desired operation: add or subtract the baseline file.

9. Click the OK button. A baseline signal will be added to or subtracted from each data file signal that has the same units. The resulting data is displayed.

![Baseline File Window](image)

**Figure 2.11**
Baseline File Window

**NOTE:**

Those signals that are not compatible between the files are not used.
Saving Analyses

When you have finished performing all of the functions you desire on a data file you can save it with the original filename or save it under another name using the File/Save Analysis option. The standard window is displayed allowing you to select a filename and location for the data analysis file.

Once an analysis has been saved in a data file, the analysis results can be retrieved by selecting the Restore button on the Data File Information window. See “Entering Data File Information” in this chapter.

Another way to save a modified file is to use the File/Export Data File function, which is described in the next section.

NOTE: Saved analyses that have been performed using the DOS version of Universal Analysis are restorable using this program. However, if you overwrite the DOS analyses with this program, the original record of analyses can no longer be used for the DOS Universal Analysis program.

Exporting Data Files

Universal Analysis provides the ability to export the file signals and/or the plot signals in the form of a binary data file, an ASCII data file, or a spread sheet text file. This will let you use your data in other software applications such as spread sheet programs and word-processing programs for reports, etc.

To export your data files, select File/Export Data File from the main menu. The menu shown here is displayed. The menu items found on the Export Data File menu are used for the following purposes:

- **TTS Signals**: Use this option to export selected DMA or DEA Time-Temperature Superposition (TTS) signals from the data file.

- **File Signals Only**: Use this option to export selected signals from the data file only.

- **Plot Signals Only**: Use this option to export selected signals from the plot only.

- **File and Plot Signals**: Use this option to export selected signals from the data file and the plot.

Select one of the options described above, the Export Data File window is displayed. See the figure shown on the next page.
Handling Data Files

Follow these instructions to continue with the export procedure:

1. Click to check or uncheck the output signals displayed. The checked output signals will be exported. You can limit the output signals by selecting only those signals that you want to save in the exported file. (At least one signal must be selected.)

2. Click on the desired type of export file:
   - **Binary** format (standard file format) saves the files in a special binary format. This format stores the data in an efficient, compact form and preserves the method log information.
   - **ASCII** (American Standard Code for Information Interchange) format saves the data file in a text format that allows the data file to be imported into other software packages, or transmitted conveniently through serial communication protocols.
   - **Spread Sheet** format saves the data file in a "tab-delimited" spread sheet-compatible ASCII text format, which places the data in columns. This format is compatible with most commercial spread sheet programs. When importing or exporting this file format, select "Tab delimited text" format in the spread sheet program.
3. Choose the desired character set: OEM or Windows. Universal Analysis can handle both the OEM (PC-8) and the Windows (ANSI) character sets in data files. The OEM (PC-8) character set originated with the Disk Operating System (DOS) and the first personal computers. The OEM character set contains the original 128 ASCII characters plus an additional 128 special symbols (including the degrees symbol, the micro symbol, etc). The Windows character set was developed by Microsoft® Corporation for use with their Windows operating system. The Windows character set also contains the original 128 ASCII characters, but a different set of 128 special symbols is used.

4. Click on the desired export options:

- **No parameter block** exports the data file without any parameter block information. Note that if you check this option, the exported file will not be able to be opened in Universal Analysis as a data file, because there will no longer be any parameter block information available. Leave this box unchecked (default) to export your data file with the parameter block information intact.

- **No data breaks or flags** exports your data file without any data breaks or data flags such as cycle markers, gas on/off changes, or event on/off changes. This allows you to remove data breaks that may hinder your use of the data in spreadsheet applications. When this item is checked, the minus time flags are removed from the data and all points appear connected. Leave this box unchecked (default) to export your data file as it is, with all data breaks or flags intact.

- **No invalid data points** removes any invalid data points that are present in the data file from the exported data file. These invalid points will be replaced with a single data break for each group of invalid points. **NOTE**: If the option No data breaks or flags is checked along with this checkbox, no data break will be inserted in place of the invalid points in the exported data file. Leave this box unchecked (default condition) to export your data file as it is, with all invalid data points included.

5. Click on the Finish button when completed to specify an export filename and location.

**NOTE:** The data file information displayed on the window can be selected and copied, but it cannot be altered here. To change the data file information shown on the Export Data File window, you must alter it on the initial Data File Information window when the file is first opened.
Handling Data Files

NOTE: This function also allows you to save data that has been modified with the options found in the Tools menu and the Edit/Exclude Data menu (except the “Marked as invalid data” option).

Saving Program Sessions

After you have spent time setting up and configuring an overlay plot, you may find that you would like to save all of that work so that you can come back later and do more work on that plot. You can save the work you have already done by saving the program session.

You can also use the Save Session function to save the current state of the program, including all settings, open file information, and data read into memory. This function can also be used to save the analysis results from multiple data files into a single session file. This way you can turn off or restart your computer, or let someone else use the program, without losing the work you have already done. You can later restore the program to the state it was in when you saved the session.

Saving a Session

Select File/Save Session from the main menu. Then select the drive and directory location and enter the filename. It is recommended that you save session files using a specific extension that allows you to recognize the session files (use .sav for example).

NOTE: The data files will not be saved with the session file. The associated data files should be saved separately. If the data files must be reread for a particular function (changing data limits; smoothing curves; changing signals, units, or instrument parameters), the data file must be present—a session file alone will not suffice.

Recalling a Session

To recall a saved session, simply open a session file using the File/Open function. Any files currently open in the program will be replaced by the ones contained in the session file.

NOTE: Saved session files from the DOS Universal Analysis program cannot be opened with this program. An error message will be displayed, if you attempt to open one.
Editing Parameter Blocks

There may be times when you would like to change the information that is contained in the parameter block of a data file. Perhaps someone put their name in as the operator and you would like to change it to your company's name and use the file for a demonstration, etc. You can use the File/Edit Param Block function to make an exact copy of the current data file and to edit the parameter block information that is stored in the new file.

Follow these steps to edit parameter block information:

1. Select File/Edit Param Block from the main menu. The Edit Parameter Block window, shown in the figure below is displayed.

2. Place the cursor in the text string that you wish to change and edit the characters as desired.
NOTE: It is best to edit only those parameters that you are familiar with. Editing sample name, operator, comments, etc. will not affect the handling of the data file. Some parameters are used by the Universal Analysis program to perform certain functions—those parameters can be altered also, but doing so may cause problems in the functioning of the program when the altered file is used.

3. Click the Finish button to display a window that allows you to save the new data file.

NOTE: We recommend that you do not overwrite the original data file after editing the parameter block information. The altered file may not open properly if you edit the parameter block information incorrectly. If the file is not overwritten, you can go back to the original file without a problem.

4. Enter the new filename and location. Then click Save.

NOTE: If the current data file contains a method log or saved analysis, it will be copied to the new data file.
Setting Up Windows for Display

While you are using the Universal Analysis program you may have several data files open at the same time. You can arrange and size these windows different ways for viewing.

Sizing Windows

To resize a window follow these directions:

Move the pointer over any outer edge or corner of the window until the cursor becomes a double-headed arrow. Then hold down the left mouse button and pull the mouse in the direction that you want to make the window smaller or larger.

Arranging Windows

To rearrange the data file windows follow any of these directions:

- You can manually drag the window by moving the pointer to the top of the window's title bar, holding down the left mouse button and dragging the window to its desired position.

- You can use the Windows menu, as described in the next section, to arrange the open data file windows.

Using the Windows Menu

The Windows menu is used to arrange the currently open windows in different configurations. Select the Windows menu (shown here) from the main menu.

The menu items found on the Windows menu are used for the following purposes:

- **Tile**: Use this command to arrange multiple opened windows in a non-overlapped fashion. See the figure on the next page for an example.
Handling Data Files

Figure 2.14
Example of Tiled Windows

- **Cascade**: Use this command to arrange multiple opened windows in an overlapped fashion. See the figure below for an example.

Figure 2.15
Example of Cascaded Windows
• **Arrange Icons**: Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an open document window at the bottom of the main window, then some or all of the icons may not be visible because they will be underneath this document window.

• **Stay On Top**: Check this function to keep the Universal Analysis program window on top of any other open application windows.

• **1 Filename A, 2 Filename B, etc.**: Click on the name of the file desired to bring the chosen window to the front.
Chapter 3
Setting Program Parameters

Introduction ................................................................. 3-3
Setting Up Your Own Tool Bar ........................................ 3-3
Customizing the Pop-up Menu ......................................... 3-6
Changing Fonts .............................................................. 3-8
Selecting Program Colors ............................................. 3-12
   Selecting Individual Colors ....................................... 3-12
   Selecting Color Schemes .......................................... 3-13
Choosing Data Handling Options .................................... 3-14
   Using the Data Compression Window ......................... 3-17
Selecting More Options ............................................... 3-18
Setting Up Export Options .......................................... 3-20
Choosing Program Directories ....................................... 3-22
Setting Program Initialization Options ............................ 3-24
Setting Up Print Options ............................................. 3-26
Saving Program Parameters ......................................... 3-27
Introduction

The TA Instruments Universal Analysis program lets you set up certain programming options that can be set and then recalled each time you open the program. This chapter discusses these program parameters and provides instructions on what each option is used for and how to set it up the way you want it to be.

Setting Up Your Own Tool Bar

General Tool Bar Buttons

Tool bars, such as the tool bar above, can be very useful objects, but only if you can recognize and use the options that are displayed there. If the options you use frequently are found on the tool bar, it is a very useful tool. We kept that in mind when we designed the Universal Analysis program. You can set up the tool bar that is displayed at the top of the Universal Analysis window to suit your own needs as follows:

1. Select File/Options from the main menu. The Main Options - Tool Bar Page is displayed.
2. Select the buttons that you want to display on the tool bar by using one of two methods:

   a. Check each desired function button name from the scrollable button list shown. This list corresponds to the menu items performing the same function.

   or

   b. Click on the button that selects the default functions that apply to the button label. For example, you can click on the TGA button to select the icons for the most common functions that apply to the TGA instrument.

3. Check each option that you want to use for your tool bar: Show tool bar, Flat buttons, Flyover help.

4. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

See the table below for an explanation of each of the items found on the Main Options - Tool Bar Page.

**Table 3.1**  
**Tool Bar Page Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Button</td>
<td>Click this button to select all of the options shown.</td>
</tr>
<tr>
<td>None Button</td>
<td>Click this button to select none of the options shown.</td>
</tr>
<tr>
<td>DSC Button</td>
<td>Click this button to select the buttons applying to the most common functions available for the DSC (Differential Scanning Calorimeter) for display on the tool bar.</td>
</tr>
<tr>
<td>TGA Button</td>
<td>Click this button to select the buttons applying to the most common functions available for the TGA (Thermogravimetric Analyzer) for display on the tool bar.</td>
</tr>
</tbody>
</table>

*(continued on next page)*
### Table 3.1

**Tool Bar Page Options (continued)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMA Button</td>
<td>Click this button to select the buttons applying to the most common functions available for the TMA (Thermomechanical Analyzer) for display on the tool bar.</td>
</tr>
<tr>
<td>DMA Button</td>
<td>Click this button to select the buttons applying to the most common functions available for the DMA (Dynamic Mechanical Analyzer) for display on the tool bar.</td>
</tr>
<tr>
<td>General Button</td>
<td>Click this button to select the most common functions that apply to all thermal analysis instruments.</td>
</tr>
<tr>
<td>Show Tool Bar</td>
<td>Check this box to display the tool bar on the main window of the Universal Analysis program. If the box is not checked, no tool bar is displayed.</td>
</tr>
<tr>
<td>Flat Buttons</td>
<td>Check this box to display the buttons in a one-dimensional fashion (flat). If the box is not checked, the buttons will display with a three-dimensional look.</td>
</tr>
<tr>
<td>Fly-over Help</td>
<td>Check this box to display a small text box, called fly-over help, containing the name of the button as you move the pointer over the buttons. (This type of help is also called tool tip help or screen tip help.) If this box is not checked, no fly-over help is displayed.</td>
</tr>
</tbody>
</table>
Customizing the Pop-up Menu

After you have opened and graphed at least one data file, you can display the main pop-up menu (shown here) by clicking the right mouse button. You can customize the items that appear on the main pop-up menu every time the menu is displayed. You can set up the main pop-up menu to suit your own needs as follows:

1. Select **File/Options** from the main menu, then click on the **Pop-Up Menu** tab at the top of the window. The **Main Options - Pop-Up Menu Page** is displayed, see the figure on the next page.

2. Select the menu items that you want to display by using one of two methods:
   a. Check each desired menu name from the scrollable menu item list.
      or
   b. Click on the button that selects the default menu items that apply to the button label. For example, you can click on the General button to use only the most common menu items.

3. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:** Pop-up menu items that are selected for display, but are not valid when the pop-up menu is activated will not appear.
Customizing the Pop-up Menu

Figure 3.2
Main Options - Pop-up Menu Page
Changing Fonts

Fonts can be changed in specific places in the Universal Analysis program. You can change fonts that are used in printing out the graphs and when viewing or printing reports. The displayed graph fonts cannot be changed.

Use the **Font page** of the **Main Options** window to set up the fonts that appear on the printed curve. Changing fonts here will not affect the graphs displayed on your monitor. To check the size and position of the text on the graph before it is printed, use the **File/Print Preview** option.

You can set up the fonts to suit your own needs as follows:

1. Select **File/Options** from the main menu, then click on the Font tab at the top of the window. The **Main Options - Font Page**, shown below, is displayed.

![Main Options - Font Page](image)

**Figure 3.3**
**Main Options - Font Page**

2. Click on the button bearing the name of the part of the graph that will have font adjustments. See the figure on the next page for the location of these graph parts and the table for a description of each item on the **Font** page.
Figure 3.4
Parts of a Graph

Table 3.2
Font Page Items

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plot Header Button</td>
<td>Use this button to edit the font used for the header appearing at the top of the graph. The header includes the sample name and filename. (Additional header information—size, method name, comment, and date—appears on the printed graph.)</td>
</tr>
<tr>
<td>Overlay Header Button</td>
<td>Use this button to edit the font used for the header appearing at the top of the printed overlay graph. The header includes the customizable text that is entered on the Curve Overlay Options – Plot Heading Page.</td>
</tr>
<tr>
<td>Axis Names Button</td>
<td>Use this button to edit the font used for the axis names appearing at the sides of the graph. The axis names include the X- and Y-axis names.</td>
</tr>
</tbody>
</table>

(continued on next page)
### Table 3.2
**Font Page Items**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tick Labels Button</strong></td>
<td>Use this button to edit the font used for the tick labels (usually numbers) appearing on the axes of the graph. The tick labels include both the x- and y-axis tick labels.</td>
</tr>
<tr>
<td><strong>Legend Button</strong></td>
<td>Use this button to edit the font used for the legend appearing on the graph. See “Creating Plot Legends” on page 4-18 for information on setting up a legend.</td>
</tr>
<tr>
<td><strong>Results Button</strong></td>
<td>Use this button to edit the font used for the results appearing on the graph after an analysis has been performed.</td>
</tr>
<tr>
<td><strong>Footer Button</strong></td>
<td>Use this button to edit the font used for the footer information appearing at the bottom of the graph. The footer includes the exotherm direction and program name and version.</td>
</tr>
<tr>
<td><strong>Symbols Button</strong></td>
<td>Use this button to select the font contained in the Edit Custom symbol list. The symbols can be used to differentiate curves and axes.</td>
</tr>
<tr>
<td><strong>Report Text Button</strong></td>
<td>Use this button to edit the font used for the Report Editor. The font can also be changed using the Report Editor’s Edit/Font menu.</td>
</tr>
</tbody>
</table>

3. Select the desired font, font style, and size using the Font window displayed, see the figure on the next page.
4. Repeat step 3 for the desired parts of the graph.

5. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. The font(s) will be applied to the selected portion(s) of the graph.

**NOTE:**

It is recommended that only True Type (TT) fonts be used. True Type fonts are always scalable to all sizes on all output devices.
Selecting Program Colors

Colors can be used to help add interest to your graphs and analysis presentations. You can set up the colors that will be used each time the Universal Analysis program is started. Follow the directions below to set up the default colors to be used for your plots, axes, results, and baselines.

You can set up the colors to suit your own needs as follows:

Selecting Individual Colors

1. Select **File/Options** from the main menu, then click on the Color tab at the top of the window. The **Main Options - Color Page** is displayed as seen in the figure below.

2. Click the down arrow to display the drop-down list of colors for the item that you wish to set up.

3. Click on the desired color for that item.

---

**Figure 3.6**  
**Main Options - Color Page**
4. Repeat steps 2 and 3 for each item that you want to set up. Multicolor is used to set up the "multicolor" option that is available to apply colors to curves in normal and overlay plots. (This choice is available on the Graph Options window, Curve Overlay Options - Curves Page, and normal Plot Legend window.) You can select a color to apply to up to 12 corresponding cycles in the data. If more than 12 cycles exist in the data, the colors in the list will be repeated.

5. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. The color(s) will be applied to the selected portion(s) of the graph.

Selecting Color Schemes

1. Select File/Options from the main menu, then click on the Color tab at the top of the window. The Main Options - Color Page is displayed.

2. Click on the down arrow to display the drop-down list of color schemes that you can use for the entire program.

3. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. The color(s) will be applied to the selected portion(s) of the graph.

NOTE: Click the Default button to return all of the colors to their original factory settings.
Choosing Data Handling Options

When you start the Universal Analysis program for the first time, the data files are opened using the factory default settings. You can change the way the data files are handled by using the Main Options - Data Page. You can set the data options as desired and they will be applied each time you open the program.

Follow these steps to set up the data options:

1. Select File/Options from the main menu, then click on the Data tab at the top of the window. The Main Options - Data Page is displayed as seen in the figure below.

![Main Options - Data Page](image)

Figure 3.7  
Main Options - Data Page

2. Click on the direction for your RMX Exotherm plot. See “Choosing an Exotherm Direction” in Chapter 2 for details.

Note: Files created with the Thermal Advantage software are not affected by this selection. To edit the exotherm direction for these files, select the desired direction using the Data Information window (if applicable) or Instrument Control software.
3. Choose the type of DSC and DTA derivative plot desired (if you are analyzing DSC and DTA files):

- **Normal**: Selects the mathematical derivative for DSC and DTA.
- **Reversed**: Inverts the DSC and DTA derivative by multiplying by minus one.

4. Choose the type of data compaction that you want to use when the data files are opened:

- **Prompt for option**: Displays the Data Compaction window that enables you to choose the data compaction each time the program opens a large data file that must be compacted. See the figure on the next page.
- **Discard points**: The program will remove data points linearly throughout the data file. The number of points removed is based on the amount of data reduction needed.
- **Linear smoothing**: The program will divide the points into groups and compute an average for each group. The size of the groups depends on how much data compaction is needed.

5. Check the remaining options that you wish to use for your data files:

- **Plot data outside of analysis range**: Check this box to have the data that falls outside of the analysis range plotted. Data outside the analysis range is plotted in the plot grid color. Leave this box unchecked to plot only data within the analysis range.

- **Autoscale new data X-axis or Y-axis**: Check one or both of these boxes to have the data file’s x and/or y axis autoscaled. When checked the current file’s axis data will be autoscaled when the program reads in new data for Data Limits, Linear Transform, or a new axis. This is the default setting. (This applies to single files only—it does not apply to curve overlay.) Leave the box unchecked and the axis data will not be autoscaled (axis scaling is preserved).

- **Ignore breaks in data**: Check this box to have the data file plotted with a continuous curve, regardless of any breaks in the data points, each time a data file is opened. The data will be extrapolated to create an unbroken curve. Leave this box unchecked to have the data file plotted according to existing data points and display any breaks in the curve.
Setting Program Parameters

- **Break data on gas switch**: Check this box to have any gas switch and event marks that are contained in the data file plotted as if they were breaks in the data. This is the default condition. This allows gas switch and/or event marks to be used for the Cycle Limits. Leave this box unchecked to have the data file plotted without regard to gas switch and event.

- **Auto refresh data every ___ seconds**: Check this box to automatically refresh the plotted data from any active file (real time plot) without losing completed results. Enter the minimum amount of delay between refresh actions.

- **Restore saved analysis**: Check this option to return the data file back to the state it was in when Save Analysis was selected. If this box is checked, then any Quick Open or multiple file selection will be immediately restored.

- **Exact scaling X/Y axis**: Check one of these boxes to have the axis plotted using the exact range of the coordinates found in the data file or rescale zoom box.

- **Expand heat flow signal names**: Check this box to automatically replace the Heat Flow signal name in a Tzero data file with the full signal name from the parameter block (e.g., Heat Flow T4). The data file is not modified.

6. Enter the desired buffer size to use for your data files. A data compaction option, if selected, will be applied in the event a data file exceeds this size. (NOTE: You cannot change the data buffer size when data files are open. Close all files to enable the Data buffer size entry field on this page.)

7. Check any desired Open Data File options that will be used whenever a new data file is opened:

   - **Preview**: This option displays a brief list of parameter block entries from the selected (highlighted) data file.

   - **All Text**: This option is used to display a complete list of the parameter block entries from the selected (highlighted) data file. The information displayed will include all data file information plus signal and calibration information, etc. If the data file chosen was stored in a spread sheet format, the data points from the file will also be displayed when All Text is selected. If the file chosen is not a TA Instruments data file, Universal Analysis will display any text found in the file up to the first form feed character encountered.
Choosing Data Handling Options

- **Quick Open**: This option is used to open and plot the data file immediately after the Open button is clicked, without first viewing the Data File Information window for that file.

8. Enter the desired number of tick marks per label on the x axis and y axis. The default is 4 ticks per label.

9. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:** To reset the options to their factory settings, click the Default button.

Using the Data Compression Window

The **Data Compression** window, shown here, allows you to select the type of data handling that you want to apply when a file that exceeds the buffer size is opened.

![Data Compression Window](image)

Click on the desired option, listed below, then click on OK:

- **Linear smoothing**: The program will divide the points into groups and compute an average for each group. The size of the groups depends on how much data compaction is needed.

- **Discard points**: The program will remove data points linearly throughout the data file. The number of points removed is based on the amount of data reduction needed.

- **Select new data limits**: Click on this radio button to select new data limits for plotting using the **Data Limits** window. See “Choosing Data Limits” in Chapter 2 for details.
Selecting More Options

Additional options for printer orientation, time and date format, and a file close confirmation message can be selected as default program options using the Main Options - Other Page. These options will be applied whenever the program is reopened.

1. Select File/Options from the main menu, then click on the Other tab at the top of the window. The Main Options - Other Page is displayed as seen in the figure below.

![Main Options - Other Page](image)

2. Select the direction (orientation) that you want the printer to use each time the program is started for both the plots and reports: Portrait or Landscape. Note that this orientation can be changed during your use of the program, but this setting will be used each time the program is started anew.

**NOTE:**

The report orientation applies to the Report Editor program, The Custom Report Editor program, and the Macro Editor.

3. Choose the Time of Day format you want the program to use for the time data displayed on the graph.

- **24 Hours:** The program will use the time based on a 24-hour day. This format (sometimes called Military Time) will continue
to increment time past 12:00. For example, 2:00 in the afternoon is 14:00 in this format.

- **12 Hours**: The program will use the time based on the 12-hour, am/pm format. After 12:00 am the time goes back to 1:00 pm.

4. Choose the **Year** format you want the program to use for the year data displayed on the graph.

- **2 Digits**: The program will use the year based on the last two digits. For example, the year is represented as 98 or 99, rather than 1998 or 1999.

- **4 Digits**: The program will use the year based on all four digits. For example, the year is represented at 1998 and 1999 2. Choose the Time of Day format you want the program to use for the time data placed in your files.

5. Select a line type from each drop-down list to apply to the corresponding plot curve. This sets up the **Multiline** line type option. You can define up to six line types. If more than six cycles exist in the data, the line types are repeated.

6. Check the **Confirm file close with unsaved results** box to display a message whenever you attempt to close a dat file without saving the analysis results that you have already generated. Leave this box unchecked (default) to close the data files without a prompt to save any analyses performed.

7. Click the **Save** button, if you want to use these as your new settings or click the **OK** button to use these settings for this session only.
Setting Up Export Options

If you want to use your plots in different software packages or for another application, you can export the plot using the File/Export Plot function on the main menu. You can exclude certain parts of the plot, if desired, so that they do not appear in the exported plot.

You can set up the export plot options to suit your own needs as follows:

1. Select File/Options from the main menu, then click on the Export Plot tab at the top of the window. The Main Options - Export Plot Page is displayed, as shown in the figure below.

![Figure 3.10 Main Options - Export Plot Page]

2. Check the options that you want to appear in the heading on the exported plot: Sample, Size, Method, Comment, Module, File, Operator, Run Date, Instrument, and/or Directories. You can also click on the buttons to select All or None of these header options.

3. Check the options that you want to appear on the axes of the exported plot: Axes names, tick labels, or tick marks. You can also click on the buttons to select All or None of these header options.

4. Check the frame option if you want the plot to be printed with a boxed frame around it.
5. Check the options that you want to appear in the footer on the exported plot: Exotherm direction and/or Program version.

6. If you are exporting your plot to an HPGL plotter, perform the following steps:
   a. Select the appropriate radio button for the output port needed for your HPGL plotter.
   b. Enter the X min and X max values based on your plotter type listed in the table below:

<table>
<thead>
<tr>
<th>X min</th>
<th>X max</th>
<th>Pens</th>
<th>Plotter Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>-0.0250</td>
<td>1.0050</td>
<td>2</td>
<td>HP-7470</td>
</tr>
<tr>
<td>-0.0250</td>
<td>1.0115</td>
<td>6</td>
<td>HP-7475</td>
</tr>
<tr>
<td>-0.0250</td>
<td>1.0050</td>
<td>8</td>
<td>HP-7440 Color Pro</td>
</tr>
<tr>
<td>-0.0080</td>
<td>1.0090</td>
<td>8</td>
<td>HP-7550 Auto Sheet Feed</td>
</tr>
</tbody>
</table>

c. Enter the number of pens used on your plotter.

d. Check the Initialize plotter box if you want the program to reset the plotter prior to drawing a plot.

7. If you are exporting your plot to a printer, choose the default orientation that you want to use for the printing of the plot: Portrait or Landscape. You can override this default orientation using the File/Print Setup window.

8. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

NOTE: Click the Default button to return all of the options to their original factory settings.
Choosing Program Directories

When you use the Universal Analysis program there are certain file folders, or directories, that are repeatedly used to locate or to save data and settings. You can set up these directories so that the program will default to a particular location on your hard drive by using the Main Options - Directories Page.

Follow these steps to set up the file directories:

1. Select **File/Options** from the main menu, then click on the Directories tab at the top of the window. The **Main Options - Directories Page** is displayed as seen in the figure below.

![Main Options - Directories Page](image)

2. Enter the location (file path including the disk drive letter and all directories and subdirectories) of your data files or use the Browse button to locate the directory.
3. Enter the location (file path including the disk drive letter and all directories and subdirectories) to be used for any files that you want to export or use the Browse button to locate the directory.

4. Enter the location (file path including the disk drive letter and all directories and subdirectories) to be used when saving report files or use the Browse button to locate the directory.

5. Enter the location (file path including the disk drive letter and all directories and subdirectories) for your macro (.mac) files or use the Browse button to locate the directory.

6. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:** To reset the options to their factory settings, click the Default button.
Setting Program Parameters

Setting Program Initialization Options

An initialization file is a file containing all of the settings that are automatically used when the program runs. When you click the Save button on a window, the program settings are saved in the .ini file selected on the Main Options - Initialization Page.

Follow the instructions below to set up the file directories (folders) that you want to use as your default settings for the initialization (.ini) file(s), which will be used as program preferences by the Universal Analysis program.

1. Select File/Options from the main menu, then click on the Initialization tab at the top of the window. The Main Options - Initialization Page is displayed as seen in the figure below.

![Main Options - Initialization Page](image)

*Figure 3.12 Main Options - Initialization Page*

2. Enter the drive, directories, and filename of the .ini file or locate and load a new .ini file using the Load button. Click the Load button to display the Open Initialization File window, which is used to locate and load an initialization file.
3. You can use the Save As button to save the current program preferences under a new .ini filename or save it in a different directory.

4. To use the program preferences that were set at TA Instruments (factory settings), click the Load Default Program Preferences button. This will load the factory default settings for the entire program.

5. Check the Allow multiple sessions of Universal Analysis box to open a new session of the program each time the icon is selected (more than one copy of the program will be in operation). If the box is not checked, the current session of the Universal Analysis will be activated each time the icon is selected.

   **NOTE:** You must save this setting to the current initialization file by clicking the Save button or it will not take effect.

6. Click the Save button, if you want to use this .ini file as your new default setting or click the OK button to use this setting for this session only.

   **NOTE:** The default directory and filename are TAIWinUA.ini.
Setting Program Parameters

Setting Up

Print Options

The printing options are set up through the standard Windows NT®
printer setup window. The window that is displayed when you select
File/Print Setup from the Universal Analysis main menu can vary
depending upon the printer(s) that you have connected to your computer.
The window that appears, such as the example shown below, will display
the available options for the printer that you have set up as your default
printer. To change the default printer that Universal Analysis will use, just
select a different printer on the setup window.

![Print Setup Window](image)

*Figure 3.13*
*Example of a Print Setup Window*
Saving Program Parameters

When you open a window that contains Universal Analysis program parameters, such as the **Main Options** window, you will see a Save button at the bottom of the window. Click on the **Save** button to save the options that you have set up for the current window or options page in an initialization (.ini) file.
Chapter 4
Customizing the Graphs

Introduction ................................................................. 4-3
Using the Zoom Box to Rescale ....................................... 4-3
Rescaling in the X/Y Direction ........................................... 4-4
Using the Rescale Menu ................................................... 4-5
  Manual Rescaling ......................................................... 4-7
Adding a Scale Bar ......................................................... 4-8
Using the Graph Menu .................................................... 4-9
Using the Spreadsheet View ............................................. 4-13
  Characteristics of the Spreadsheet View: ............................. 4-13
Selecting a Y Axis .......................................................... 4-14
Annotating Graphs ........................................................ 4-15
  Using the Annotation .................................................... 4-17
  Pop-Up Menus ............................................................ 4-17
Changing Colors, ........................................................... 4-19
Line Types, Symbols, etc. .................................................. 4-19
Adding a Plot Header ...................................................... 4-21
Creating Plot Legends ..................................................... 4-22
Using Symbols in Curves .................................................. 4-25
Creating an Inset View ..................................................... 4-26
  Inset View Characteristics ............................................. 4-26
  Setting Up an Inset View .............................................. 4-28
Using the Tools Menu ...................................................... 4-31
  Smoothing Curves ....................................................... 4-32
  Shifting Curves .......................................................... 4-33
  Rotating Curves .......................................................... 4-35
  Linear Transformation ................................................... 4-37
Customizing the Graphs

Overlaying Curves .......................................................... 4-38
  What is Curve Overlay? ...................................................... 4-38
Configuring the ............................................................... 4-39
Auto Overlay Functions ..................................................... 4-39
  Step 1: ........................................................................... 4-39
  Step 2: ........................................................................... 4-39
  Step 3: ........................................................................... 4-43
  Step 4: ........................................................................... 4-43

Setting Up the Curve Overlay Options ................................. 4-44
Configuring the Curves Page ................................................. 4-44
Configuring the Axes Page ................................................... 4-47
Configuring the Plot Heading Page ....................................... 4-48
Configuring the Legend Page ............................................... 4-49
Configuring the Grid Page .................................................... 4-50
Configuring the Auto Page .................................................. 4-51
Results of Offset Selections .................................................. 4-52

Exporting Plots .................................................................... 4-54

Printing Plots ...................................................................... 4-57
  Print ................................................................................ 4-57
  Print Preview .................................................................. 4-57
  Print Setup ...................................................................... 4-57
Introduction

You may not always want to use the graph as it appears when the data file is first opened. You might decide that you want to analyze a certain portion of the graph or that you want to add some design elements to it, such as symbols or legends. This chapter describes the different ways that you can customize your graphs.

Using the Zoom Box to Rescale

Rescaling is a technique that can be used to enlarge an area of the curve that you want to concentrate on for your data analysis. The "Zoom Box" feature in the Universal Analysis provides the fastest way to rescale. You can easily expand a portion of the curve for analysis using the mouse. To zoom in on a particular portion of the curve for analysis, follow these steps:

1. Position the pointer in the general area you wish to enlarge and hold down the left mouse button. As you move the mouse, a zoom box will be drawn from the original point position. Move the mouse to draw a box encompassing the area of the curve to be enlarged. See the figure below for an example of the zoom box.

![Zoom Box Example](image)

**Figure 4.1**
**Example of Zoom Box**
2. Release the mouse. If the area selected is acceptable, move the pointer inside the box and click the left mouse button to zoom the X and selected Y axis or click the right mouse button to display the pop-up menu. For an example of how the area is enlarged, see the figure below.

![Graph Rescaled with the Zoom Box](image)

This process can be used repeatedly to expand a smaller portion of the curve. To return back to the most recent scale changes, press Ctrl-U (Rescale/Previous Limits option).

### Rescaling in the X/Y Direction

You can change the position of the curve in the Y direction (up or down on the monitor) using either of two methods:

- **Drag-and-drop method**: Click on the curve. A crosshair is displayed when you have correctly positioned the pointer on the curve. Continue to hold down the left mouse button while you move the crosshair to the desired point in either y direction. Release the mouse button. The plot is rescaled.

- **Dragging tick labels**: Position the cursor over the axis tick label. Hold down the left mouse button and drag the label

In a normal plot this action rescales the X/Y axis.
In curve overlay this action changes the X/Y offset.
Using the Rescale Menu

The Universal Analysis Rescale menu (shown here) has options that allow you to change the limit points and analysis range. You can change the axis scaling and zoom in on the portion of the graph that will be analyzed using these options.

The menu items found on the Rescale menu are used for the purposes described in the table below.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manual</td>
<td>The Manual rescale option displays the Manual Rescale window (see page 4-7) that is used to select exact start and stop limits for the X- and Y-axes to reduce or expand the graph, and to change the label and tick intervals.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>When you select the Zoom Out option, you will expand the current X and Y axis in all directions by approximately ten percent. Click once to move out one level. Shortcut Key: Ctrl-Z.</td>
</tr>
<tr>
<td>Previous Limits</td>
<td>The Previous Limits option redraws the graph as it appeared before the most recent scale changes. Only the scaling options selected from the Rescale menu are affected by this menu option, any changes made in color or annotation are not affected. Selecting Previous Limits a second time will return the graph back to the most recent changes. Shortcut Key: Ctrl-U.</td>
</tr>
<tr>
<td>Full Scale Axis</td>
<td>The Full Scale Axis option redraws the current axis as it first appeared when you generated it from the data file. The graph is autoscaled to the minimum and maximum data values for the selected axis only.</td>
</tr>
</tbody>
</table>

(continued on the next page)
## Customizing the Graphs

### Table 4.1
Rescale Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Scale All</td>
<td>The Full Scale All option redraws the graph as it first appeared when you generated it from the data file. The graph is autoscaled to the minimum and maximum data values for all of the axes contained in the file.</td>
</tr>
<tr>
<td>Common Scale</td>
<td>When the Common Scale option is selected, all of the axes that have the same Y-axis signal units are autoscaled to match the widest axis. All of the curves on the axes with the same units are then adjusted to have the same data range, and are displayed in full view on the graph.</td>
</tr>
<tr>
<td>Same Scale</td>
<td>When the Same Scale option is selected, all of the axes that have the same units are rescaled to the same axis scales. The largest scale maximum and the smallest scale minimum are used for the scale limits.</td>
</tr>
<tr>
<td>Stack Axes</td>
<td>When you select Stack Axes, the Y axes are adjusted so that the curves on the axes are stacked, one above the other, with no curves from one axis overlapping the curves of another axis. See the figure on the next page for an example.</td>
</tr>
<tr>
<td>Exact Scaling X/Y</td>
<td>When you check this option, the axis will be plotted using the exact range of coordinates found in the data file or rescale zoom box. This option applies only to the current data file. To apply exact scaling every time a file is opened, check the Exact Scaling box found on the <strong>Main Options—Data Page</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** The Stack Axes option cannot be used when one or more of the axes are displayed in log form.
Using the Rescale Menu

Manual Rescaling

The Rescale/Manual option is used to change the limit points and analysis range by entering numerical values with the keyboard. You can enlarge the portion of the graph that you want to analyze as follows:

1. Select Rescale/Manual from the main menu. The Manual Scaling window shown in the figure below is displayed.

2. Enter the start and stop limits for each Y-axis curve, along with the desired label interval, tick interval, and label offset for each curve.

3. Click the OK button when completed.

![Manual Scaling Window](image)

Figure 4.3
Example of Stacked Axes

Figure 4.4
Manual Scaling Window
Adding a Scale Bar

After you have plotted a data file, you can add a labeled I-bar, which denotes a unit of distance, to the plot.

Follow these steps to add a scale to your plot:

1. Open the desired data file.

2. Select the desired y axis for the scale bar.

3. Select **Edit/Add Scale Bar**. The **Scale Bar** window (shown here) is displayed.

4. Enter the width of the scale. The units displayed will reflect the units found on the current y axis, if horizontal direction is selected (see step 4), or the x axis, if vertical direction is selected (see step 4).

5. Click on the desired color for the scale bar and label. The FG (foreground) mark will be displayed in the selected color block.

6. Select the desired direction for the scale bar by clicking on either the **Horizontal** or **Vertical** radio button.

7. Click OK. A marker will be displayed on the graph.

8. Position the marker at the desired place for the scale bar, then right click and select **Accept Limits** from the pop-up menu. The scale bar will be displayed as seen in the figure to the left.

You can drag-and-drop the label for the scale bar anywhere on the graph.

The scale bar is handled as a result by the program. There to edit or remove this label, right click on the label text to display the pop-up menu and select the desired action.
Using the Graph Menu

The **Graph menu** (shown here) is used to select options that allow you to set up your graphs, either before or after analysis by changing signals, units, parameters, data limits, etc.

The menu items found on the **Graph menu** are briefly described in the table below. All of these functions are described in more detail in this manual, see the Index or Table of Contents to locate the references.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spreadsheet View</td>
<td>Use this function to toggle between the spreadsheet view and the graph view. When you display the data in spreadsheet view some menus will change and some menu items will be unavailable.</td>
</tr>
<tr>
<td>Signals</td>
<td>Use the Signals option to access the <strong>Signal Selection</strong> window, which allows you to choose the X- and Y-axis signals that you want to use for your graph.</td>
</tr>
<tr>
<td>Units</td>
<td>Use the Units option to access the <strong>Units Selection</strong> window, which allows you to choose the units that you want to use when graphing and analyzing your data files.</td>
</tr>
<tr>
<td>Instrument Parameters</td>
<td>Use the Instrument Parameters option to access the <strong>DMA Instrument Parameters</strong> window or the <strong>MDSC Instrument Parameters</strong> window, which enables you to edit instrument parameters which affect the data.</td>
</tr>
</tbody>
</table>

(continued on next page)
Table 4.2
Graph Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameters</td>
<td><strong>This option is only available when multiple files are open.</strong> Use the Params Same As option to copy the parameters used in another file to the current file. The parameters that are copied include the signals and units selected, graph options, baseline file (if applicable), and smoothing.</td>
</tr>
<tr>
<td>Data Limits</td>
<td>Use the Data Limits option to select from four options: Full Range, Cursor, Time, or Temperature. These allow you to use the entire data file for analysis, or to place constraints on the amount and type of data. NOTE: This option deletes any existing analyses from the plot.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Use the Refresh/Data option to redraw the plot using the current data points. Use Refresh/Plot to redraw the plot using the current data points.</td>
</tr>
<tr>
<td>X Axis</td>
<td>Use the X Axis option to select the signal to graph on the X axis. Click on the name of the signal and the graph will be replotted immediately. This option preserves the applicable analyses when switching between these signals.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>The signal specified on the <strong>Signal Selection</strong> window for the X signal is used here in addition to time and temperature.</td>
</tr>
<tr>
<td>Y Axis</td>
<td><strong>This option is only available when multiple Y-axis signals are displayed.</strong> Use the Y Axis option to select a Y-axis signal for functions such as rescaling, analysis, etc. Emphasis will be switched to that signal (as seen by the small box enclosing the Y-axis number).</td>
</tr>
<tr>
<td>Curve</td>
<td><strong>This option is only available for a curve overlay graph.</strong> Use the Curve option to switch between different curves on the selected axis of an overlay graph, so that you can perform functions on that curve (such as rescaling, analysis, etc.).</td>
</tr>
</tbody>
</table>

(continued on next page)
### Table 4.2
**Graph Menu Items**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overlay</td>
<td>Performing a curve overlay operation lets you combine curves from several different experiments or experimental techniques to provide a visual comparison of the data. This will allow you to “overlay” the curves on one window and position the graphs to display the data in a manner that enables you to emphasize important aspects of the data. Up to four individual y-axes may be used, containing up to ten curves, each of common units.</td>
</tr>
<tr>
<td>Plot Header</td>
<td>Use the Plot Header option to add a text-only header to an exported or printed plot. The plot header will not be displayed on the monitor. When you select this option the Plot Header window is displayed to allow you to set up the header.</td>
</tr>
<tr>
<td>Plot Legend</td>
<td>Use the Plot Legend option to display the Plot Legend window, which is used to customize the legend that will be placed on the current graph.</td>
</tr>
<tr>
<td>Inset View</td>
<td>Use this function to add a picture-in-picture window to the plot. When you select this option, the Inset View dialog is displayed to allow you to customize the insert view.</td>
</tr>
<tr>
<td>Options (Graph)</td>
<td>Use the Options menu item to display the Graph Options window. This window will enable you to customize the axis labels, grid type, line type, color, and symbol for each curve on the graph.</td>
</tr>
<tr>
<td>Plot Full Range</td>
<td>Check this option to have the data that falls outside of the analysis range plotted, but grayed out. Data outside the analysis range is plotted in the “Plot Grid” color. NOTE: This option applies only to the current data file. To apply this option each time a new file is opened, check the “Plot data outside of analysis range” box found on the Main Options-Data Page.</td>
</tr>
</tbody>
</table>

*(continued on next page)*
### Table 4.2

**Graph Menu Items**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Scale New Data X/Y</strong></td>
<td>Check this option to have the data file autoscaled when the program reads in new data for Graph/Data Limits, Tools/Linear Transform, or a new Graph/X axis or Y axis. NOTE: This option applies only to the current data file. To apply this option each time a new file is opened, check the &quot; Autoscale new data: x axis or y axis&quot; box(es) found on the Main Options—Data Page.</td>
</tr>
<tr>
<td><strong>Ignore Breaks in Data</strong></td>
<td>Check this option to have the data file plotted with a continuous curve, regardless of any breaks in the data points. The data will be extrapolated to create an unbroken curve. NOTE: This option applies only to the current data file. To apply this option each time a new file is opened, check the &quot;Ignore breaks in data&quot; box found on the Main Options—Data Page.</td>
</tr>
<tr>
<td><strong>Auto Refresh Data</strong></td>
<td>Check this option to automatically refresh the plotted data from an active data file (real time plot) without losing completed results. Auto refresh can be turned on as a default condition on the Main Options—Data Page.</td>
</tr>
</tbody>
</table>

Most of the items contained in the table are discussed in further detail in this manual. To locate a particular topic, refer to the Table of Contents or the Index.
Using the Spreadsheet View

Use the **Graph/Spreadsheet View** function to toggle between the spreadsheet view and the graph view. When you display the data in spreadsheet view some menus will change and some menu items will be unavailable.

**Characteristics of the Spreadsheet View:**

- A maximum of five columns can be shown in the spreadsheet view—one x-axis and up to four y-axes.

- You can double click on any data point in the table to modify that point or use the **Edit/Modify** function to modify the data. (NOTE: The data file will not be changed.) The **Modify Data** window is displayed as seen here. Just enter the desired value and click OK to alter the selected cell.

- You can select (highlight) rows, columns, and regions of table cells by holding down the left mouse button and dragging across the desired cells.

- A right-click popup menu (shown to the right) is available for the following functions in spreadsheet view: Select all cells, and Copy, Paste, and Modify data. A list of signals (chosen on the Signal Selection window) is also displayed in the pop-up menu to allow you to display (checked) or remove (unchecked) the signal data from the spreadsheet view.

- You can copy any range of data to the clipboard from the spreadsheet view and retrieve it in another application.
Customizing the Graphs

- You can perform data modification functions such as smoothing, linear transform, and excluding data using the applicable menu functions.

- You can restrict the data displayed in spreadsheet view to a specific range using the Data Limits and Analysis Range options.

- When you are using a Curve Overlay plot, only the data for the currently selected curve is displayed in spreadsheet view. (This is because the x-axis values of each data point are different in each data file.)

**NOTE:**

If you want more columns of data for a Curve Overlay plot, use the View/Data Table function instead of the spreadsheet view.

- If you want to paste several columns of data into an area below a particular cell, first copy the set of data points, then select the desired cell and select paste from the popup menu. The data will be pasted into the cells below the chosen cell in the same column, overwriting the previous data.

- If you want to smooth a group of data points in the spreadsheet, select (highlight) the desired group of cells. Then select Edit/Exclude Data, check "Smooth and blend with adjacent data," then click OK.

Selecting a Y Axis

If more than one Y-axis has been graphed, you need to specify which axis should be used for operations. You can select a Y axis for use by performing one of five actions:

- Select Graph/Y Axis from the main menu.
- Click on the Y number text above the axis.
- Click on the Y-axis label on the graph
- Click on the curve for the desired Y axis.
- Right click on a result label on the desired Y axis.
Annotating Graphs

Annotations are alphanumeric characters that can be placed on the graph to add notations or comments regarding the information displayed. You can place comments of up to 20 lines of 80 characters (600 characters maximum) on the graph.

Follow these steps to place an annotation on the graph:

1. Select Edit/Annotate from the main menu. The Annotation window, shown in the figure below, is displayed.

2. Enter the desired text in the Text box. (You can use tabs for alignment.)

3. Click on the desired text color. The FG (foreground) mark will be displayed in the selected color block.

4. Check the Arrow to Point box, if you want to have an arrow pointing from the text to the reference point selected on the plot.

5. Click the Params (Parameters) button, if you want to choose common parameters to insert in your annotation. The Insert Data File Parameters window (see the figure on the next page) is displayed. Make your selections and click OK. The selected text is inserted at the current position of the cursor in the text box of the Annotation window.
Customizing the Graphs

6. Click on OK. The graph is displayed again with crossed marker lines displayed.

7. Position the markers so that they intersect at the desired reference point on the plot.

8. Right click to display the pop-up menu and select Accept Limits. The text will be displayed on the graph at the chosen point.

After the annotation has been created and displayed, you can edit it. Position the pointer over the annotation text and click the right mouse button. The **Annotation Pop-up** menu is displayed as seen on the next page.

**NOTE:** Annotations may be repositioned after they are displayed by dragging and dropping the text at the desired location using the mouse.
Using the Annotation Pop-Up Menus

Use one of the pop-up menus below, after an annotation or analysis result label has been created, to edit or delete the annotation. Position the pointer over the annotation or result label and click the right mouse button to display these menu options.

**Bold**

**Italic**

**Color...**

**Size...**

**Resolution...**

**Adjust Result...**

**Delete Result**

**Edit Annotation...**

**Copy Text**

**Annotation Popup**

**Results Label Popup**

The menu items found on the pop-up menu are used for the following purposes:

- **Bold**: Use this menu item to make the selected annotation text bold.

- **Italic**: Use this menu item to make the selected annotation text italicized.

- **Color**: Use this menu item to change the color of the selected annotation text. When you select Color, the **Label Color** window is displayed to allow you to select a color.

- **Size**: When you select Size, the **Label Size** window is displayed. Use this window to enter or select from a list of relative sizes that will be applied to the PRINTED annotation text. The size of the annotation on the display will not be affected. Use Print Preview to observe the affect of the label size change on the exported plot.

- **Resolution**: Use the Resolution menu item to set the numeric resolution of an individual result value that is displayed on the plot and in the reports generated by the Universal Analysis program. When you select Resolution, the **Label Resolution** window is displayed to allow you to round the value to the defined resolution.

- **Adjust Result**: After you have completed performing certain types of analyses on your data file, you can adjust the results of the analysis.
Customizing the Graphs

- **Delete Result**: Use this menu item to remove the associated result or annotation from the graph.

- **Edit Annotation**: Use this menu item to make changes to the selected annotation. When you select this option, the Annotation window is displayed. See “Adjusting Analysis Results” in Chapter 5.

- **Delete Label**: Use this menu item to remove the selected analysis label from the graph. The remainder of the associated analysis result is not affected.

- **Copy Text**: Use this menu item to copy the text in a result label, legend, or annotation to the clipboard for retrieval later.
Changing Colors, Line Types, Symbols, etc.

You can set up the appearance of the graph by choosing graph settings that will apply to the file currently displayed. You can set up the curves with different colors, line types, and symbols, as well as placing a grid on the graph, if desired.

Follow these steps to select your graph's appearance:

1. Select **Graph/Options** from the main menu (or position the pointer over a Y-axis label title or over a curve and click the right mouse button). The **Graph Options** window, shown in the figure below, is displayed.

![Graph Options Window](image)

**Figure 4.7**
**Graph Options Window**

2. Select the radio button for the Y-axis label and curve that you wish to set up.

3. Edit the names for the Y-axis and X-axis labels, if desired.
4. Select the color for the graph and label by clicking on the desired color. Multicolor uses the colors selected on the Main Options—Color Page. Each color in the multicolor list is applied to the corresponding text line or plot curve.

5. Select the grid type from the drop-down list. Grid options apply to the currently-selected axis and can only be specified for one Y axis.
   - No grid
   - Grid at labeled ticks
   - Grid at all ticks.

6. Select the line type from the drop-down list. If you select “multiline,” you can define up to six line types, which are selected on the Main Options—Other Page. If more than six cycles exist in the data, the line types are repeated.

7. Select the symbol type from the drop-down list. (For more information on symbols turn to page 4-20.) Choose from one of the following:
   - No symbols
   - Digits (Uses ascending Arabic numbers from 1 through 9.)
   - Letters (Uses the alphabet from A to Z in upper case followed by letters a to z in lower case.)
   - Custom symbol list (The symbols will be used in the order displayed. You can use the default symbols already displayed or enter your own symbols.)

   If you select a symbol, it will be displayed at the bottom of the window, then go on to step 8. If you select “No symbols,” go on to step 10.

8. Select the type of differentiation from the drop-down list. Choose from one of the following:
   - Curves is used to have the symbol that is used for a curve change to the next symbol in the list at a break in the data. (E.g., data breaks, change in multiplexed signal value.)
   - Axis/Axes is used to have the symbol that is used for an axis change when the next axis is drawn.
   - Subcurves (available only in curve overlay plot) is used to have the symbol that is used for a curve change to the next symbol in the list when a subcurve is displayed.

9. Select the spacing between data points from the drop-down list. Choose from one of the following:
   - Coarse is used to space the symbols farthest apart on the curve.
   - Medium is used to space the symbols closer together on the curve.
   - Fine is used to space the symbols even closer together on the curve.
   - Every point is used to place a symbol at every data point on the curve. (This can sometimes lead to a solid line effect.)
10. If you want to edit the list of symbols, click on the Edit List button, then edit the list as desired.

11. Repeat steps 1 through 10 for each axis. Grid type and symbol differentiation apply singularly to the entire plot. They can not be set up uniquely for each axis, except in a curve overlay plot.

12. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. (X and Y names cannot be saved.)

**NOTE:**

Select the Default button to use the default settings for this window.

### Adding a Plot Header

A plot header is a text-only heading that can be added to exported or printed plots. You can set up the plot header as desired using the steps below:

1. Open a data file, then select **Graph/Plot Header** from the main menu. The **Plot Header** window is displayed.

![Plot Header Window](image)

#### Figure 4.8
**Plot Header Window**

2. Select the radio button for the desired header type: Standard, Custom, Blank, or No Header.

3. Type in the desired text in the "Custom header text" area, if you have selected the Custom radio button in step 2. A maximum of four lines of text can be entered. You can set the font for this text by clicking the Font button.

4. Click on the desired button to choose the alignment of the text from the following justifications: Left, Center, or Right.

5. Click the OK button when finished.

To view the header, select **File/Print Preview** after you have created one.
Creating Plot Legends

A plot legend is a customized box that shows the symbols, line type, etc. used for each curve, along with your own text. You can configure the legend to your specifications before you place it on your graph or edit it after one has been created.

Follow the steps below to configure or edit the legend.

1. Select Graph/Plot Legend from the main menu (or right click on a legend that has already been created). The Plot Legend window, shown in the figure below, is displayed.

![Plot Legend Window](image)

**Figure 4.9**
Plot Legend Window

1. Enter the desired Heading for the plot legend.

2. Check one or more options that will be applied to the legend:
   - **Multiplexed Signal Table**: Displays the values of the multiplex signal (e.g., DMA and DEA frequency, DMA amplitude, and μTA location). If a symbol is used to distinguish these curves then it will be displayed next to each value. If you check Multiplexed Signal Table, you must also select either Vertical or Horizontal from the drop-down list.
NOTE: When the Border box is checked the legend is opaque (nothing behind it will show). When the box is not checked, there is no border and the legend is transparent (anything behind it will show through).

- **Border**: Places a box around the legend. NOTE: When the Border box is checked the legend is opaque (nothing behind it will show). When the box is not checked, there is no border and the legend is transparent (anything behind it will show through).

- **Module ID**: Places the name of the instrument in the legend.

- **Multicolor table**: Assigns multiple colors to the lines of a vertical multiplexed signal table. NOTE: Multicolor table will only work when the Multiplexed Signal Table is set to "Vertical."

- **Multicolor text**: Assigns multiple colors to the lines of text created in the text field.

The colors used for multicolor options are defined on the Main Options—Color Page.

3. Enter the desired Text that will be added to the bottom of the legend.

4. Enter an X-axis position coordinate. The coordinates are unitless, and range from 0.0 to 1.0 on the axis.

5. Enter a Y-axis position coordinate. The coordinates are unitless, and range from 0.0 to 1.0 on the axis.

6. Click on the desired vertical position for the legend handle: Top, Center, or Bottom.

7. Click on the desired horizontal position for the legend handle: Left, Center, or Right.

8. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

See the figure below for an example showing a plot legend.

**Figure 4.10**
Plot Legend Example
NOTES:

The legend may be repositioned after it is displayed by dragging and dropping the legend at the desired location using the mouse. You can also right-click over legend text to display a pop-up menu that allows you to edit or delete the legend or copy it to the clipboard.

To use these settings each time you display this window, select the Save button.

Select the Default button to use the default settings for this window.
Using Symbols in Curves

Symbols are a fun way to creatively represent your information on the graphs. You can use symbols to differentiate between axes or curves.

Symbols are particularly useful for multifrequency (DMA and DEA) or multiamplitude (DMA) experiments and can be displayed in the plot legend. They can be used to differentiate axes.

You can also use the Edit/Exclude Data function to create data breaks, and then use symbols to show changes within a signal. For example, gas changes (oxidative stability) or heat/cool segments can be marked by making breaks in the data, then using symbols to differentiate between the changes.

NOTE: The symbol type applies to all of the uninterrupted data on an axis or to different axes. The list symbols apply in the left to right order displayed. When symbols are used as axis differentiators, the first symbol applies to axis Y1, the second to axis Y2, etc.

For an example of using symbols in curves, see the figure below.

Figure 4.11
Example of Symbols in Curves
Customizing the Graphs

Creating an Inset View

An inset view is a picture-in-picture window that can be added to the plot. The best way to use the inset view is to first zoom in on the area of the curve to be analyzed. Then perform the analyses desired. Adjust the position of the labels to your satisfaction, then set up the inset view using either Graph/Inset View or by right clicking to display the pop-up menu (shown here) and selecting either Inset View or Auto Inset. See the following sections for more details.

Inset View Characteristics

When you set up an inset view, keep in mind the following characteristics and refer to the figures shown for examples:

- Inset view is generally used to view events of two different sizes at the same time. You can show an enlarged view of a small event inside the inset view and display the full size plot at the same time.

- Only one inset view may be added to a plot.

- The inset view has separate axis scaling so that you can expand any area of the main plot and put that into an inset view.

- The inset view can be placed anywhere in the plot area using drag-and-drop.

Figure 4.12
Inset View Example 1
• An inset view can be customized with optional borders, arrows, axes, etc. using the Inset View dialog. See the next section, “Setting Up an Inset View” for more details.

• You can make the inset view transparent (items behind the inset view will be displayed) by turning off (unchecking) the Border option on the Inset View dialog. If Border is checked, the inset view will cover anything underneath it. See the next section, “Setting Up an Inset View” for more details.

• You can view the entire plot or manually choose the viewing area by selecting Graph/Inset View from the menu. The Inset View dialog is displayed to allow you to customize the view. See the next section, “Setting Up an Inset View” for more details.

• You can choose the area of the plot to be viewed by creating a zoom box with the mouse and then right clicking to display the pop-up menu. At this point you can customize the view by selecting Inset View from the pop-up menu or let the view be created automatically from the zoom box area by selecting Auto Inset View from the pop-up menu.

• You can suppress results that fall within the inset view from appearing on the main plot, if desired by unchecking the "Results on plot" box on the Inset View dialog. If this is checked, the results will only be displayed in the inset view. See the next section, “Setting Up an Inset View” for more details.

• When you create an overlay plot (see Curve Overlay), you can include all of the plots in your inset view or include only the current plot by checking or unchecking "All curves" on the Inset View dialog. See the next section, “Setting Up an Inset View” for more details.

• You can mark the area of the inset view on the full size plot by using either a dashed box and/or arrow.
Customizing the Graphs

Setting Up an Inset View

Select **Graph/Inset View** to open the window shown below. This window is used to customize the appearance of the inset view.

![Inset View Dialog](image)

**Figure 4.13**
_Inset View Dialog_

1. Check the items that you want to appear on the inset view window:
   - **View**: Check this box to show the graph in the inset view. If this box is not checked, the inset view will not be displayed.
   - **View Border**: Check this box to put a border around the inset view and make it opaque. If Border is checked, the inset view will cover anything underneath it. See Figure 4.11 for an example of an inset view with a border.

   You can make the inset view transparent (items behind the inset view will be displayed) by turning off (unchecking) the Border option on the **Inset View** dialog.

   - **Region Border**: Check this box to leave a dotted line around the region chosen for the inset view. See Figure 4.11 for an example of an inset view with the region shown as a dotted line. If this box is not checked, the region chosen for the inset view will not be shown.
Creating an Inset View

- **Results on Plot**: Check this box to show any analysis results contained in the inset region on the main plot and the inset view.

  If this box is not checked, the results contained in the inset region will only be displayed on the inset view and not on the main plot. See Figure 4.11 for an example of an inset view with results only on the inset view.

**NOTE:** You can also toggle this option on or off using the inset view pop-up menu after the inset view is placed on the plot.

- **Arrow to Curve**: Check this box to show an arrow pointing from the inset view to its source on the curve. See the figure below for an example showing an arrow to the curve. If this box is not checked, no arrow is displayed.

**Figure 4.14**
Inset View Example 2

- **All Curves**: Check this box to display all available data curves in the inset view. If this item is not checked, only the current curve is displayed in the inset view.

- **X Axis Scale**: Check this box to display the x axis in the inset view. See Figure 4.13 for an example of an inset view showing the x-axis scale. If this box is not checked, the x axis will not be displayed in the inset view.
Customizing the Graphs

- **Y Axis Scale**: Check this box to display the y axis in the inset view. If this box is not checked, the y axis will not be displayed in the inset view.

- **Partial Results**: Check this box to display any results whose limits may be partially in and partially outside the area selected for the inset view. If this box is not checked, any results that do not fall completely within the limits chosen will not be displayed in the inset view.

2. Enter the size of the window in the X and Y directions in terms of a percentage of the main window. For example, entering X and Y both as 40 percent will create a small window that is 40 percent of the main window's size.

**NOTE:** If you resize the main window, the inset view window is resized proportionally.

3. Enter the data region limits to be used in the inset view window to be created.

4. Enter a View handle position X coordinate on the graph for the position of the handle for the inset view. The coordinates are unitless, and range from 0.0 to 1.0 on the axis.

5. Enter a View handle position Y coordinate on the graph for the position of the handle for the inset view. The coordinates are unitless, and range from 0.0 to 1.0 on the axis.

6. Click on the desired vertical handle position: Top, Center, or Bottom.

7. Click on the desired horizontal handle position: Left, Center, or Right.

8. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:** To use these settings each time you display this window, select the Save button. Select the Default button to use the default settings for this window.
Using the Tools Menu

The Tools menu (shown here) is used to select from a list of different types of functions that can performed on the current graph. You can smooth, shift, and/or rotate the curve and perform a linear transformation on either axis. If you change your mind you can remove the curve shifts. The resultant curve can be saved using the File/Export Data File option.

The menu items found on the Tools menu are described in the table below.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smooth</td>
<td>Use this option to smooth curves using a least-squares averaging technique.</td>
</tr>
<tr>
<td>Shift</td>
<td>Use the Shift option to move the curve up or down to the position of the horizontal bar of the marker.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Use the Rotate option to take the curve and rotate it around the points chosen.</td>
</tr>
<tr>
<td>Linear Transform</td>
<td>Use the Linear Transform/Y Axis function to adjust the slope and/or intercept of the selected Y-axis signal.</td>
</tr>
<tr>
<td>Y Axis</td>
<td></td>
</tr>
<tr>
<td>Linear Transform</td>
<td>Use the Linear Transform/X Axis function to adjust the slope and/or intercept of the X-axis signal.</td>
</tr>
<tr>
<td>X Axis</td>
<td></td>
</tr>
<tr>
<td>Remove Shifts</td>
<td>Use the Remove Shifts function to undo any shifting or rotating of the curve. Please note that when a linear transformation is applied to the shifted data, this function is no longer available.</td>
</tr>
</tbody>
</table>

(continued on next page)
Customizing the Graphs

**Table 4.3**

*Tools Menu Items (continued)*

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Baseline File</td>
<td>Use Baseline File to perform baseline subtraction or addition. File addition or subtraction requires the use of two data files, a sample and a baseline reference file, both obtained from the sample instrument, to create a modified sample signal(s). When you select this function, you will get a choice of the available files to be used as the baseline file.</td>
</tr>
</tbody>
</table>

**NOTE:**

- The *Shift* and *Rotate* options are not available for log axis data.

This section contains further information on the items listed in the *Tools* menu on the following pages.

**Smoothing Curves**

The *Smooth* option found in the Universal Analysis program allows you to smooth curves using a least-squares average. Normal curves are smoothed versus the X-axis signal, and derivative curves are smoothed versus the X-axis signal with respect to which the derivative was taken. Integral curves cannot be smoothed. We recommend that you perform smoothing before any analysis functions.

**NOTE:**

- The larger the smoothing interval you specify, the smoother the curve.

Follow these steps to perform this function:

1. Choose the desired Y-axis to smooth by clicking on the desired Y number displayed on the graph.

2. Select *Tools/Smooth* from the main menu. The *Smooth Curve* window shown on the next page is displayed.
3. Enter the width of the desired smoothing region. For example, if you enter 5 for an X-axis showing temperature, data from every 5 degrees is grouped together and averaged by the method of least squares. The resulting averages are then plotted on the screen.

4. Check the box to smooth the curve for the next file or new data limits, if you would like to save and apply this smoothing region again each time the selected signal is read from the data file.

5. Click on the OK button when completed. (If a reduced analysis range has been selected, then the smoothing is applied to the selected analysis range only. A limited data range can also be smoothed using the Exclude Data function.)

NOTE: To use the default settings, click on the Default button.

Shifting Curves

You may find it useful in some cases to manipulate your graph by moving the curve up or down to a desired position on the graph. The Shift option found on the Tools menu allows you to shift the curve as desired.

Follow these steps to use this function:

1. If more than one Y-axis is displayed, choose the desired Y-axis to shift by clicking on the Y number shown on the graph.

2. Select Tools/Shift from the main menu. A marker is displayed on the graph.

3. Double click at the point where you want to shift the curve to position the marker as seen in the figure on the next page. The position of the horizontal bar of the marker indicates whether the curve is to shift up or down and by how many units. The vertical bar of the marker intersects the curve at the point that will be brought to the level of the horizontal bar.
Customizing the Graphs

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program redraws the graph according to your specifications as seen in the example below.

Figure 4.16
Markers for Shift Curve

Figure 4.17
Example of a Shifted Curve
The curve can be shifted and/or rotated multiple times. To remove shifting/rotating, select **Remove Shifts** from the **Tool** menu.

The **Shift** option is not available for log axis data.

**Rotating Curves**

If your curve can use adjustment, you can use the **Rotate** option to take the curve and rotate it around the points chosen.

Follow these steps to use this function:

1. If more than one Y-axis is displayed, choose the desired Y-axis to shift by clicking on the Y number shown on the graph.

2. Select **Tools/Rotate** from the main menu. Markers are displayed on the graph.

3. Double click at the first point where you want to shift the curve to position the marker. The position of the horizontal bar of the marker indicates whether the curve is to shift up or down and by how many units. The vertical bar of the marker intersects the curve at the point that will be brought to the level of the horizontal bar.

4. Double click at the second point to which you want to shift the curve to position the next marker. See the figure below.

![Figure 4.18](image-url)

*Figure 4.18*  
**Markers for the Shift Curve Option**
5. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program rotates the curve and redraws the graph according to your specifications. See the figure below for an example.

**Figure 4.19**
Example of a Rotated Curve

**NOTES:**
The curve can be shifted and/or rotated multiple times. To remove shifting/rotating, select **Remove Shifts** from the **Tool** menu.

The **Rotate** option is not available for log axis data.
**Linear Transformation**

You can perform a linear transformation on the selected Y-axis or X-axis signals displayed on the graph using the appropriate option found in the **Tools** menu.

The Y-axis or X-axis transformation functions are used to enter the desired values into the general equation that the program will use to perform the linear transformation, which adjusts the slope and/or intercept of the selected Y-axis signal or the X-axis signal.

Follow these steps to perform this function:

1. If more than one Y-axis is displayed, choose the desired Y-axis to smooth by clicking on the desired Y number displayed on the graph.

2. Select **Linear Transform/Y Axis** or **Linear Transform/X Axis** from the **Tools** menu. The X or Y Transform window, shown in the figure below, will be displayed.

   ![Y Transform Window](image)

   **Figure 4.20**
   **Y Transform Window**

3. Enter the desired value for the equation in each field. The default values are displayed when the window is first opened.

4. Click on the OK button when completed. The linear transformation will be performed, the graph will be autoscaled, and the results displayed on the screen.

**NOTE:** When a linear transformation is applied to the shifted data, the **Remove Shifts** option is no longer available.
Customizing the Graphs

Overlaying Curves

What is Curve Overlay?

Performing a curve overlay operation lets you combine curves from several different experiments or experimental techniques to provide a visual comparison of the data. This will allow you to "overlay" the curves on one window and position the graphs to display the data in a manner that enables you to emphasize important aspects of the data. Up to four individual Y-axes may be used, containing up to ten curves, each of common units. Up to 20 separate overlay plots may be configured.

NOTE: A signal from a file may only be used once. Signals containing the same units (e.g., nonreversing and reversing heat flow, flexural and storage modulus) may be overlaid on the same Y-axis, however, the axis label will reflect the signal of the first curve added to the axis. Customize the axis label using the Axes Page.

NOTE: The curve is displayed on the overlay graph using the same conditions that were used in the single file mode. For example, the same data limits, analyses, etc. will be used.

Follow these basic steps to overlay curves:

1. First you need to open and plot your files using the desired signals.

2. Then you can overlay curves using one of the following methods from the Graph/Overlay menu seen here:

   • Auto Configure: Use this option to automatically configure the open data files for curve overlay. When you select this options, the Overlay Auto Configure window (see the next page) is displayed to allow you to select the settings that you want the program to automatically configure for you. See the next section for details.

   • Manual Setup: Use the manual setup option to manually configure a new curve overlay.

   • Edit: Use the Edit option to edit the chosen curve overlay plot.

   • Copy: Use the Copy option to copy the chosen curve overlay plot.
• **Show Overlay Plot**: Use this option to switch the window focus to display the curve overlay results.

• **Show Normal Plot**: Use this option to switch the window focus to the normal plot window of the currently selected overlay curve (the curve that is numbered).

### Configuring the Auto Overlay Functions

You can set up Universal Analysis so that the program will automatically configure options that will be used to create a curve overlay graph. To do this, you can use the **Graph/Overlay/Auto Configure** function to set up a curve overlay graph initially (using the program-optimized settings), then use the **Graph/Overlay/Manual SetUp** function to refine your overlay graph.

Follow these steps to automatically set up your curves for overlay:

**Step 1:**

First you need to open and plot your files using the desired signals.

**Step 2:**

Then, select **Auto Configure** from the **Graph/Overlay** menu. The **Auto Configure** window, as seen in the figure below, is displayed.

![Auto Configure Window](image)

**Figure 4.21**

*Auto Configure Window*
Follow the instructions beginning on the next page to set up this window.

1. Check the desired Y-axis signal boxes (Y1, Y2, etc) to automatically use the selected Y signal(s) for a curve overlay graph, when available in the selected data files. For detailed examples, see the information below.

   Examples Y Signals (Curve Overlay)

   — If several data files are chosen for Curve Overlay that have signals plotted on axes Y1, Y2, and Y3, checking just the Y2 check box on the Auto Configure window will configure only the Y2 signals from each selected data file.

   — If the Y2 signals in each file have the same units, then they will all be configured on a single overlay axis.

   — If the Y2 signals in each file have different units, then each signal will be placed on a different overlay axis.

   NOTE: Signals from different Y axes are always configured on different overlay axes, regardless of their units.

   — To autoconfigure identical signals from several files on different overlay axes, open each data file with the signals on the same axis (as desired on the overlay plot) and check all Y signals check boxes on the Auto Configure window.

   — To autoconfigure identical signals from several files on one overlay axis, open each data file with the signals on the same axis (as desired on the overlay plot) and check only the Y signal check box for the axis specified.

2. Check the desired Auto options from the following:

   • Line: Check this box to automatically apply the Auto Line settings, found on the Manual SetUp/Auto Page, to the curve overlay graph. To change the Auto Line settings after auto configure is complete, use the Manual SetUp/Curves Page to adjust the line type for each curve.

   Examples Auto Line Checked:

   — Checking Auto Line for Curves is equivalent to pressing the Auto Line button on the Manual SetUp/Curves Page for each overlay axis.

   — Checking Auto Line for Axis assigns the first Auto Line type to all curves on overlay axis Y1, the second Auto Line type is assigned to all curves on axis Y2, etc.
Overlaying Curves

Example Auto Line Unchecked

- If the Auto Line box is not checked, the line type for each curve in the overlay will be the same as that used in the individual file graph.

- Symbol: Check this box to automatically apply the Auto Symbol settings, found on the Manual SetUp/Auto Page, to the curve overlay graph. To change the Auto Symbol settings after auto configure is complete, use the Manual SetUp/Curves Page to adjust the symbol type for each curve.

Example Auto Symbol Checked

- Checking Auto Symbol for Curves (see the figure below) is equivalent to pressing the Auto Symbol button on the Manual SetUp/Curves Page for each overlay axis.

- Checking Auto Symbol for Axis (see the figure below) assigns the first Auto Symbol type to all curves on overlay axis Y1, the second Auto Symbol type is assigned to all curves on axis Y2, etc.

Example Auto Symbol Unchecked

- If the Auto Symbol box is not checked, the symbol type for each curve in the overlay will be the same as that used in the individual file graph.

- Color: Check this box to automatically apply the Auto Color settings, found on the Manual SetUp/Auto Page, to the curve overlay graph. To change the Auto Color settings after auto configure is complete, use the Manual SetUp/Curves Page to adjust the color for each curve.

Example Auto Color Checked

- Checking Auto Color for Curves is equivalent to pressing the Auto Color button on the Manual SetUp/Curves Page for each overlay axis.

- Checking Auto Color for Axis assigns the first Auto Color to all curves on overlay axis Y1, the second Auto Color is assigned to all curves on axis Y2, etc.

Example Auto Color Unchecked

- If the Auto Color box is not checked, the color for each curve in the overlay will be the same as that used in the individual file plot.
3. Click on the Axes or Curves radio button to automatically apply the associated setting to the curve overlay axes.

- **Example 1:** If you check Line and Axes, the Auto Line type settings will be automatically applied to the curve overlay axes. All curves on a single overlay axis will be assigned the same line type.

- **Example 2:** If you check Line and Curves, the Auto Line type settings will be automatically applied to each curve on an axis. The first curve on each overlay axis will be assigned the first line type. The second curve on each axis will be assigned the second line type, and so on.

4. Check any of the remaining four **Auto** options that you want the program to optimize and apply to your overlay graph:

- **Curve offset:** Check this box to automatically apply the Auto Offset settings from the Manual Set Up/Auto Page to each axis in the curve overlay plot. To change the offset settings, use the Overlay/Manual Setup function to manually adjust the offset for each curve in the overlay plot.

- **Auto Curve Offset Checked:** Checking the Auto Curve Offset box is equivalent to pressing the Auto Offset button on the Manual Set Up/Curves Page for each overlay axis.

- **Auto Curve Offset Unchecked:** If you do not check the Auto Curve Offset box, then no offset is applied to any curve in the overlay plot.

- **Axis:** Check this box to automatically configure the Show Color, Symbol, and Line Type options for each overlay axis. If Auto Axis is not checked, the Manual Set Up/Axes Page settings are used.

- **File selection:** Check this box to automatically include all of the opened files for curve overlay. You can then uncheck any files that you do not want to include.

- **Legend:** Check this box to automatically apply the legend settings, that the program will optimize for you, to the curve overlay graph. To change the Legend settings, use the Manual Set Up/Legend Page. When the Auto Legend box is checked, the program will include the minimum amount of information in the legend that uniquely identifies the files included in the overlay plot.
5. Enter the plot heading that you want to have printed on your curve overlay graph each time one is created using the Auto Configure option. The plot heading will not be displayed on the screen, it will only be PRINTED or EXPORTED.

6. Click the Save button, if you want to use these as your new default settings for Auto Configure or click the OK button to use these settings for this plot only. The curve overlay results will be displayed.

**Step 3:**

Use the Graph/Overlay/Manual Set Up function to refine the options to be used. When you select Manual Setup from the Graph/Overlay menu, the Curve Overlay Options window is displayed. Click on the tab at the top of the window that will open the page pertaining to the item that you wish to configure for curve overlay.

**Step 4:**

Save the curve overlay options when you have finished the manual setup above.

Once the curves are displayed on the overlay plot, you can still perform all of the same operations on the selected curve (e.g., analysis, rescaling, etc.).

**NOTE:** A signal from a file may only be used once. Signals containing the same units (e.g., nonreversing and reversing heat flow, flexural and storage modulus) may be overlaid on the same Y-axis, however, the axis label will reflect the signal of the first curve added to the axis. Customize the axis label using the Manual Setup/Axes Page.

**NOTE:** The curve is displayed on the overlay graph using the same conditions that were used in the single file mode. For example, the same data limits, analyses, etc. will be used.
Customizing the Graphs

Setting Up the Curve Overlay Options

To combine (overlay) curves from several different experiments, you need to open and plot your files using the desired signals. Then create a new curve overlay plot manually following the directions provided here.

1. Select Graph/Overlay/Manual Setup from the main menu. The Curve Overlay Options window, shown in the figure below is displayed.

2. Click on the tab at the top of the window that will open the page pertaining to the item that you wish to configure for curve overlay. Information on each of these pages can be found in this section on the following pages.

Configuring the Curves Page

The Curves Page (shown below) is used to set up the curves that will be overlaid from the different data files.

![Curve Overlay Options](image)

*Figure 4.22 Curve Overlay Options—Curves Page*
Follow these steps to configure the Curves Page:

1. Click on the desired Y-axis number at the top of the window to select the Y axis that will be configured.

2. Click the Add Curves button. The Add Overlay Curves window is displayed, as seen in the figure below. Select the files and signal to be used.

![Add Overlay Curves Window](image)

**Figure 4.23**
Add Overlay Curves Window

3. Select the line type to be used for each curve. Use either the drop-down list or click the Auto Line button. (The automatic line type selection can be set up using the Auto Page.)

4. Click on the Symbol block to display the Curve Symbol window (shown on the next page), which allows you to select the symbols to be used for the curves, or click on the Auto Symbol button. (The automatic symbol selection can be set up using the Auto Page.) For more information on symbols see “Changing Colors, Line Types, Symbols, etc.” in this chapter.

5. Select the color to be used for each curve. Use either the drop-down list or click the Auto Color button. (The automatic color selection can be set up using the Auto Page.)

6. Enter the Y offset to be used or click the Auto Offset button. This allows the curves to be offset in the Y direction. (The automatic offset selection can be set up using the Auto Page.)
Customizing the Graphs

**Figure 4.24  Curve Symbol Window**

7. Edit the filename, if desired.

8. Check the Show Legend Text box, if you want to show any information for this curve in the legend. You can also edit the legend text here. The individual items displayed for each legend entry are selected on the Legend Page.

9. Save the curve overlay options when you have finished the manual setup. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. The curve overlay results will be displayed.
Configuring the Axes Page

The Axes Page (shown below) displays the axes that have been set up for curve overlay using the Curves Page. Use this page to customize the axis labels that will be displayed on the curve overlay window.

![Curves Overlay Options](image)

**Figure 4.25**

*Curve Overlay Options—Axes Page*

Follow these steps to customize the axis labels using this window:

1. Edit the name(s) of the axis label(s) displayed, if desired. The units associated with the axis signal are displayed next to the name.

2. Check the box next to the desired items that you want to be displayed in the Y-axis label: Line type, Color, or Symbol.

3. Enter the desired X-axis offset. This allows curves to be offset by a fixed amount from each other in the X direction. (This does not apply to the first curve.) The X-axis offset can be used with Y-axis offsets to produce a simple 3-D (Z axis) effect on the plot.

4. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only. (The names entered here cannot be saved as a default setting.)
Configuring the Plot Heading Page

The **Plot Heading Page** (shown below) is used to customize the plot heading that will be placed on the curve overlay graph.

![Image of Curve Overlay Options window]

**Figure 4.26**
*Curve Overlay Options—Plot Heading Page*

Follow these steps to customize the plot heading using this window:

1. Enter the desired name (maximum of 80 characters) for the overlay window that will be created. This name will appear in the window title and Windows menu only. It is used to help identify one curve overlay plot from another.

2. Click on the desired button to choose the alignment of the text from the following justifications: Left, Center, or Right.

3. Enter up to four lines of 76 characters that are used for the plot header information.

4. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.
Configuring the Legend Page

The **Legend Page** (shown below) is used to customize the legend that appears on the curve overlay window. An entry in the legend appears for each curve that is displayed in the overlay graph.

![Curve Overlay Options](image)

*Figure 4.27\nCurve Overlay Options—Legend Page*

Follow these steps to choose what will appear in the legend:

1. Check the box next to the desired options that will be displayed in the legend: Border, Line type, Color, Symbol, File name, Text. See “Changing Colors, Line Types, Symbols, etc.” in this chapter for more information.

2. Select the x and y coordinates on the graph for the manual positioning of the legend. The coordinates are unitless and range from 0.0 to 1.0 on the X and Y axis.

**NOTE:** When the curve overlay window is displayed, you can drag and drop the legend anywhere on the graph.
3. Click on the radio buttons desired to select the position for the point of reference that is used to move the legend to the selected coordinates. For example, if you choose both center radio buttons, the center of legend box is positioned at the coordinates selected.

4. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

Configuring the Grid Page

Use the Grid Page (shown below) to select the grid that can be used for each axis.

![Grid Page](image)

**Figure 4.28**
*Curve Overlay Options—Grid Page*

Follow these steps to select the grid type:

1. Click on the radio button to choose the desired Y axis that will display the grid.

2. Select the grid type from the drop-down list.
3. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

Configuring the Auto Page

Use the **Auto Page** (shown below) to set up the Auto Line, Auto Symbol, Auto Color, and Auto Offset buttons shown on the **Curve Page** and the similar settings on the **Auto Configure** window. The settings shown on this page will be used when you click on those buttons.

![Curve Overlay Options](image)

**Figure 4.29**  
**Curve Overlay Options—Auto Page**

Follow these steps to configure the Auto buttons:

1. Select the desired line type for the first curve from the drop-down list.

2. Position the pointer over the first symbol field and click the mouse button to display the **Curve Symbol** window (see Figure 4.20). Choose the desired symbol type, then click OK. For more information on symbols see “Changing Colors, Line Types, Symbols, etc.”
3. Select the desired color for the first curve from the drop-down list.

4. Repeat steps 1, 2 and 3 for all ten curves.

5. Click on the desired radio button for the desired offset. See the next section “Results of Offset Selections” for details on the effect of these selections.
   
   • **Major axis tick**: Positions (offsets) each curve on the axis positively by an amount equal to a major axis tick when the Auto Offset button is selected.
   
   • **Minor axis tick**: Positions (offsets) each curve on the axis positively by an amount equal to a minor axis tick when the Auto Offset button is selected.
   
   • **Half minor axis tick**: Positions (offsets) each curve on the axis positively by an amount equal to a half minor axis tick when the Auto Offset button is selected.
   
   • **Percent of axis range**: Positions (offsets) each curve on the axis by an amount equal to the percentage of the axis range entered when the Auto Offset button is selected. Enter the desired percentage.

6. Check the box for negative offsets, if you want to use the offset chosen above as negatives.

7. Check the desired boxes for the axes that you want to autoscale. Any unchecked axes will not be autoscaled when using the curve overlay function. (The default setting is all axes checked.)

8. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this curve overlay only.

**Results of Offset Selections**

The **Auto Offset** selections result in the offset of the curves from each other as follows:

• No offset is applied to the first curve on an axis.

• The second curve is offset by the amount equal to one offset interval when the Auto Offset button is selected.

• The third curve is offset by an amount equal to twice the offset interval when the Auto Offset button is selected.
- The fourth curve is offset by the amount equal to three times the offset interval when the Auto Offset button is selected.

- And so on...

*Figure 4.30 Example of Finished Curve Overlay*

Once a curve overlay graph has been created and displayed, you can position the pointer over a curve Y-axis label or legend and right click to display the Curve Overlay Options window. This allows you to edit the curve overlay graph.

You can also reposition a curve on the overlay graph already created. Select the desired curve, then drag-and-drop it at the position you want using the left mouse button.
Customizing the Graphs

Exporting Plots

You may find that you would like to use the graph image that you have plotted using Universal Analysis in another application for a presentation or report, etc. It is possible to export the plot to a file for just such a purpose. It is suggested that you become familiar with the type of file that is compatible with your application before you use this function, or you can just export the plot to the clipboard and retrieve it into your application.

To export a plot, follow these steps:

1. Select File/Export Plot from the main menu. The Export Plot window, shown below, is displayed.

![Export Plot Window]

2. Select the plot’s destination from one of the following options:

   - **Clipboard** exports the plot to the computer clipboard so that it may be pasted into other applications after export. Note that you must also select the desired format—Metafile or Bitmap—before exporting the plot.
**NOTE:**

 Exporting Plots

- **File** exports the plot to a file. If you choose the file export option, you must enter a filename or use the Browse button to locate a filename. You must also select the format for export.

- **Plotter** exports the plot to a plotter. The plotter must already be configured online with your computer and connected to the port specified on the Main Options - Export Plot Page (select File/Options).

- **Printer** exports the plot to a printer. The printer must already be configured online with your computer.

  The default printer will be used unless you specify a different printer. Use the Setup button, if needed.

3. Select the format for export from the following options:

- **Metafile** exports your plot to a file using the Metafile format. If you select this option, you must also choose a Metafile type from the Metafile list.

- **Bitmap** exports your plot to a file using the Bitmap format. If you select this option, you must also choose a Bitmap pixel format to use from the drop-down list.

- **HPGL** exports your plot to a file using the HPGL format. If you select this option, you must also choose a HPGL symbol type from the HPGL list.

4. Select the desired colors for export from the drop-down list.

- **All Colors**: All of the colors shown on the monitor will be exported.

- **Dark Colors Only**: The light colors (white, yellow, aqua, and lime green) will be translated into darker colors.

- **Black and White Only**: All colors will be translated to black and white.

5. Select the size desired for the exported plot, if applicable:

- **Full Size** is 100% of the allowable size.

- **Reduction** reduces the plot to the percentage entered for height and width reduction.

- **Pixels** sizes the plot to the entered size in pixels.
6. Enter the desired pen width, if applicable.

7. Click on the Save button, if you want to save the settings for the plot destination chosen.

**NOTE:** You can set up each plot destination with its own settings, then click the Save button each time to save them as the default settings for that specific destination.

8. Click the Export button when completed.

**NOTE:** HPGL is the only format available when you export to a plotter.

**NOTE:** Changes made when exporting to the clipboard or printer affect the pasted plot (Edit/Copy Plot) and File/Print functions respectively.
Printing Plots

There are three different printing options you can select in Universal Analysis:

Print

To print your plots, select File/Print from the main menu. A standard Windows NT® Print dialog box is displayed, which lets you specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.

Or you click on the Print button to print directly to the default system printer without displaying the Print dialog box.

Print Preview

You can also preview the plots before it is printed using File/Print Preview on the main menu. An example of a plot shown in the Print Preview window can be seen in the figure on the next page.

Print Setup

To set up your particular printing options, select File/Print Setup from the main menu. The print setup dialog box specific to your printer will be displayed. Choose the options you want to use when printing plots in Universal Analysis.

NOTE: Changes that you have made on the Export Plot window (such as reductions) will be applied when you use the printing options described above.
Customizing the Graphs

**Figure 4.32**
Print Preview Window
Chapter 5
Analyzing the Data

Introduction ................................................................. 5-3
   Basic Analysis Steps ............................................... 5-3

Using the Analyze Menu .............................................. 5-4

Using the Analysis Pop-Up Menu ................................. 5-5

Setting the Analysis Range ........................................ 5-7
   Using the Full Range .............................................. 5-7
   Entering Limits ..................................................... 5-7
   Selecting a Cycle ................................................ 5-8
   Selecting a Multiplex Value ................................. 5-9

Tips on Using Markers .............................................. 5-10
   Active vs. Inactive Markers .................................. 5-10
   Moving Active Markers ....................................... 5-11
   Activating a Marker .......................................... 5-11

Step/Glass Transition Analysis .................................. 5-12

Weight Change ......................................................... 5-14

Temp/Time at Weight % ............................................ 5-16

Weight At Temp/Time ............................................... 5-17

Weight Loss Temp/Time ............................................ 5-17

Residue ........................................................................ 5-18

Modify Size ............................................................... 5-19
   Using Manual Limits to Modify Size ....................... 5-20
   Using Graphic Limits to Modify Size ..................... 5-21
   Using Graphic Start to Modify Size ...................... 5-22
   Using Graphic Finish to Modify Size ................... 5-23

Alpha At X ................................................................. 5-24

Alpha X1 to X2 .......................................................... 5-25

Alpha Fit X1 to X2 ..................................................... 5-26

Dimension Change .................................................... 5-27

Integrate Peak ......................................................... 5-28
   First Peak Integration ....................................... 5-28
   Additional Peak Integration Analyses .................. 5-28
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyzing the Data</td>
<td></td>
</tr>
<tr>
<td>Result of the Integration Analyses</td>
<td>5-29</td>
</tr>
<tr>
<td>Linear Baseline</td>
<td>5-30</td>
</tr>
<tr>
<td>Description of Sigmoidal Baselines</td>
<td>5-31</td>
</tr>
<tr>
<td>Sigmoidal Horizontal Baselines</td>
<td>5-31</td>
</tr>
<tr>
<td>Sigmoidal Tangent Baselines</td>
<td>5-32</td>
</tr>
<tr>
<td>Extrapolated Baseline</td>
<td>5-33</td>
</tr>
<tr>
<td>Perpendicular Drop Analysis</td>
<td>5-34</td>
</tr>
<tr>
<td>Tangent Analysis</td>
<td>5-35</td>
</tr>
<tr>
<td>Deleting Peak Integrations</td>
<td>5-36</td>
</tr>
<tr>
<td>Running Integral Analysis</td>
<td>5-36</td>
</tr>
<tr>
<td>Peak Max</td>
<td>5-38</td>
</tr>
<tr>
<td>Signal Max</td>
<td>5-38</td>
</tr>
<tr>
<td>Onset Point</td>
<td>5-39</td>
</tr>
<tr>
<td>Oxidation Time/Temp</td>
<td>5-40</td>
</tr>
<tr>
<td>Purity</td>
<td>5-41</td>
</tr>
<tr>
<td>Collecting DSC Purity Data</td>
<td>5-42</td>
</tr>
<tr>
<td>Guidelines for Data Collection</td>
<td>5-42</td>
</tr>
<tr>
<td>Analyzing for Purity</td>
<td>5-43</td>
</tr>
<tr>
<td>Selecting Purity Analysis Options</td>
<td>5-45</td>
</tr>
<tr>
<td>Purity Analysis Options - Partial Area Page</td>
<td>5-45</td>
</tr>
<tr>
<td>Purity Analysis Options - Purity Calculation Page</td>
<td>5-46</td>
</tr>
<tr>
<td>Purity Analysis Options – Results Plot Page</td>
<td>5-48</td>
</tr>
<tr>
<td>Purity Analysis Options – Results Label Page</td>
<td>5-49</td>
</tr>
<tr>
<td>Slope</td>
<td>5-52</td>
</tr>
<tr>
<td>Running Integral</td>
<td>5-53</td>
</tr>
<tr>
<td>Curve Value at X/Y</td>
<td>5-55</td>
</tr>
<tr>
<td>Label at X,Y</td>
<td>5-57</td>
</tr>
<tr>
<td>Setting the Analysis Options</td>
<td>5-58</td>
</tr>
<tr>
<td>Step Transition Page</td>
<td>5-58</td>
</tr>
<tr>
<td>Choosing the Midpoint</td>
<td>5-60</td>
</tr>
<tr>
<td>Choosing the Step Change Options</td>
<td>5-61</td>
</tr>
<tr>
<td>Onset/Peak Integration Page</td>
<td>5-62</td>
</tr>
<tr>
<td>List of Integration Weight Options</td>
<td>5-64</td>
</tr>
<tr>
<td>Special Area Page</td>
<td>5-64</td>
</tr>
<tr>
<td>Resolution Page</td>
<td>5-66</td>
</tr>
<tr>
<td>Other Page</td>
<td>5-67</td>
</tr>
<tr>
<td>Adjusting Analysis Results</td>
<td>5-68</td>
</tr>
<tr>
<td>Removing Analysis Results</td>
<td>5-69</td>
</tr>
</tbody>
</table>
Introduction

After you have used the other features contained in the Universal Analysis program to set up your graph the way you want it to appear, you can analyze the data using the functions found in this chapter.

Although each type of analysis is different, there are basic steps that generally apply to most of the analyses.

Basic Analysis Steps

Most of the analyses that you can perform in the Universal Analysis will follow the same basic steps. There may be additional information that you need to enter through special dialogs, but most of the analyses involve choosing and accepting limit points. You can apply the following basic steps to most types of analyses in the Universal Analysis program.

1. Click on the appropriate Y-number label displayed above the desired axis on the graph to select that axis, if more than one Y-axis is displayed.

2. If you are analyzing a curve from a family of curves, (e.g., multiplexed data) select the desired curve for the analysis by choosing Edit/Frequency List, Edit/Amplitude List, or Edit/Location List then selecting the desired curve (or by using the Analyze/Analyze Range options).

3. Select the desired operation from the Analyze menu, from the pop-up menu, or click the appropriate tool bar button. One or more markers are displayed. (See “Tips on Using Markers,” found on page 5-10.)

4. Double click at the point on the curve where you want the baseline to begin (before the transition) to position the first marker. The next marker (if applicable) becomes active.

5. Double click at the point on the curve where you want the baseline to end (after the transition) to position the second marker. Repeat steps 3 and 4 if additional points are required for your analysis.

6. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The analysis results are displayed.

7. Change the position of the fitted lines, if desired, by selecting Adjust Results from the Edit or pop-up menu.

**NOTE:** You can change the parameters of certain analyses before they are performed by using Analyze/Options to set the desired analysis options, see page 5-58 for details.
Using the Analyze Menu

The Analyze menu is used to choose the type of analysis that you want to perform on the current data file. This menu reflects the type of analyses available for the particular type of signal that is currently selected (see the menus below). For example, if an SDT data file is currently active, and a TGA signal has been selected, the analyze menu contains only those types of analyses that relate to TGA analysis.

A set of generic analyses are always available for any signal selected. Signal-specific analyses are only available when that signal is selected and displayed as “normal” type (with no derivative applied).

NOTE:

When the analysis results are displayed, you can drag and drop the results anywhere on the graph.

<table>
<thead>
<tr>
<th>DEA Analyze Menu</th>
<th>DMA Analyze Menu</th>
<th>DSC/DTA/μTA Analyze Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrate Peak</td>
<td>Integrate Peak</td>
<td>Integrate Peak</td>
</tr>
<tr>
<td>Peak Max</td>
<td>Peak Max</td>
<td>Peak Max</td>
</tr>
<tr>
<td>Signal Max</td>
<td>Signal Max</td>
<td>Signal Max</td>
</tr>
<tr>
<td>Step Transition</td>
<td>Step Transition</td>
<td>Step Transition</td>
</tr>
<tr>
<td>Onset Point</td>
<td>Onset Point</td>
<td>Onset Point</td>
</tr>
<tr>
<td>Slope</td>
<td>Slope</td>
<td>Slope</td>
</tr>
<tr>
<td>Running Integral</td>
<td>Running Integral</td>
<td>Running Integral</td>
</tr>
<tr>
<td>Curve Value At X</td>
<td>Curve Value At X</td>
<td>Curve Value At X</td>
</tr>
<tr>
<td>Curve Value At Y</td>
<td>Curve Value At Y</td>
<td>Curve Value At Y</td>
</tr>
<tr>
<td>Label At X, Y</td>
<td>Label At X, Y</td>
<td>Label At X, Y</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TGA/SDT Analyze Menu</th>
<th>TMA Analyze Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Transition</td>
<td>Alpha At X</td>
</tr>
<tr>
<td>Weight Change</td>
<td>Alpha X1 To X2</td>
</tr>
<tr>
<td>Temp At Weight %</td>
<td>Alpha F1 X1 To X2</td>
</tr>
<tr>
<td>Weight Loss Temp</td>
<td>Dimension Change</td>
</tr>
<tr>
<td>Residue</td>
<td></td>
</tr>
<tr>
<td>Modify Size</td>
<td></td>
</tr>
<tr>
<td>Integrate Peak</td>
<td>Integrate Peak</td>
</tr>
<tr>
<td>Peak Max</td>
<td>Peak Max</td>
</tr>
<tr>
<td>Signal Max</td>
<td>Signal Max</td>
</tr>
<tr>
<td>Step Transition</td>
<td>Step Transition</td>
</tr>
<tr>
<td>Onset Point</td>
<td>Onset Point</td>
</tr>
<tr>
<td>Slope</td>
<td>Slope</td>
</tr>
<tr>
<td>Running Integral</td>
<td>Running Integral</td>
</tr>
<tr>
<td>Curve Value At X</td>
<td>Curve Value At X</td>
</tr>
<tr>
<td>Curve Value At Y</td>
<td>Curve Value At Y</td>
</tr>
<tr>
<td>Label At X, Y</td>
<td>Label At X, Y</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Analysis Range</th>
<th>Analysis Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro</td>
<td>Macro</td>
</tr>
</tbody>
</table>

Options...
This chapter will discuss each one of the different types of analysis in further detail on the pages that follow.

Using the Analysis Pop-Up Menu

After you have selected an analysis option from the Analyze menu, a pop-up menu becomes available. This Analysis pop-up menu allows you to change to a manual method for entering data limits, accept the limits chosen, cancel the operation, or choose a point to enter.

The menu items found on the Analysis pop-up menu are described in the following pages:

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Limits</td>
<td>Use the Accept Limits function to accept the chosen data limits for analysis. The results of the analysis will be displayed on the graph.</td>
</tr>
<tr>
<td>Manual Limits</td>
<td>Use the Manual Limits function to select limit points by entering numeric values from the keyboard. When you select this option the Manual Limits window is displayed, allowing you to enter the numerical values desired.</td>
</tr>
<tr>
<td>Auto Limits</td>
<td>Use the Auto Limits function, which is available for certain types of analyses, to store and then automatically reuse stored analysis limits. This option is good for repeating a particular analysis on similar data files and take the uncertainty factor out of trying to choose the correct analysis limits. The desired position of the cursors relative to the peak can be predetermined using the Auto Limits feature. Then when you analyze similar data files, you can recall the appropriate cursor position and perform accurate analyses quickly. When you select this option a window is displayed that allows you to either use the cursor (marker) position that the operator selects or to use an offset (or differential fraction).</td>
</tr>
</tbody>
</table>

*(table continued)*
## Table 5.1
### Analysis Pop-Up Menu Items (cont’d)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Use the Cancel option to abort the operation chosen.</td>
</tr>
<tr>
<td>Point 1,2,3,4,5,6</td>
<td>Use the Point menu items to activate the applicable marker on the graph. This allows you to more accurately position the markers for analysis. The number of points available depend upon the type of analysis and the chosen analysis options.</td>
</tr>
</tbody>
</table>
Setting the Analysis Range

The **Analysis Range** option is used to set the analysis range from portions of the original X-axis range, thus confining your data for analysis purposes to the chosen range. Data outside this range becomes invisible to the analysis functions, but analyses already performed on these curves are retained.

When you select **Analyze/Analysis Range** from the main menu, the menu (example shown here) is displayed.

The items shown in the menu are explained in this section on the following pages.

Using the Full Range

The **Analyze Range/Full Range** menu option is used to restore all of the data points available in the file for analysis after the range has been limited by one of the other analysis range options.

Entering Limits

The **Analyze Range/Enter Limits** menu option is used to select points for the new analysis range.

1. Select **Enter Limits** from the **Analyze/Analysis Range** menu. Markers will be displayed on the graph.

2. Double click on the desired place on the curve to position the marker at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next marker at the end of the region you want to analyze.

4. Right click to display the **Analyze pop-up** menu, then select **Accept Limits** (or press Enter). The graph is redrawn using the analysis limits chosen.

**NOTE:** Data outside the analysis range is drawn in the grid color instead of the normal curve color.
Analyzing the Data

**NOTE:** When the program redraws the plot, part or all of the region you rejected for analysis may be excluded. To view the entire graph again, select Rescale/Previous Limits. The previous limit points will be shown, but your analysis range will still be restricted, as indicated by the grid color of the data outside the analysis range.

**Selecting a Cycle**

The Analyze Range/Select Cycle option is used to segregate data using the cycle markers contained in the data file. (See the online manual accompanying Thermal Advantage Instrument Control for information on creating methods that will add cycle markers to your data.)

1. Choose Select Cycle from the Analyze/Analysis Range menu. The Data Cycle window, shown in the figure below, is displayed.

![Data Cycle Window](image)

**Figure 5.1**

Data Cycle Window

2. Enter the desired cycle number to be used for analysis.

3. Click the OK button.

**NOTE:** This option is only available for data files containing either cycle markers, multiplexed data, or data storage off/on method segments.
Selecting a Multiplex Value

The Analyze Range/Select Frequency (Amplitude or Location) option is used to separate the data according to a chosen multiplex value. This option is very useful when performing a function (such as analysis) on an individual value.

1. Choose Select Frequency or Select Amplitude or Select Location from the Analyze/Analysis Range menu. A window, such as the Data Frequency window shown below, is displayed.

![Data Frequency Window](image)

2. Click on the button to display the drop-down list of multiplex values available.

3. Click on the desired value, then click the OK button. The data in that range will be available for analysis. The data outside the analysis range will be grayed out.
Tips on Using Markers

Markers are lines that are used to select points on a graph during rescaling and analysis operations. Depending on the action and/or the file, markers will be displayed as a single vertical line or as a set of vertical and horizontal lines.

When using markers, keep in mind the following tips:

Active vs. Inactive Markers

- Only one marker is active at any time.
- The active marker can be indicated two ways depending on the action or file: As a full-length vertical and horizontal line or as a single vertical or horizontal line.
- Inactive markers are generally seen as a cross.

![Graph showing Active and Inactive Markers](image)

Figure 5.3
Example of Active and Inactive Markers
Moving Active Markers

- To move active markers with the mouse follow these steps:
  1. Grab the marker with the left mouse button as follows: Position the point at the intersection of the cross or anywhere on the single line. Press and hold down the left mouse button.
  2. Drag the marker to the desired position and release the mouse button.

- To move the active marker with the keyboard, use the right and left arrow to move the marker or hold down the Ctrl key or Shift key while using the arrows to move the marker 10 pixels at a time.

- To move an active marker quickly you can also position the pointer at the desired location and double click the left mouse button to move the marker to this point. This action causes the next marker to become active.

Activating a Marker

To activate (select) the next marker you can use any one of these methods:

- Position the pointer over the inactive marker and click the left mouse button.

  or

- Right click to display the pop-up Analyze menu and select the next point from the menu.

NOTE: When using markers to perform peak integration, you can drag-and-drop the first set of markers to encompass the first peak. Then, if you want to analyze a neighboring peak on the curve, you can leave the right-hand marker in its existing position (thereby keeping the exact same data point, which will become the start point of the second peak) and drag-and-drop the left-had marker at the stop point desired for the second peak.
Step/Glass Transition Analysis

The Step Transition or Glass Transition analyses (both are very similar) are used to calculate the onset, end, inflection, and signal change of a step/glass transition in the curve. For example, this analysis enables you to determine DSC glass transition.

- **Onset** is the intersection of the first and second tangents.
- **Inflection** is the portion of the curve between the first and third tangents with the steepest slope.
- **End** is the intersection of the second and third tangents.

**NOTE:**

The Step/Glass Transition option is not available if the Y-axis scale is log.

The step/glass transition can be done in either of two ways: automatic mode (which is the default condition) or manual mode (selected on the Analysis Options - Step Transition Page).

- In automatic mode the program draws three tangent lines between the two data limits that you select.

- In the manual mode, you specify the start and stop limits for each of the three tangent lines. The intersection of the first two lines is the onset, and the intersection of the second two is the end.

Follow these steps to perform the step/glass transition analysis:

1. Select Step Transition or Glass Transition from the Analyze menu. Markers will be displayed on the graph.

2. Position the active marker by double clicking on the curve at the point where the data for the tangent line will begin.
3. Position the second marker by double clicking on the curve at the point where the data for the tangent line will end.

4. If you are using manual mode, repeat steps 2 and 3 for Points 3 through 6 until all six markers have been placed.

5. **TGA data only**: The **Transition Label** window (see the figure on the next page) is displayed. Enter the desired text (up to 30 characters) and click the **OK** button.

6. Right click to display the **Analyze** pop-up menu, then select Accept Limits (or press **Enter**).

The program draws the tangent lines, calculates and displays the onset, midpoint, and end.

---

**Figure 5.4**  
**Example of Step Transition Analysis**

**NOTE:** You can change the parameters of this analysis by using **Analyze/Options** to set the desired analysis options.
Weight Change

The **Weight Change** option is used to determine the amount of change in the weight between two points on a TGA curve. A horizontal line is drawn from your selected start point to a vertical line drawn from your selected stop point. The difference between these points is reported in the units of the Y-axis.

Follow these steps to determine the TGA weight change:

1. Select **Weight Change** from the **Analyze** menu. Markers will be displayed on the graph.

2. Double click on the desired place on the curve to position the marker at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next marker at the end of the region you want to analyze.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The **Transition Label** window is displayed.

5. Enter any text that you want to display on the graph (up to 30 characters), then click on the OK button.

The program calculates the weight change and displays the results in percent and in the units of the Y-axis as shown in the figure on the next page.
Figure 5.6
Example of Weight Change Analysis
Temp/Time at Weight %

The Temp/Time at Weight % option is used to locate the X-axis value on a TGA curve (either time or temperature) that corresponds to a selected Y-axis value, and label the graph with the weight percent.

NOTE:

This analysis is only available when the selected Y-axis units are in % weight.

Follow these steps to perform this analysis:

1. Select Temp/Time at Weight % from the Analyze menu. A marker will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which you want the corresponding X-axis value (either temperature or time).

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program calculates the results and marks the graph with a cross at the selected point and labels it with the corresponding X- and Y-axis values as seen in the figure below.

![Graph Example](image)

Figure 5.7
Example Temp at Weight % Analysis.
**Weight At Temp/Time**

Use the **Weight At Temp/Time** option to locate the X-axis value on a TGA curve (either time or temperature) that corresponds to a selected Y-axis value, and label the graph with the weight remaining in the sample.

Follow these steps to perform this analysis:

1. Select **Weight At Temp/Time** from the **Analyze** menu. A marker will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which you want the corresponding X-axis value (either temperature or time).

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program calculates the results and marks the graph with a cross at the selected point and labels it with the corresponding X- and Y-axis values.

**Weight Loss Temp/Time**

Use the **Weight Loss Temp/Time** option to locate the X-axis value on a TGA curve (either temperature or time respectively) that corresponds to a selected Y-axis value, and label the graph with the weight lost (µg, mg, or %) from the sample (from the original or 100 % weight).

Follow these steps to perform this analysis:

1. Select **Weight Loss Temp** or **Weight Loss Time** from the **Analyze** menu. A marker will be displayed on the graph.

2. Position the horizontal marker at the weight on the curve for which you want the corresponding X-axis value (either temperature or time).

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program calculates the results and marks the graph with a cross at the select point and labels it with the time or temperature and the corresponding weight lost from the sample (from the original weight).

**NOTE:**

This analysis is only available when the selected Y-axis units are weight.
Residue

The **Residue** option is used to report the difference between any selected point on the TGA curve and the final weight. The final weight is assumed to be zero, but can be modified to any value using the **Modify Size** option.

Follow these steps to perform this analysis:

1. Select **Residue** from the Analyze menu. A marker will be displayed on the graph.

2. Position the marker at the point on the curve that you want to analyze.

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The **Transition Label** window is displayed.

4. Enter any text that you want to display on the graph (up to 30 characters), then click on the OK button.

The program calculates the residue and displays the results on the graph, along with the transition label as shown in the example below.

![Image of a TGA graph showing residue analysis](image)

*Figure 5.8: Example of Residue*
Modify Size

The Modify Size options (menu shown here) for TGA files are used to modify the sample weight used in the percent weight calculations. This allows you to provide volatile-free and ash-free results. These options can also be used to isolate a reaction from other side reactions (e.g., oxidation).

**NOTE:**

The Modify Size options are available only when the weight signal is plotted in percent.

The default sample weight is the weight measured at the start of the run. You can change the start and/or the stop weight, and the program will adjust the percent axis based on the new weight. The shape of the curve itself does not change.

After you have used one of the Modify Size analysis options (which are explained on the following pages) to change the size, any subsequent analyses are based on the new modified size—previous analysis results are unaffected.

If you want to restore the original size after modifying it, select **Graph/Data Limits/Full Range** from the main menu. All analyses performed on the modified size will be lost.
Analyzing the Data

Using Manual Limits to Modify Size

The Modify Size/Manual Limits option is used to enter start (100%) and final (0%) sample weights directly from the keyboard as follows:

1. Select Modify Size/Manual Limits from the Analyze menu. The Modified Size Limits window is displayed to allow you to change the size.

NOTE: The current sample size is displayed for reference.

![Modified Size Limits Window](image)

2. Enter the desired start weight.

3. Enter the desired final weight.

4. Click the OK button. The entries are shown again for confirmation. The modified sample weight is the difference between these two points.

5. Click OK again to accept the weights displayed.

The program adjusts the percent axis (y-axis) to the modified weight and alters the axis label to reflect the changes.

After you have used one of the Modify Size analysis options to change the size, any subsequent analyses are based on the new modified size—previous analysis results are unaffected.

If you want to restore the original size after modifying it, select Graph/Data Limits/Full Range from the main menu. All analyses performed on the modified size will be lost.
Using Graphic Limits to Modify Size

The **Modify Size/Graphic Limits** option is used to enter start (100%) and final (0%) sample weights by choosing corresponding X-axis points (temperature or time) using the markers.

Follow these steps to perform this analysis:

1. Select **Modify Size/Graphic Limits** from the **Analyze** menu. Markers will be displayed on the graph.

2. Double click on the desired place on the curve to position the marker at the beginning of the region of the curve you want to analyze.

3. Double click on the desired place on the curve to position the next marker at the end of the region you want to analyze.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The modified size values are displayed for verification.

5. Click the OK button to accept the modified weight or Cancel to exit the analysis. If you accept the results, the program adjusts the percent axis (y-axis) to the modified weight.

After you have used one of the **Modify Size** analysis options to change the size, any subsequent analyses are based on the new modified size—previous analysis results are unaffected.

If you want to restore the original size after modifying it, select **Graph/Data Limits/Full Range** from the main menu. All analyses performed on the modified size will be lost.
Using Graphic Start to Modify Size

The **Modify Size/Graphic Start** option is used to select a volatile-free start weight using a marker to choose a corresponding X-axis point (temperature or time). The modified sample weight is considered the difference between the chosen point and the stop point.

Follow these steps to perform this analysis:

1. Select **Modify Size/Graphic Start** from the **Analyze** menu. A marker is displayed on the graph.

2. Position the marker at the desired start weight.

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The modified size values are displayed for verification.

4. Click the OK button to accept the modified weight or Cancel to exit the analysis. If you accept the results, the program adjusts the percent axis (y-axis) to the modified weight.

After you have used one of the **Modify Size** analysis options to change the size, any subsequent analyses are based on the new modified size—previous analysis results are unaffected.

If you want to restore the original size after modifying it, select **Graph/Data Limits/Full Range** from the main menu. All analyses performed on the modified size will be lost.
Using Graphic Finish to Modify Size

The **Modify Size/Graphic Finish** option is used to select an ash-free final weight using a marker to choose a corresponding X-axis point (temperature or time). The modified sample weight is considered the difference between the chosen point and the stop point.

Follow these steps to perform this analysis:

1. Select **Modify Size/Graphic Finish** from the **Analyze** menu. A marker is displayed on the graph.

2. Position the marker at the desired final weight.

3. Right click to display the **Analyze** pop-up menu, then select **Accept Limits** (or press Enter). The modified size values are displayed for verification.

4. Click the OK button to accept the modified weight or Cancel to exit the analysis. If you accept the results, the program adjusts the percent axis (y-axis) to the modified weight.

After you have used one of the **Modify Size** analysis options to change the size, any subsequent analyses are based on the new modified size—previous analysis results are unaffected.

If you want to restore the original size after modifying it, select **Graph/Data Limits/Full Range** from the main menu. All analyses performed on the modified size will be lost.
Alpha At X

The **Alpha at X** option is used to calculate the expansion coefficient (alpha) using a single point on a TMA curve. Alpha is calculated from the smoothed digital derivative at the point.

Follow these steps to perform this analysis:

1. Select **Alpha At X** from the Analyze menu. A marker is displayed on the graph.

2. Double click at the region of the curve that you want to analyze to position the marker.

3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program will calculate the expansion coefficient (alpha) at the single point X. The result plus the temperature at the chosen point will be added to the graph.

**NOTE:** This option is only available when a dimension change signal is selected.
Alpha X1 to X2

The **Alpha X1 to X2** option is used to calculate the expansion coefficient changes in dimension, divided by the change in temperature between two selected points on a TMA curve.

Follow these steps to perform this analysis:

1. Select **Alpha X1 to X2** from the Analyze menu. Markers will be displayed on the graph.

2. Double click at the beginning of the region of the curve that you want to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program will calculate the expansion coefficient (alpha) between the two points. The result plus the temperature values of the two analysis limits will be added to the graph. See the figure below for an example of Alpha X1 to X2 analysis.

---

**NOTE:** This option is only available when a dimension change signal is selected.

---

**Figure 5.10**
**Example Alpha X1 to X2**
Alpha Fit X1 to X2

The **Alpha Fit X1 to X2** option is used to calculate an expansion coefficient that is measured as the slope of a line fit through a region of data between two points on a TMA curve.

Follow these steps to perform this analysis:

1. Select **Alpha Fit X1 to X2** from the Analyze menu. Markers will be displayed on the graph.

2. Double click at the beginning of the region of the curve that you want to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program will calculate the expansion coefficient as a linear fit through the data between the two points. The result plus the temperature values of the two analysis limits will be added to the graph.

**NOTES:**

Endpoints may not lie exactly on the curve because a line has been fitted through the data.

This option is only available when a dimension change signal is selected.
Dimension Change

During your TMA experiment, the sample will react to the changes in the physical environment placed upon it. This may be a change in temperature, force, or atmosphere. The resulting dimension change of the TMA sample is detected by the instrument’s probe and can be measured between any two points on the data curve using the Dimension Change option.

Follow these steps to perform this analysis:

1. Select Dimension Change from the Analyze menu. Markers will be displayed on the graph.

2. Double click at the beginning of the region of the curve that you want to analyze to position the marker.

3. Double click at the end of the region of the curve that you want to analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter).

The program will calculate the dimension change of the sample within the specified limits, drawing a horizontal line from point 1 and a vertical line from point 2. The results are displayed on the graph. See the figure below for an example of Dimension Change analysis.

**NOTE:**

This option is only available when a dimension change signal is selected.

![Dimension Change Graph](image)

**Figure 5.11**
Example of Dimension Change
Integrate Peak

The Integrate Peak menu contains analysis options that are used to calculate and report start and stop temperatures, onset temperature, peak maximum temperature, and peak area.

When you first select the Integrate Peak menu, it appears as shown here, with certain options grayed out.

First Peak Integration

Perform the first peak integration analysis by selecting the type of baseline to be used from the following Integrate Peak menu items:

- Linear
- Sigmoidal Horizontal
- Sigmoidal Tangent
- Extrapolated

These types of baselines are further described in this section, on pages 5-30 to 5-34.

The peak is integrated with respect to time between the start and stop baseline limits.

Additional Peak Integration Analyses

Once a peak integration has been conducted for the first time on a curve, a number of additional peak integration analyses (see the menu here) are available when you reselect Integrate Peak from the Analyze menu.

- Perpendicular Drop
- Tangent
- Delete Peak
- Running Integral

These additional analyses are further described in this section, on pages 5-34 to 5-37.
Result of the Integration Analyses

The peak onset is at the intersection of the onset tangent line with the baseline. The onset tangent line is fit to the current X-axis type, and can be selected in automatic mode (the default condition) or manual mode (selected using the Analysis Options - Onset/Peak Integration Page.)

- In automatic mode you select the baseline limits, and the program defines the onset line as the line tangent to the curve at the inflection point (the inflection is the steepest 1/10 portion of the curve from peak start to peak max).

- In manual mode you also select the data limits for the onset tangent line. (If you use the Manual Limits Window to enter the limit points, be sure to specifically enter or tab through all four entries for the limit points to ensure that the program picks up the exact limit values.)

NOTE:

The onset line and onset point are not displayed if the axis scaling is log.

If the data shows superheating or supercooling (temperature decreases or increases by more than 0.25°C), the onset point is at the superheating or supercooling point. Superheating and supercooling are detected only if the X-axis is temperature.

- DSC Peak Integration: The program uses the sample size to normalize the area under the peak and obtain the experimental heat in joules per gram. If the sample size is zero, the heat is expressed in joules. If the Y-axis heat units are calories instead of watts, the area is reported in calories per gram (or millicalories if the sample size is zero). If you want the results reported in mJ, uncheck the Normalized Area option on the Analysis Options - Onset/Peak Integration Page.

- DTA Peak Integration: If the DTA sample size is not zero, the peak area is normalized to °C times minutes per milligram. If the sample is zero, the area is expressed in °C times minutes. If you want the results reported in mJ, uncheck the Normalized Area option on the Analysis Options - Onset/Peak Integration Page.

- Peak Integration Using Other Instruments: The peak area is not normalized for other instrument types.
The Integrate Peak/Linear option is used to perform a peak integration using a linear baseline. A linear baseline (shown here) is defined as a straight line drawn between the selected start and stop limits. It is used when the baseline varies directly (linearly) with time.

Follow these steps to perform this analysis:

1. Select Linear from the Analyze/Integrate Peak menu. Markers will be displayed on the graph.

2. Double click at the place on the curve where you want the baseline to begin to position the marker.

3. Double click at the place on the curve where you want the baseline to end to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The peak integration analysis results are displayed.

**NOTE:** You can change the parameters of this analysis by setting the options found on the Analysis Options - Onset/Peak Integration Page.
Description of Sigmoidal Baselines

A sigmoidal baseline is an s-shaped line that changes in level and/or slope before or after a peak. It is used to compensate for the change in baseline that occurs during a transition; the baseline is adjusted for the fraction reacted (alpha) versus time.

A sigmoidal baseline initially is calculated as a straight line from peak start to peak end. It is then recalculated for each data point between the peak limits as the weighted average between the projected horizontal or tangent baselines at peak start and end. The weighting factors for a given point are: (1) one minus alpha times the initial baseline and (2) alpha times the final baseline. The area is then recalculated with the new baseline. If the new area differs from the previous area by more than one percent, the area is recalculated and the sigmoidal curve shifted repeatedly until two consecutive calculations of the area differ by no more than one percent. If the baseline fails to converge within ten iterations, the calculation is aborted. The convergence of the baseline can be observed by checking the “Draw sigmoidal baseline iterations” box on the Analysis Options – Other Page.

Sigmoidal Horizontal Baselines

To calculate a sigmoidal horizontal baseline, two lines are drawn between the selected limits, then a sigmoidal curve is drawn with its midpoint halfway between the horizontals. This baseline type is used when the glass transition and cure overlap.

Follow these steps to perform this analysis:

1. Select Sig Horizontal from the Analyze/Integrate Peak menu. Markers will be displayed on the graph.

2. Double click at the place on the curve where you want the baseline to begin to position the marker.

3. Double click at the place on the curve where you want the baseline to end to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The peak integration analysis results are displayed.

NOTE: You can change the parameters of this analysis by setting the options found on the Analysis Options - Onset/Peak Integration Page.
Sigmoidal Tangent Baselines

To calculate a sigmoidal tangent baseline, two tangent lines are fit within the selected limits on each side of the transition. A sigmoidal curve then joins the tangent lines.

Follow these steps to perform this analysis:

1. Select **Sig Tangent** from the **Analyze/Integrate Peak** menu. Markers will be displayed on the graph.

2. Right click to display the Analyze pop-up menu, then select Point 1 to activate the first marker.

3. Position the first marker so that it intersects the curve where you want the first tangent line to begin.

4. Right click to display the Analyze pop-up menu again, then select Point 2.

5. Position the second marker where you want the first tangent line to end.

6. Right click to display the Analyze pop-up menu again, then select Point 3.

7. Position the third marker so that it intersects the curve where you want the second tangent line to begin.

8. Right click to display the Analyze pop-up menu again, then select Point 4.

9. Position the fourth marker where you want the second tangent line to end.

10. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The peak integration analysis results are displayed.

**NOTE:** You can change the parameters of this analysis by setting the options found on the **Analysis Options - Onset/Peak Integration Page**.
Extrapolated Baseline

The **Integrate Peak/Extrapolated** option is used to perform a peak integration using an extrapolated baseline.

To calculate an extrapolated baseline, four points are selected (in any order). The program automatically sorts the points. Tangent lines will be drawn between two of the points so that the extrapolated baseline intersects the range of data bracketed by the other two points (intersection range). The program automatically determines whether the first two points (as seen in Figure A) or the last two points (as seen in Figure B) specify the tangent line. This is accomplished by the program as it tries both potential tangent lines and then uses the tangent line that will intersect the data between the other points.

**Figure A**

![Figure A](image)

**Figure B**

![Figure B](image)

For example, in Figure A, a tangent line drawn between Point 1 and Point 2 will not intersect the data found between Points 3 and 4. This arrangement is discarded as incorrect. The program will then draw a tangent line between Points 3 and 4. This tangent line does intersect the data found between Points 1 and 2, so this becomes the final extrapolated baseline.

If two of the four points are placed on top of each other, the baseline is extrapolated to be a horizontal baseline from these two points to intersect the data between the other two points, as seen in Figure C on the next page.
Perpendicular Drop Analysis

After you have performed at least one peak integration on a curve, the Perpendicular Drop option becomes available when you reselect Integrate Peak from the Analyze menu.

When you perform the perpendicular drop function, it subdivides a peak with a perpendicular line drawn from a selected point on the curve to the baseline. This is helpful if you have transitions that overlap each other and must be analyzed separately.

NOTE: The Perpendicular Drop option is not available if the Y-axis scale is log.

Follow these steps to perform this analysis:

1. Perform at least one peak integration.

2. Select Perpendicular Drop from the Analyze/Integrate Peak menu. A marker is displayed on the graph.

3. Position the vertical bar of the marker at the point where you want to bisect the curve.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates the area of the subpeak marked off by your perpendicular line.
**Tangent Analysis**

After you have performed at least one peak integration on a curve, the Tangent option becomes available when you reselect Integrate Peak from the Analyze menu.

When you use the Tangent integrate peak option, the program uses a line tangent to the curve (determined by a least-squares fit) to find the area of a subpeak between two points (shown here). Results displayed are the area of the subpeak, the area of the main peak, the total area, and the onset.

**NOTE:**

The Tangent option is not available if the Y-axis scale is log.

Follow these steps to perform this analysis:

1. Perform at least one peak integration.

2. Select Tangent from the Analyze/Integrate Peak menu. Markers will be displayed on the graph.

3. Double click at the place on the curve where you want the tangent line to begin to position the marker.

4. Double click at the place on the curve where you want the tangent line to end to position the second marker.

5. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates the area of the subpeak marked off by your tangent line.
Analyzing the Data

Deleting Peak Integrations

The Integrate Peak/Delete Peak option is used to delete the results of a selected peak integration so that you can reanalyze the peak without deleting all of the results. If the deleted peak is a tangent or perpendicular drop subpeak, its area is returned to the peak that was subdivided. If the deleted peak contains any subpeaks, they too are deleted.

Follow these steps to delete peaks:

1. Select Delete Peak from the Analyze/Integrate Peak menu. A marker is displayed on the graph.
2. Position the vertical bar of the marker within the limits of the peak integration results you wish to delete.
3. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The selected results are deleted.

Running Integral Analysis

The Integrate Peak/Running Integral option is used to graph the integral of the data based on peak integration. This analysis is useful when you want to determine the area under a peak or the ratio of different materials within a sample. For example, in TGA, this function is valuable for determining the relative amounts of evolved gases in a material. In DSC, it can be used to calculate the percent composition of polymer blends.

NOTE: The Running Integral option is not available if the Y4 axis is being used to graph a data signal.

Follow these steps to perform this analysis:

1. Perform at least one peak integration.
2. Select Running Integral from the Analyze/Integrate Peak menu. A marker is displayed on the graph.
3. Position the marker within the limits of the peak integration results on which you wish to perform a running integral analysis.
4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The Integral Type window, shown on the next page, is displayed.
5. Select the running area type from the types displayed:

- **Integral**: The program plots the raw integrated data.
- **Area Percent**: The program takes the end result of the raw integration and shows the percent contribution of each peak in the selected region of the curve (assuming the selected region to be 100%). If you want to determine the percent composition of various components in a material, select the area percent option. Then, when the program finishes plotting the integral curve, use the Curve Value analysis to mark each step of the curve with its percent contribution.
- **Normalized**: For DSC files only. The program plots the integral curve in normalized units (Joules/g).
- **Inverted**: The program multiplies the normal integral by minus one, and computes the area percent integral from 100 percent down to zero percent.

6. Choose from the following running area baseline choices:

- **Linear baseline**: When you select this option the baseline will be anchored to the curve at the integral limit points. The area will be integrated with respect to the linear baseline between the analysis limits.

- **Zero baseline (absolute integral)**: When you select this option, the area will be integrated with respect to a baseline set to zero on the y axis, which calculates the absolute integral.

**NOTE:** In both cases above the baseline is linear, unless the peak running integral is selected with Sigmoidal baseline peak integration.

7. Click on OK. The program calculates the integral of the peak based on the peak integration results and displays the result on the Y4 axis.
NOTE: You must use the Analyze/Integrate Peak/Running Integral analysis to obtain the correct peak area when integrating over a sigmoidal baseline. The more general Analyze/Running Integral analysis always uses a linear baseline for integration, which will give a different running area than that reported by the Peak Integration analysis with a sigmoidal baseline.

Peak Max

The Peak Max analysis option is used to calculate a peak’s point of maximum deviation from a linear baseline drawn between two points on the curve. After you select the start and stop limits for the baseline, the program calculates and reports the height of the peak.

Follow these steps to perform this analysis:

1. Select Peak Max from the Analyze menu. Markers will be displayed on the graph.
2. Double click at the intersection of the baseline start to position the marker.
3. Double click at the intersection of the baseline stop to end to position the second marker.
4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates and displays the peak’s maximum deviation from the baseline.

NOTE: Peak Max and Signal Max analyses report the same maximum value if the baseline is horizontal (the curve Y-axis values of the start and stop limits are the same).

Signal Max

The Signal Max analysis option is used to calculate the maximum signal value between two selected points.

Follow these step to perform this analysis:

1. Select Signal Max from the Analyze menu. Markers will be displayed on the graph.
2. Double click at the intersection of the desired start point to position the marker.
3. Double click at the intersection of the desired stop point to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates and displays the maximum signal.

### Onset Point

Use the **Onset Point** analysis option to determine the temperature at which a change in the slope of the curve occurs (*i.e.*, the onset point of a transition). The onset point is defined as the intersection of an initial tangent line with a final tangent line.

Onset determination can be done in either of two ways: automatic mode (which is the default condition) or manual mode (selected on the **Analysis Options - Onset/Peak Integration Page**).

- In **manual mode**, you select the start and stop limits for each tangent line and the program fits two tangent lines to the curve.

- In **automatic mode**, you enter the start and stop limits to be used in the analysis, and the program takes care of the rest.

Follow these steps to perform this analysis:

1. Select **Onset Point** from the **Analyze** menu. Markers will be displayed on the graph.

2. Double click at the point where you want the data for the tangent line to begin to position the first marker.

3. Double click at the point where you want the tangent line to end to position the second marker. If you are using manual mode, repeat steps 2 and 3 for Points 3 and 4 until all four markers have been placed.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates and displays the onset point.
Oxidation Time/Temp

The Oxidation Time/Temp option is used to analyze DSC data from oxidation induction time (OIT) and oxidation temperature (OT) experiments.

- Oxidation induction time (OIT) is a DSC test method that measures the time to oxidation onset of a sample held at an isothermal temperature and in an oxidizing atmosphere.

- Oxidation temperature (OT) is a DSC test method that measures the oxidation onset temperature of a temperature-programmed sample in an oxidizing atmosphere.

Follow these steps to perform either analysis:

1. Select Oxidation Time/Temp from the Analyze menu.

   If you choose OIT as your analysis type, the Oxidation Time window, shown in the figure below, is displayed.

   ![Oxidation Time Window](image1)

   Figure 5.13
   Oxidation Time Window

   If you choose OT as your analysis type, the Oxidation Temperature window, shown in the figure below, is displayed.

   ![Oxidation Temperature Window](image2)

   Figure 5.14
   Oxidation Temperature Window

2. Enter the signal threshold to mark the desired point where the curve deviates the threshold value from the baseline.
3. *For OIT analyses:* Enter the oxidation gas start, which is the time when you started the use of oxygen in your experiment.

4. Click the OK button. Markers will be displayed on the graph.

5. Double click at the beginning of the region of oxidation onset to position the marker.

6. Double click at the end of the region of oxidation to position the second marker.

7. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates and displays the oxidation results.

---

**Purity**

The TA Instruments DSC Purity Analysis can be used to calculate the absolute purity of a sample based on data obtained from the DSC (Differential Scanning Calorimeter) according to ASTM procedure E0928.*

**NOTE:**

The DSC Purity Analysis is not recommended for analysis of SDT (DSC-TGA) data. The results will not be as expected.

The analysis method used in DSC Purity Analysis is based on the van't Hoff equation shown below:

\[
T_s = T_o - \frac{R T_o^2 X}{\Delta H_f} \left( \frac{1}{F} \right)
\]

Where:

- \(T_s\) = sample temperature
- \(T_o\) = melting point of pure sample (K)
- \(R\) = gas constant (8.314 J/mol\(^{-1}\)K\(^{-1}\))
- \(X\) = mole fraction impurity
- \(\Delta H_f\) = heat of fusion of pure sample (J/mol\(^{-1}\))
- \(F\) = faction of total sample melted at \(T_s\)

* For more information go to [http://www.astm.org](http://www.astm.org) or write to ASTM, 100 Barr Harbor Drive, West Conshohocken, PA 19428-2959, (610) 832-9500.
If you use this data analysis program to plot $T_g$ versus $1/F$, it should result in a straight line with a slope of $RT_g^2 \Delta H/\Delta F$ (melting point depression) and an intercept of $T_0$ (melting point of a pure sample). In actual practice, the plot of $T_g$ versus $1/F$ results in a curve. This curve is thought to be the result of “undetected melting.” A correction value is added to the value of $F$ so that a straight line results. The impurity level of your sample is calculated from the slope of the $T_g$ versus $1/F$ line. The heat of fusion is calculated using the total peak area.

You can select specific parameters to be used in the analysis and obtain a better fit to the equation used by the program. The results of all analyses are displayed on the screen. You can also print your results on the printer and create tabular reports on the screen, printer, or in a disk file.

Before performing Purity analysis, you will need to gather the data. For the guidelines used to obtain the best results from the Purity analysis, see the following section.

For additional information on purity analysis, see R.L. Blaine and C.K. Schoff, eds., *Determinations by Thermal Methods*, ASTM Special Technical Publication 838, Publication code 04-838000-40.

**Collecting DSC Purity Data**

You can analyze DSC data from many types of samples using DSC Purity analysis.

Be sure to calibrate your DSC using indium at the heating rate to be used for subsequent sample analysis. Correct calibration of your DSC for cell constant and onset slope is extremely important. These calibration constants will affect the accuracy of your DSC Purity results.

**Guidelines for Data Collection**

To obtain the best results from the DSC Purity analysis, use the following optimum experimental conditions for purity determinations:

- Sample size = 1.7 mg
- Heating rate = 0.5 °C/min
- Impurity level < 2 mol%
- Data sampling interval = 1 sec/point
- Encapsulate the sample as tightly as possible to minimize gradients and/or sample movement.
Slight variations from the previous values are acceptable; however, for the most accurate results, you need to maintain as many of these parameters, at the most optimum value possible, during data collection.

The Analyze/Purity menu (shown here) provides two items—one to analyze the data and one to set up options for analysis. The following sections describe these options.

Analyzing for Purity

Select Analyze/Purity/Analyze to perform the analysis on the current data file. The following guidelines should be considered when analyzing:

- Before analyzing the data, set up the analysis options by selecting Analyze/Purity/Options.

- When you select Analyze/Purity/Analyze, the markers are displayed on the graph to allow you to select the analysis limits.

- Select the desired analysis limits and select Accept Limits from the pop-up menu.

- Enter the molecular weight of the sample in g/mol when prompted.

- The program uses the van’t Hoff equation to calculate your sample’s purity, performing a series of operations using the data file. See the online help for more information.

- First, there is an initial scan of the peak to find the baseline, peak area, and peak height, which are needed to calculate area segments.

- A second scan divides the peak into the number of partial area segments specified on the Purity Options—Partial Area Page (25 is the default) to find the $T_s$ versus $1/F$ curve. The segments are equally spaced along the $1/F$ axis. The first segment starts when the peak height is the specified percent of the maximum height or the input value (10 percent is the default). The last segment ends at the specified maximum percent of the total peak area or the input value (50 percent is the default).
NOTE: If the curve does not contain enough points to allow the specified number of segments, the allocation continues until the maximum partial area percent of the total peak is reached.

- A correction is made at the end of each segment for the temperature difference between the sample and sample thermocouple (using the onset slope value entered in the analysis options).

- Then a nonlinear least squares technique is used to approximate the area correction for the $T_g$ versus $1/F$ curve. (This is done to linearize the usual curvature of the line, commonly attributed to undetected melting of the sample before peak start.)

- A least-squares fit to a straight line is used to calculate the slope and intercept of the $T_g$ versus the corrected $1/F$ curve.

- The corrected peak area is used to calculate the heat of fusion unless you have opted to used the uncorrected area, or have entered a known heat of fusion for the sample.

- Lastly, the van’t Hoff equation is used to calculate the impurity level and convert it to the purity.
Selecting Purity Analysis Options

Select the Analyze/Purity/Options function to set up the options available for DSC purity analysis.

Purity Analysis Options - Partial Area Page

Click on the Partial Area Page (shown here) to set up the default parameters for the program to use when you perform the DSC Purity analysis.

Figure 5.15
Purity Analysis Options Partial Area Page

Follow the steps below to set up these options:

1. Enter the First partial area height cutoff (fraction of peak maximum) as a decimal [the default is 0.1 (10 percent)]. The first partial area begins at the left edge of the peak range, and extends to the point where the signal is a specified fraction of the peak height below the baseline.

2. Enter the Maximum partial area (fraction of peak area) as a decimal [the default is 0.5 (50 percent of the total area)]. The last partial area ends when it exceeds or equals this fraction of the total peak area.

3. Enter the desired Number of partial areas (the default value is 25). The number of partial areas is computed by the program and used in the purity calculations. The reciprocals of these partial areas are spaced approximately equal.
4. Enter the upper and lower limits of the area correction factor as the Constraints on area correction factor. The “missing area” correction factor must fall within the specified range (0.0 < Factor < 0.2 is the default). You can force the correction to a specific value by setting the lower and upper limits of the range to the same value; however, it is more often used to force the correction to remain below a selected value (the upper limit value).

If the correction factor selected by the program is equal to the upper limit, the amount may be inadequate to obtain a good fit to the straight line, and DSC Purity obtained may be incorrect. Check the fit (using the RMS deviation value in the Results Report). If necessary, you can re analyzer the data with a larger maximum area correction factor. A small RMS deviation indicates a good fit to the straight line.

5. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.

NOTE: To use the factory default options, click the Default button.

NOTE: If you make a change to these parameters after analyzing the data, you will need to repeat the analysis again.

Purity Analysis Options - Purity Calculation Page

Click on the Purity Calculation Page (shown below) to set up the default parameters for the program to use when you perform the DSC Purity analysis.

Follow the steps below to set up these options:

![Purity Analysis Options](image)
1. Enter the desired **Penalty factor** (larger value forces smaller area correction). The penalty factor is used to bias the results towards a smaller area correction. A penalty factor of one means that the fit is determined entirely by the squared deviation between the data and the modified van’t Hoff equation. A penalty factor greater than one results in a deviation multiplied by a function that tends to make smaller area corrections fit better. The default value is 1.0.

This function is:

\[
P = 400 \frac{(Pf - 1.0)(g - 0.05)^2 + 1.0}{\text{if } g > 0.05}
\]

\[
P = 1.0 \quad \text{if } g < 0.05
\]

Where:

\[
P = \text{penalty}
\]

\[
Pf = \text{penalty factor}
\]

\[
g = \text{area correction factor (gamma) as a fraction (0.0 < gamma < 1.0). Gamma is reported as “correction %”/100.0 on the report.}
\]

This equation is a quadratic function centered on a 5 percent correction, with a penalty equal to the penalty factor at a 10 percent correction.

2. Check the **Adjust delta H of fusion according to area correction factor** box, if this option is desired.

3. Check the **Use the known pure heat of fusion** box, if desired. If this option is checked, enter the value in kJ/mol.

4. Check the **Use the known pure melting temperature** box, if desired. If this option is checked, enter the value in °C.

5. Check the box for **Use known molecular weight** to perform the purity calculations on your data using the known molecular weight of the sample material. If you check this box, you will need to enter the value in g/mol. If you do not check this box, the **Molecular Weight window** is displayed when you perform the Purity analysis.

6. Click Save to save these options to the initialization file or click OK to use these parameters for this session only.
Analyzing the Data

Purity Analysis Options – Results Plot Page

Click on the Results Plot Page (shown below) to set up the default parameters for the program to use when you perform the DSC Purity analysis and display the results plots. Five checkbox options are displayed. These deal with the plot options that can be displayed along with the heat flow curve.

Follow the steps below to set up the “Temperature vs. partial area plot options:”

1. Check the Indicate partial area slices on Heat Flow curve box to have partial areas shown on the heat flow curve.

2. Check the Plot temperature vs. corrected partial area points box to display a graph of the temperature versus the corrected partial area points.

3. Check the Plot fitted line to corrected partial area points box, if desired. If you check the third box, a line will be drawn through the temperature versus corrected partial area points, only if displayed.

4. Check the Plot temperature vs. uncorrected partial area points box to display a graph of the temperature versus the uncorrected partial area points.

5. Check the Plot fitted modified van’t Hoff equation to uncorrected partial area points box, if desired. If you check the fifth box, a plot will be fitted to the temperature versus uncorrected partial area points, only if displayed.
6. Select the **Axis** from the drop-down list that will be used to plot the analysis results.

7. Select the **Color** for the results plot from the drop-down list.

8. Click the **Edit Symbols** button if you want to change the symbols used for the analysis. The first three symbols in the symbol list are used in the purity result plot. The first symbol corresponds to the partial area points on the heat flow curve, the second symbol corresponds to the corrected partial area versus temperature points, and the third symbol corresponds to the uncorrected partial area versus temperature points.

9. Click **Save** to save these options to the initialization file or click **OK** to use these parameters for this session only.

**Purity Analysis Options – Results Label Page**

Click on the **Results Label Page** (shown below) to set up the results labels that will be displayed when you perform the DSC Purity analysis and display the results.

![Purity Analysis Options](image)

**Figure 5.18**

**Purity Analysis Options Results Label Page**

Check the desired results to be displayed on the results plot as listed in the table on the next page.
### Table 5.2
Purity Analysis Results Labels

<table>
<thead>
<tr>
<th>Results Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purity</td>
<td>Check the <strong>Purity</strong> box to display the purity in the results annotation, the amount of a specified compound or element in an impure sample. Example: Purity 99.64 mol %</td>
</tr>
<tr>
<td>Melting Point</td>
<td>Check this box to display the melting point in the results annotation. Melting point is defined as the point at which the crystals of a pure substance are in equilibrium with the liquid phase at atmospheric pressure. This point is commonly referred to as melting point when a substance is approaching it from its solid state and is referred to as freezing point when a substance is approaching it from its liquid state. Example: Melting Point 134.90°C (determined)</td>
</tr>
<tr>
<td>Depression</td>
<td>Check this box to display the van’t Hoff melting point depression value in the purity analysis results. This is the difference between the melting temperature of this sample and that of a 100 percent pure sample. Example: Depression 0.29°C</td>
</tr>
</tbody>
</table>

*(table continued)*
Table 5.2 (cont'd)

**Purity Analysis Results Labels**

<table>
<thead>
<tr>
<th>Results Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delta H</td>
<td>Check this box to display the Delta H value in kJ/mol. This is the change in the heat of fusion. Depending on whether this value is determined by the data, determined and adjusted according to the area correction factor, or a known value is used, this value is labeled with (uncorrected), (corrected), or (entered). Use the Purity Analysis Options - Purity Calculation Page to enter a known value. Example: Delta H: 26.37 kJ/mol (corrected)</td>
</tr>
<tr>
<td>Correction</td>
<td>Check this box to display the Correction value in percent. This is the area expressed as a percent of the total melting enthalpy that is added to the fractional areas in order to produce the straight line form of the van’t Hoff equation.</td>
</tr>
<tr>
<td>Molecular Weight</td>
<td>Check this box to display the Molecular Weight in g/mol. This is the value that you have entered during the purity analysis, which is defined as the mass of one molecule of a nonionic substance in atomic mass units.</td>
</tr>
<tr>
<td>Cell Constant</td>
<td>Check this box to display the Cell Constant value. Cell Constant is a calibration factor used to adjust the calorimetric response of a DSC cell. The cell constant is the ratio of the known value to the measured experimental variable. Typically, the heat of fusion of indium (DSC) is used. The calibration is based on a run made in the calibration mode using the experimental conditions to be used in subsequent measurements.</td>
</tr>
</tbody>
</table>
| Onset Slope   | Check this box to display the Onset Slope in the purity analysis results. This parameter is the slope of the onset of the melting curve for a standard.  

*(table continued)*
### Table 5.2 (cont'd)
Purity Analysis Results Labels

<table>
<thead>
<tr>
<th>Results Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Onset Slope</td>
<td>The onset slope, or thermal resistance, is a measure of the temperature drop that occurs in a melting sample in relation to the thermocouple. Theoretically, a standard sample should melt at a constant temperature. As it melts and draws more heat, a temperature difference develops between the sample and the sample thermocouple. The thermal resistance between these two points is calculated as the onset slope of the heat flow versus temperature curve on the front side of the melting peak. This is always a negative term. Default is 0.00 mW/°C.</td>
</tr>
<tr>
<td>RMS Deviation</td>
<td>Check this box to display the <strong>RMS Deviation</strong> in the purity analysis results. Root Mean Square Deviation is the estimate of the deviation in the melting temperature of the 100 percent pure sample.</td>
</tr>
<tr>
<td>Peak with Limits</td>
<td>Check this box to label the peak with the chosen analysis limits for integration.</td>
</tr>
</tbody>
</table>

### Slope

The **Slope** option is used to calculate the average slope of a selected region of the curve.

Follow these steps for perform this analysis:

1. Select **Slope** from the **Analyze** menu. Markers will be displayed on the graph.

2. Double click at the beginning of the region you want to measure to position the first marker.

3. Double click at the point where you want to stop measuring the slope to position the second marker.
4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The program calculates and displays the slope.

Running Integral

The **Running Integral** option is used when you want to determine the area under a peak or the ratio of different materials within a sample. For example, in TGA, this function is valuable for determining the relative amounts of evolved gases in a material. In DSC, it can be used to calculate the percent composition of polymer blends.

**NOTE:**

The **Analyze/Running Integral** option is the same as the **Analyze/Integrate Peak/Running Integral** option found on page 5-36, with one exception—you do not need to perform a peak integration before selecting this option.

**NOTE:**

You must use the **Analyze/Integrate Peak/Running Integral** analysis to obtain the correct peak area when integrating over a sigmoidal baseline. The more general **Analyze/Running Integral** analysis always uses a linear baseline for integration, which will give a different running area than that reported by the Peak Integration analysis with a sigmoidal baseline.

**NOTE:**

The **Running Integral** analysis option is not available if the Y4 axis is being used to graph a data signal.

Follow these steps to perform this analysis:

1. Select **Running Integral** from the **Analyze** menu. Markers will be displayed on the graph.

2. Double click at the beginning of the region of the curve that you want to analyze to position the marker.

3. Double click at the end of the region you want to analyze to position the second marker.

4. Right click to display the Analyze pop-up menu, then select Accept Limits (or press Enter). The **Integral Type** window is displayed.
5. Select the running area type from the types displayed:

- **Integral**: The program plots the raw integrated data.

- **Area Percent**: The program takes the end result of the raw integration and shows the percent contribution of each peak in the selected region of the curve (assuming the selected region to be 100%). If you want to determine the percent composition of various components in a material, select the area percent option.

Then, when the program finishes plotting the integral curve, use the **Curve Value** analysis to mark each step of the curve with its percent contribution.

- **Normalized**: For *DSC files only*. The program plots the integral curve in normalized units (Joules/g).

- **Inverted**: The program multiplies the normal integral by minus one, and computes the area percent integral from 100 percent down to zero percent.

6. Choose from the following running area baseline choices:

- **Linear/Sigmoidal Baseline**: When you select this option the baseline will be anchored to the curve at the integral limit points. The area will be integrated with respect to the linear baseline between the analysis limits.

- **Zero baseline (absolute integral)**: When you select this option, the area will be integrated with respect to a baseline set to zero on the y axis, which calculates the absolute integral.

**NOTE:** In both cases above the baseline is linear, unless the peak running integral is selected with Sigmoidal baseline peak integration.

7. Click on OK. The program calculates the integral of the peak based on the peak integration results and displays the result on the Y4 axis.

**NOTE:** You must use the Analyze/Integrate Peak/Running Integral analysis to obtain the correct peak area when integrating over a sigmoidal baseline. The more general Analyze/Running Integral analysis always uses a linear baseline for integration, which will give a different running area than that reported by the Peak Integration analysis with a sigmoidal baseline.
Curve Value at X/Y

The Curve Value at X/Y analysis options are used to determine the X-axis value or Y-axis value at the selected point on the curve. Marking the curve with this feature allows you to label a curve at any point.

Follow these steps to perform this analysis:

1. Select Curve Value at X or Curve Value at Y from the Analyze menu. A marker is displayed on the graph.

2. Double click at the point on the curve you want to label to position the marker.

3. Right click to display the Analyze pop-up menu, then select Accept Limits. The Label Point window is displayed.

![Label Point Window](image)

4. Check the box for the item(s) that you wish to use for the point labeling. Refer to the table on the next page for a description of each item.
### Table 5.3
**Label Point With...**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Labels the selected data point on the graph with the time.</td>
</tr>
<tr>
<td>Temperature</td>
<td>Labels the selected data point on the graph with the temperature.</td>
</tr>
<tr>
<td>Signal</td>
<td>Labels the selected data point on the graph with the X signal. This signal is selected on the <strong>Signal Selection</strong> window. You do not have to select the Signal radio button on the <strong>Signal Selection</strong> window. In this manner, any point can be labeled with any of the X signals saved when the data was collected.</td>
</tr>
<tr>
<td>Y-Axis Value</td>
<td>Labels the selected data point on the graph with the Y-axis value.</td>
</tr>
<tr>
<td>Frequency*</td>
<td>Labels the selected data point on the graph with the frequency.</td>
</tr>
<tr>
<td>Amplitude*</td>
<td>Labels the selected data point on the graph with the amplitude.</td>
</tr>
<tr>
<td>Location*</td>
<td>Labels the selected data point on the graph with the location.</td>
</tr>
<tr>
<td>Draw arrow to point</td>
<td>Check this box to have an arrow displayed that will point from the label(s) to the selected data point on the graph.</td>
</tr>
<tr>
<td>Draw cross at point</td>
<td>Check this box to have an cross displayed at the selected data point on the graph.</td>
</tr>
</tbody>
</table>

5. Click the OK button. The point you selected is labeled with the selected items on the curve.

**NOTE:**

* This option is available for multiplexed files only.
Label at X,Y

The Label at X,Y analysis option is used to determine the x and y coordinates for any point within the graph limits, even if it is not on the curve. To obtain a point on a curve, use the Curve Value at X/Y analysis.

Follow these steps to perform this analysis:

1. Select Label at X,Y from the Analyze menu. A marker is displayed on the graph.

2. Double click at the point you want to label to position the marker.

3. Right click to display the Analyze pop-up menu, then select Accept Limits. The Label Point window is displayed.

4. Check the box for the item(s) that you wish to use for the point labeling. See the table on the previous page for a description of each item.

5. Click the OK button. The point you selected is labeled with the selected items.
Setting the Analysis Options

The Options menu item found in the Analyze menu is used to set up parameters that will be applied when analyzing your data files.

When you select Analyze/Options from the main menu, the following window is displayed.

Click on the desired tab at the top of the window to select the page you wish to use. Details on each page can be found in this section.

Step Transition Page

The Step Transition Page (shown in the figure above) is used to set up the parameters for the program to use when you perform a step or glass transition analysis.

Follow the steps below to set up these options:

1. Select Analysis/Options from the main menu, then click on the Step Transition tab, if needed.

2. Check the Manual tangent selection option, if you wish to manually select the start and stop limits for the tangent lines. If you choose the manual mode, the program uses the limits you select to fit the tangent lines to the curve. The program will use the limits you select to fit the tangent lines to the curve.
**NOTE:**

If you do not check the **Manual tangent selection** box, the analysis will be done in automatic mode. This means that you will only need to enter the start and stop data limits to be used in the analysis and the program will take care of the rest.

3. Click on the arrow to display the drop-down list and select the step transition **Midpoint**. See “Choosing the Midpoint” for further information.

4. Click on the arrows to display each drop-down list and select the two **Step change between** options to be used in step transition calculations. See “Choosing the Step Change Options” for further information.

5. Check the desired options to be used when labeling the step transition analysis results:

   - **Limits**: Check this box to label the graph with the x-axis value at the limit points.
   - **Onset**: Check this box to label the graph with the onset of the step/glass transition.
   - **End**: Check this box to label the graph with the end of the step/glass transition.
   - **Change**: Check this box to label the graph with the step/glass transition signal change.
   - **Delta Cp**: Check this box to label the graph with the heat capacity.
   - **Signed Change**: Check this box to label the graph with the appropriately signed change value. If the change is negative, a minus sign will be shown with the numerical value. If the change is positive, no sign will be shown with the numerical value, positive is implied.
   - **Signed Delta Cp**: Check this box to label the graph with the appropriately signed change in heat capacity (Cp) value. If the heat capacity is negative, a minus sign will be shown with the numerical value. If the heat capacity is positive, no sign will be shown with the numerical value, positive is implied.

**NOTE:**

The **Delta Cp** step label is available for DSC heat flow curves only.

6. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:**

You can choose the default options by clicking on the Default button.
Choosing the Midpoint

Select one of the following methods to be used in determining the midpoint in step transition analyses:

- **None** results in no step transition midpoint calculation.

- **Inflection** results in the use of the inflection point (the point on the curve with the steepest slope) as the midpoint of the step transition.

- **Half height** defines the midpoint as the Y-axis value halfway between the onset and end of the step/glass transition region.

- **Half width** defines the midpoint as the X-axis value halfway between the onset and end of the step transition region.

(continued on next page)
• **Half extrapolated tangents** results in a line drawn midway between the onset and end tangents, and the intersection of this line with the curve is considered the midpoint.

![Diagram of midpoint with half extrapolated tangents]

• **Fictive temperature** defines the intersection point of two extrapolated baselines extending from the start point and end point of the absolute running integral of the glass or step transition being analyzed with respect to the current x-axis. This option is primarily used to remove the effects of enthalpic relaxation phenomena in your experiment.

Choosing the Step Change Options

Use **Step Change** list to select how you want the step change (height) to be determined in step transition calculations. The step change is calculated as the change in the Y-axis between the two choices made on the Analysis Options - Step Transition Page (see Figure 5.16 on page 5-47). Choose from the following:

• **Start**—the step change will be computed using the specified start limit on the Y-axis.

• **Onset**—the step change will be computed using the step transition onset point on the Y-axis.

• **Midpoint**—the step change will be computed using the onset tangent or end tangent Y-axis value evaluated at the midpoint X-axis value.

• **End**—the step change will be computed using the step transition end point on the Y-axis.

• **Stop**—the step change will be computed using the specified stop limit on the Y-axis.
Analyzing the Data

Onset/Peak Integration Page

The **Onset/Peak Integration Page** (shown in the figure below) is used to set up the parameters for the program to use when you perform an onset or peak integration analysis.

![Analysis Options](image)

Follow the steps below to set up these options:

1. Select **Analysis/Options** from the main menu, then click on the **Onset/Peak Integration** tab.

2. **For DSC-TGA Mode SDT Files Only**: Select a Weight option to be used to calculate peak integration results from the drop-down list. If you select “Prompt” from the list, you will need to select a weight to be used from the **Integration Weight Selection** window. See also: “List of Integration Weight Selections” on the next page.

3. Check the **Manual Onset tangent selection** option, if you wish to manually select the start and stop limits for the tangent lines. If you choose the manual mode, the program uses the limits you select to fit the tangent lines to the curve. The program will use the limits you select to fit the tangent lines to the curve.

**NOTE:**

If you do not check this box, the analysis will be done in automatic mode. This means that you will only need to enter the start and stop data limits to be used in the analysis and the program will take care of the rest.
4. Check the desired boxes to label these onset values: X-axis, Y-axis, Time, Temperature, and X-signal. These options apply to Onset Point and Peak Integration analyses.

5. Click on the arrow to display the drop-down list and select the signal used to Calculate peak onset versus. Use this list to choose whether you want the program to calculate and display the peak onset during peak integrations and to select the variable desired.

6. Check the desired options to be used when labeling the peak:

   • Limits: Check this box to label the peak with the chosen analysis limits.
   • Area: Check this box to label the peak with the peak area.
   • Height: Check this box to label the peak with the height.
   • Width at Half Height: Check this box to label the peak with its width at the half height point.
   • Normalized Area: (Available for DSC and DTA data only.) Check this box to label the peak with the normalized area, otherwise, unnormalized area is reported.
   • Signed Heat Flow Area: Check this box to label the peak with the appropriate exotherm/endotherm designation. If the peak area is exothermic, the value will be labeled as positive (implied-no sign displayed). If the peak area is endothermic, the value will be labeled as negative (minus sign displayed).

7. Click on the arrow to display the drop-down list and select the desired peak maximum label. This list lets you choose whether you want the program to calculate and display the peak maximum and to select the variable desired.

8. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

**NOTE:** You can choose the default options by clicking on the Default button.
List of Integration Weight Options

The following options are available on the Integration Weight Selection window, shown here. They will be used when you perform a peak integration analysis for DSC-TGA mode SDT files.

- The Original button uses the weight displayed.
- The Start button uses the first limit selected.
- The Midpoint button used the weight midway between the start and stop limits.
- The Stop button uses the last limit selected.

- The Change button uses the difference between the start and stop limits.
- The Graphic One Point button permits graphic selection of the weight from the weight curve using one point.
- The Graphic Two Points button permits graphic selection of the weight change (difference between the two limits chosen) for the weight curve.
- The Manual button allows you to enter the desired weight value.

Special Area Page

The Special Area Page (shown below) is used to select a special area calculation, if desired. Special area calculations are additional analyses performed when you integrate a peak.

Figure 5.22
Analysis Options - Special Area Page
1. Select **Analysis/Options** from the main menu, then click on the **Special Area** tab.

2. Click on the desired item in the drop-down list from the following list.

   - **No area**: No special calculations using area are performed.
   - **General equation**: When you perform a peak equation integration, a value is automatically calculated using the following equation, which is displayed when you click on General Equation:
     \[
     \text{Value} = (\text{area} \times 1.0 / 1.0) + 0.0
     \]
     This is used to compare results with a standard material. You can change any of the numbers in the equation to tailor it to your needs. You can also type in a label of up to 20 characters with the reported value.
   - **Percent crystallinity**: *This is available for DSC data files only*. The percent crystallinity (\%Cr) is calculated using the following equation:
     \[
     \%Cr = \frac{\text{area}}{\text{standard heat}} \times 100
     \]
     When you click on Percent Crystallinity the standard heat entry field is displayed, allowing you to change the value, if desired.
   - **Percent cure**: *This is available for DSC data files only*. The percent cure (\%C) is calculated using the following equation:
     \[
     \%C = (1 - \frac{\text{area}}{\text{standard heat}}) \times 100
     \]
     When you click on Percent Cure the “Standard Heat” entry field is displayed, allowing you to change the value, if desired.
   - **Heat per mole**: *This is available for DSC data files only*. The heat per mole (H/M) is calculated using the following equation:
     \[
     \frac{\text{H}}{\text{M}} = \text{area} \times \text{molecular weight}
     \]
     When you click on Heat per Mole the molecular weight entry field is displayed, allowing you to change the value, if desired.

3. Click the Save button, if you want to use these as your new default settings or click on the OK button to use these settings for this session only.
NOTE: In order to use the percent crystallinity or percent cure options, you must have a non-zero sample size.

Resolution Page

The **Analysis Options - Resolution Page** (shown below) is used to set the numeric resolution of all result values that are displayed on the plot and in the reports generated by the Universal Analysis program.

![Analysis Options - Resolution Page](image)

**Figure 5.23**

**Analysis Options - Resolution Page**

1. Select **Analysis/Options** from the main menu, then click on the **Resolution** tab.

2. Click on the drop-down list to set the resolution for all of the time, temperature, or other values to one of the following criteria:
   - 1 to 7 significant figures
   - 0 to 10 digits after the decimal point
   - rounded to an integer
   - automatic resolution (this is the default)

NOTE: The "Other" option refers to any and all result values that are not time or temperature.

3. Click the Save button, if you want to use these as your new default settings or click the OK button to use these settings for this session only.

The resolution adjustment can be made to any individual result label on the plot by right clicking on the label and selecting the **Resolution** menu item from the pop-up menu.
The **Analysis Options - Other Page** (shown below) is used to select a special additional analysis parameters. The two parameters shown are applicable only to TMA data files.

**Figure 5.24  
Analysis Options - Other Page**

1. Select **Analysis/Options** from the main menu, then click on the **Other** tab.

2. Enter the desired smoothing width. The number entered here will result in the logical smoothing of the data to the specified width. Alpha is calculated as the slope of a least squares linear fit to the dimension and temperature data region around the given temperature. The size of this linear fit region is the "alpha at a point smoothing width" analysis parameter. The region is truncated if it extends outside the analysis limits or data collection region. If the given temperature is outside the analysis limits or is in a region where data was not collected, then the calculation of alpha is suppressed.

3. Click on the first checkbox to calculate the percent value by dividing the expansion over the temperature range by the corrected size of the sample. The corrected length is calculated at the first temperature entered. Leaving this box blank (which is the default) indicates that the percent value will be found by dividing the expansion over the temperature range by the original size of the sample.
4. For DSC-TGA Mode SDT Files Only: Enter the desired weight that will be used as the minimum value for the weight-corrected SDT heat flow data. The default value is five percent.

5. Click on the next checkbox to adjust the TGA weight derivative for modify size analyses.

6. Click on the checkbox to Label results with curve color, if you want to use the same color for the curve and results label.

7. Check the Draw sigmoidal baseline iterations box to have intermediate sigmoidal baseline iterations shown on the graph during peak integration analyses. Leave this unchecked to see only the final peak integration results.

8. Check any of the following checkboxes to label a TGA step change, weight change, or residue analysis with the label listed: Limits, Weight, Percent, Transition Label, or Signed Change.

9. Click the Save button, if you want to use these as your new default settings or click on the OK button to use these settings for this session only.

**Adjusting Analysis Results**

After you have completed performing operations such as those listed below on your data file, you can adjust the results of the analysis.

- Integrate Peak
- Glass Transition
- Step Transition
- Onset Point
- Slope
- Oxidation Time/Temperature
- Alpha Fit X1 to X2
- Annotate
- Add Scale Bar

1. Select Adjust Last Result from the Edit menu immediately after one of the analyses listed above (or right click on a label associated with one of these results and select Adjust Result from the pop-up menu). Markers for each of the analysis tangent lines will be displayed. The Adjust Last Result option is used to fine tune the position of the analysis tangent lines.

2. Select the desired marker and reposition it to the new location, as desired. The revised analysis results will be shown when you are finished. Right click to display the Analysis pop-up menu, then select Accept Result (or press Enter) when you have completed the adjustment.

To Cancel this operation, select Cancel from the Analysis pop-up menu or press the Esc key.
Removing Analysis Results

After your analysis is complete, you can change your mind and remove the results from the graph. The option that you select will depend on how many analyses you have already performed, and which one you want to remove.

To remove one or more analysis results from your graph, select Edit/Delete Results from the main menu. Four different options (shown in the Delete Results menu here) will be available depending on the number of analyses you have performed.

The menu options are described below:

- **Last**: Use the Last option to delete the last data analysis results that you obtained from the plot.

- **Select**: Use the Select option to select an analysis result for deletion. A dialog box is displayed for each analysis performed, allowing you to decide whether or not you want to delete that particular analysis.

- **All**: Use the All option to delete all of the current analysis results from the plot.

- **Axis-1,2,3**: Use this option to remove all of the analysis results from the selected (active) Y axis.

**NOTE:** To remove an individual result, you can also position the pointer over the result you want to delete, then right click to display the pop-up menu and choose **Delete Result**.

For information on how to print out the analysis results, turn to Chapter 6.
Analyzing the Data
Chapter 6
Getting Reports

Introduction ................................................................. 6-3

Obtaining the Different Reports ........................................ 6-3

Using the View Menu .................................................... 6-4

Getting Results Information ............................................. 6-4
Results Report ............................................................ 6-4
Results in Spreadsheet Form .......................................... 6-5
Setting Up Results Options ............................................ 6-6

Viewing Data Table Information ....................................... 6-7
Data Table Report ........................................................ 6-7
Data Table in Spreadsheet Form .................................... 6-8

Viewing the Parameter Block .......................................... 6-9

Viewing a Method Log ................................................... 6-10

Looking at the Current Macro ......................................... 6-11

Viewing an Autoqueue Report ......................................... 6-12

Viewing an Autoqueue Log ............................................ 6-13

Using the Report Editor ................................................ 6-14
File Menu (Report Editor) ............................................. 6-14
Edit Menu (Report Editor) .......................................... 6-16
Finding Text ............................................................... 6-17
Replacing Text ............................................................. 6-17
Text Space Separators With Tabs .................................. 6-18
Space Separators With Commas .................................... 6-19
Insert Menu (Report Editor) .......................................... 6-19
Report Heading (Report Editor) ..................................... 6-20
Help Menu (Report Editor) .......................................... 6-20

Opening the Spreadsheet Program .................................. 6-21

Creating a Custom Report Template ............................... 6-21
Starting the Custom ...................................................... 6-22
Report Editor Program ................................................ 6-22
Basic Instructions on Creating a Template ....................... 6-23
Setting Up Options ..................................................... 6-25
Getting Reports

Using the Custom Report Editor File Menu ......................... 6-27
Setting Up the Custom Report Options ......................... 6-29

Using the Custom Report Editor Edit Menu ..................... 6-33
Editing Box Properties for the Report Objects ............... 6-34
Editing Fonts for the Report Objects ..................... 6-36
Editing Parameters for the Report Objects ..................... 6-36
Editing Parameter-Type Report Objects ..................... 6-37
Editing Plot-Type Report Objects ..................... 6-38
Editing Text-Type Objects ..................... 6-39
Editing the File Number of a Report Object .................. 6-40
Editing the Overlay Number of a Report Object .............. 6-40
Editing a Spreadsheet Report Object ..................... 6-41
Layering the Report Objects ..................... 6-41
Snapping Objects to the Grid ..................... 6-42
Locking an Object's Position ..................... 6-42

Creating a Custom Report with Multiple Files .................. 6-42

Using the Custom Report Editor Insert Menu .................. 6-43
Inserting a Results Report Object ..................... 6-44
Inserting a Results Spreadsheet Object ..................... 6-44
Inserting a Data Table Report Object ..................... 6-44
Inserting a Data Table Spreadsheet Object ..................... 6-44
Inserting a Parameter Report Object ..................... 6-45
Inserting a Parameter Spreadsheet Object ..................... 6-45
Inserting a Method Log Object ..................... 6-45
Inserting a Normal Plot Object ..................... 6-46
Inserting an Overlay Plot Object ..................... 6-46
Inserting an Image File Object ..................... 6-46
Inserting a Text Object ..................... 6-47

Using the Custom Report Editor Tool Bar ..................... 6-48
Introduction

The Universal Analysis program contains options that enable you to obtain various types of reports individually, edit them, or combine them into one report or make up a customized report template for use again and again. You can also access a spreadsheet program directly from Universal Analysis to create data spreadsheets. This chapter contains information on the following subjects:

- Obtaining the different reports
- Using the View menu items
- Using the Report Editor program
- Opening the spreadsheet program, Microsoft Excel®
- Creating a Custom Report Editor template.

Obtaining the Different Reports

All data files will present information for the data table, parameter block, and method log reports because that type of data was obtained when the experiment was originally run. However, in order to obtain a results report, you must first perform at least one analysis on your data file. For a current macro report, you must have loaded a macro file and opened a macro. For an autoqueue report and autoqueue log, you must have an autoqueue containing records that has not yet been processed and after it is processed, you can view the resulting autoqueue log.

For information on how to obtain the different types of reports and an example of each one, refer to the appropriate page in this chapter.

Microsoft Excel® is a registered trademark of the Microsoft Corporation.
Getting Reports

Using the View Menu

The View menu (shown here) is used to select from an assortment of information on the analysis to view, and in some cases, edit or print.

If you want to combine any or all of the reports shown in the View menu into one, use the Report Editor’s Insert menu (see page 6-14 for information).

NOTE:

Only one Report Editor window and one Custom Report Editor window at a time is available within the Universal Analysis program. If either of these windows is minimized or opened, and the View options are accessed again, the current information displayed in the window is replaced with the newly selected information.

The following pages describe each type of report and function available using the View menu.

Gettings Results Information

After you have completed analyzing your data, you can use the View/Results menu (shown here) to view the results in either report or spreadsheet form and to choose results that will be displayed.

Results Report

The View/Results/Report function is used to view the results of your analysis in a written report form. When you select this item from the View menu, the Report Editor program is automatically opened, displaying the analysis results and allowing you to edit and print the report using the Report Editor functions. See the figure on the next page for an example of the results report. See the section on “Using the Report Editor” in this chapter for more information on the functions of the program.
Results in Spreadsheet Form

The View/Results/Spreadsheet function is used to open the data analysis results in a spreadsheet application such as Microsoft Excel® (see the figure below). If you need help using the program, see the documentation provided with the program.
Getting Reports

Setting Up Results Options

You can individually select the types of results and options you want to display in your results report, whether it is displayed in the regular Universal Analysis Report Editor or in a spreadsheet by setting up the results options as follows:

1. Analyze your data files as desired.

2. Select View/Results/Options from the menu. The Results Options window (shown here) is displayed.

3. Check or uncheck the desired result values from the list that you want to display in your results report or spreadsheet.

4. Check or uncheck the desired result options that you want to display in your results report or spreadsheet. See the figure below to find out what the "Display options" part of the report are.

5. Click Save to save the settings to the initialization file or OK to save the settings for this session only.

You can click the All button to turn on all options and values or click the None button to turn off all options and values.

Figure 6.3 Parts of the Results Report

6–6 THERMAL ADVANTAGE UNIVERSAL ANALYSIS OPERATOR'S MANUAL
Viewing Data Table Information

After you open a data file you can get the data table information in either a report form or opened in a Microsoft Excel® spreadsheet by using the Data Table options found in the View menu (shown here).

Data Table Report

The View/Data Table/Report function is used to display a report showing the sample information and raw data points from the data file. For multiplexed data, such as frequency or amplitude, a separate table is generated for each multiplexed value.

Follow these steps to perform this function:

1. Select View/Data Table/Report from the main menu. The Data Table Limits window (shown here) is displayed.

2. Enter the point at which the program will start using the data to create the data table report.

3. Enter the point at which the program will stop using the data to create the data table report.

4. Enter the Increment to set the spacing between the reported values. For example, an increment of 0.1 causes the program to report a data point from every 0.1 unit of time or temperature. An increment of 0.0000 selects all of the data points in a file.

5. Check the All Data Points box to use all of the data points available in the file.
6. Check the Time and Temperature box to output the time and temperature data to the data table report or spreadsheet. Leave the box blank to output only the currently displayed x- and y-axis signals.

7. Click the Resolution button, if you want to set the numerical values to a particular resolution. The Label Resolution window is displayed to allow you to enter a value.

8. Click the OK button to display the data table report in the Report Editor window.

![Figure 6.4 Example of a Data Table Report](image)

**Data Table in Spreadsheet Form**

Use the View/Data Table/Spreadsheet function to open the data file's data table in a spreadsheet application such as Microsoft Excel®. If you need help using the program, see the documentation provided with the program.

![Figure 6.5 Data Table Spreadsheet](image)
Viewing the Parameter Block

The View/Parameter Block function is used to view a listing of the experimental parameters that were used when obtaining the data stored in the data file. When you select this item from the View menu, the Report Editor program is automatically opened, displaying the parameters (see the figure below) and allowing you to edit and print the report using the Report Editor functions.

![Report Editor - TGA-Crex 001.1](image)

**Figure 6.6**
**Example of a Parameter Block Report**
Viewing a Method Log

The **View/Method Log** function is used to view a listing of the method segments that were used to obtain the data file. Each experimental method is made up of a group of segments, which are preprogrammed instructions that are sent to the analytical instrument.

When you select this item from the **View** menu, the Report Editor program is automatically opened, displaying the segments in the method (see the figure below) and allowing you to edit and print the report using the Report Editor functions.

![Example of a Method Log Report](image)

**Figure 6.7**
**Example of a Method Log Report**
Looking at the Current Macro

The View/Current Macro function is used to view a listing of the steps contained in the currently open macro.

When you select this item from the View menu, the macro is automatically opened, displaying the steps in the macro. You can edit the text using this window for display purposes only. The macro can only be modified using the Macro Editor. See Chapter 8 for information on the Macro Editor.

![Image of Report Editor]

Figure 6.8
Example of a Macro Report
Viewing an Autoqueue Report

The View/Autoqueue Report function is used to view a listing of the steps contained in the Autoqueue file. (The Autoqueue file is created from the Instrument Control functions. See the documentation accompanying the Instrument Control portion of Thermal Advantage.)

When you select this item from the View menu, the Autoqueue Report file is automatically opened, displaying the data files and macros used in the autoanalyses. Any editing that you do here will not be saved to the autoqueue. Editing must be performed using the Autoqueue window. See Chapter 8 for more information on the Autoqueue.

![Example of an Autoqueue Report]

Figure 6.9
Example of an Autoqueue Report
Viewing an Autoqueue Log

The View/Autoqueue Log function is used to view a listing of the records contained in the Autoqueue Log file. (The Autoqueue Log file is created by the Universal Analysis Autoanalysis program when a record is processed.)

When you select this item from the View menu, the Autoqueue Log file is automatically opened, displaying the autoanalysis records (data files and macros used in the autoanalyses) along with an indicator that the record was processed successfully (OK) or unsuccessfully (!!). Any editing that you do here will not be saved to the autoqueue log.

Records may be copied, then pasted back into the Autoqueue window to processed again.

NOTE:

The entire record must be selected (highlighted) to be copied and successfully added to the Autoqueue window.

Periodically you should clear this log to avoid having too many entries listed. To clear the log, select Edit/Select All, then Edit/Delete from the menu. See Chapter 8 for more information on the Autoqueue.

Figure 6.10
Example of an Autoqueue Log File
Using the Report Editor

The Report Editor program is an independent program contained within Universal Analysis that is used to display, edit, and print reports. It can also be used as a text editor to write and print your own text report files.

**NOTE:**

Only one Report Editor window at a time is available within the Universal Analysis program. If this window is minimized or opened, and the View options are accessed again, the current information displayed in the window is replaced with the newly selected information.

You can select the font type, size, and effects (bold, underline, and italics) from the items found below the menu bar.

The Report Editor menu bar (shown here) contains four menus. Turn to the follow pages to obtain more information on each one.

**File Menu (Report Editor)**

The Report Editor File menu (shown here) is used to open a text file and perform various functions such as closing any open files, saving and printing files, etc.

Refer to the table on the next page for a brief description of each option found in the menu.
### Table 6.1
Report Editor
File Menu Items

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Use the New menu item to start a new text file.</td>
</tr>
<tr>
<td>Open</td>
<td>Use the Open option to open an existing text file. Choosing this function accesses the <strong>Open File</strong> window, allowing you to browse and locate a text file.</td>
</tr>
<tr>
<td>Close</td>
<td>Use the Close option to close the current file.</td>
</tr>
<tr>
<td>Save</td>
<td>Use the Save option to save the current text file. The default text file format is Rich Text Format (.rtf). Use Rich Text Format to save the font, text, size, etc. Use ordinary text format (.txt) to save only the text characters and not the format information. Always use ordinary text format (.txt) to save ASCII or spreadsheet data files.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>The file extension (.rtf or .txt) determines the save format. Any extension other than .rtf will save as plain text (.txt).</td>
</tr>
<tr>
<td>Save As</td>
<td>Use the Save As option to save the current text file to a different directory or in a different file format. This function accesses the <strong>Save As</strong> window.</td>
</tr>
<tr>
<td>Print</td>
<td>Use this command to print a document. This command presents a <strong>Print</strong> dialog box where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Use this command to select a printer and a printer connection. This command presents a <strong>Print Setup</strong> dialog box, where you specify the printer and its connection.</td>
</tr>
</tbody>
</table>
Edit Menu (Report Editor)

The Report Editor Edit menu is used to perform various editing functions on the current graph. You can use it from the menu bar or by right clicking to display the Edit pop-up menu.

Refer to the table below for a brief description of each option found in the menu.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Use the Undo option to cancel the last action performed.</td>
</tr>
<tr>
<td>Cut</td>
<td>Use the Cut option to remove information and place it on the clipboard for retrieval by the Edit/Paste option.</td>
</tr>
<tr>
<td>Copy</td>
<td>Use the Copy option to copy the information to the clipboard for retrieval by the Edit/Paste option. This information can also be pasted into the Annotation window to be added to a plot.</td>
</tr>
<tr>
<td>Paste</td>
<td>Use the Paste option to retrieve any information placed on the clipboard.</td>
</tr>
<tr>
<td>Select All</td>
<td>Use the Select All option to highlight all of the text in the current file. You can then copy it to the clipboard for retrieval or delete it, etc.</td>
</tr>
<tr>
<td>Find</td>
<td>Use the Find option to locate a string of characters in your document. See the next section for details.</td>
</tr>
<tr>
<td>Replace</td>
<td>Use the Replace option to locate and replace a string of characters in your document. See the next page for information.</td>
</tr>
<tr>
<td>Font</td>
<td>Use the Font option to access the Font window, which allows you to select a font, font type, font size, and effects.</td>
</tr>
<tr>
<td>Word Wrap</td>
<td>Use the Word Wrap option to turn on (checked) or turn off (unchecked) the word wrapping capability in the text editor.</td>
</tr>
</tbody>
</table>
Finding Text

Use the Find option to locate a particular string of characters within your document. When you select this option the Find window, shown in the figure below, is displayed.

![Find Window](image)

**Figure 6.11**
**Report Editor Find Window**

Follow these instructions to locate a string of characters:

1. Type the desired string of characters in the Find what field.

2. Check Match whole word only, if you want to find that exact word without any prefixes, suffixes, etc.

3. Check Match case, if you want to find that exact set of characters in only the case typed.

4. Click the Find Next button to find and select the next occurrence of the text specified.

**NOTE:** Searching begins from the position of the cursor within the document to the end of the document.

Replacing Text

Use the Replace menu (shown here) to locate and replace a string of characters in the open document with another string (Text option) or to replace the space separators in the document with either tabs or commas. Some spreadsheet programs will not separate the numerical data in a row unless there are either tabs or commas between the numerical data.
Getting Reports

Text

When you select the Replace/Text option the Replace window, shown below, is displayed. Use this window as follows to locate a string of characters within the open document.

![Replace Window](image)

**Figure 6.12**
**Report Editor Replace Window**

1. Type the string of characters you want to locate in the Find what field.

2. Type the string of characters that you want to use to replace the existing string.

3. Check Match whole word only, if you want to find and replace that exact word without any prefixes, suffixes, etc.

4. Check Match case, if you want to find and replace the given set of characters in only the case typed.

5. Click the Find Next button to locate the characters.

6. Click the Replace button to replace the selected instance of the search criteria, find the next occurrence, and then stop.

**NOTE:**

After you have completed both entry fields, you can use the Replace All button to automatically locate and replace all occurrences of the search criteria in your document. To replace the occurrences one at a time, use the Replace button.

**Space Separators With Tabs**

Use this menu option to automatically replace the space separators in the document with tabs. Some spreadsheet programs will not separate the numerical data in a row unless there are tabs between the numerical data. After choosing this option, you can copy and paste or export the data in the report to another application, such as a spreadsheet program.
Space Separators With Commas

Use this Replace menu option to automatically replace the space separators in the document with commas. Some spreadsheet programs will not separate the numerical data in a row unless there are commas between the numerical data. After choosing this option, you can copy and paste or export the data in the report to another application, such as a spreadsheet program.

Insert Menu (Report Editor)

The Report Editor Insert menu is used to add the items shown in the menu (listed below) to your text file. This can allow you to create one file that contains all of the information gathered from the current data file.

Refer to the pages listed beside each item below to obtain more information on what will be added to your report.

- Report Heading - page 6-20
- Results Report - page 6-4
- Data Table - page 6-7
- Parameter Block - page 6-9
- Method Log - page 6-10
- Current Macro Report - page 6-11
- Autoqueue Report - page 6-12
Report Heading (Report Editor)

Use the Report Heading option on the Insert menu to insert the information contained in the report heading of the current data file into the open text file. The report heading contains the following information: file name, experiment run date, name of the program used for analysis, run number and the type of file. See the example below.

![Report Heading](image)

Help Menu (Report Editor)

The Report Editor Help menu is used to access help topics and help on the Report Editor.

- Help Topics (Report Editor): Use this menu item to display the topics available in the online help associated with the current application.

- Help on Report Editor: Use this function to access help on the Report Editor program.
Opening the Spreadsheet Program

Use this function to open the Microsoft Excel® program with a blank first sheet.

**NOTE:**

If you want to bring the data file into Microsoft Excel, select **View/Data Table/Spreadsheet** from the menu.

If you need help using the program, see the documentation provided with the program.

Creating a Custom Report Template

The Custom Report Editor is used to create and edit customized Universal Analysis report templates. The templates are created using any number of report objects such as plots, results, parameters, method log, data tables, etc. The report object boxes (which represent the plots, results, etc.) can be sized and positioned as desired to fit on a single piece of paper. After a template file is created and saved, it can be used over and over again with different data files and can even be linked to an Autoanalysis macro to further automate the process of analysis and report generation.

The Custom Report Editor program requires that you have Microsoft Word® 97 or Word 2000 installed on your computer. In order for the spreadsheet function to operate, Microsoft Excel® must be installed on your computer.

You can create templates that call for only one file or templates that use multiple files. A template using one file will create the report from the current file. A template that requires multiple files will prompt you to select the files desired.

**NOTE:**

Only one Custom Report window at a time is available within the Universal Analysis program.

Universal Analysis generates custom report documents by directly running Microsoft Word and Microsoft Excel from within Universal Analysis. Each report object inserted is dynamically created at run time and inserted into a single integrated Word document. Once the Word document is created, you can edit any spreadsheets within the document by double-clicking on the object to open Excel with Word.

You can insert, edit, import, export, and print the report objects using the menus and tool bar buttons. For further information see the following pages.

Microsoft Word® and Microsoft Excel® are registered trademarks of the Microsoft Corporation.
Getting Reports

Starting the Custom Report Editor Program

There are several options available in the View/Custom Report menu (shown here) that can be used to start the Custom Report Editor program with either a blank (new) report template or to open/print an existing report template.

Use the Custom Report/New menu item to create a new custom report template or choose Custom Report/Edit to edit an existing report. When you select this menu item the Custom Report Editor window is displayed either with a blank window (new) or with the custom report last created (edit).

Select the name of an existing report template from the Custom Report list to either open the report in Microsoft Word® or send the report directly to the printer.

When the Custom Report Editor program opens, the window shown to the left is displayed.

For instructions on how to use this program and customize it to your own preferences, turn to the next several pages.
Creating a Custom Report Template

Basic Instructions on Creating a Template

There are many different ways to create a report template in Universal Analysis. The set of steps that follows is intended to give you a basic idea of the steps involved with creating a custom report template.

1. Open the desired data file(s) and analyze the data to obtain the results you want.

**NOTE:** You can create a report template with no files open (which creates empty report objects). The report objects will be filled in when a data file is open and the appropriate information is supplied. For example, there can be no results report created if no analysis is done on the open file.


3. Select the desired object to insert in your template from the Insert menu or from the tool bar.

4. Size the object block by positioning the cursor over the border of the block and hold down the mouse while moving the cursor.

5. Drag-and-drop the object anywhere you desire on the template window. This window represents an 8 1/2 by 11-inch page.

6. Repeat steps 3 through 5 for as many objects as desired. Some objects, such as Text and Data Table insertion, require that you enter information to configure that object.

7. Format the objects as desired. See “Setting Up Options” for information. See the figure to the left for an example of a finished template.

8. Click the button or select File/Save from the menu to save your template. Once you save this file, it will appear in the View/Custom Report menu.
9. Export the report to Microsoft Word® by clicking on the button or by selecting File/Export to Word from the menu. If you have more than one version of an object placed in your template (for example, Normal Plot 1 and Normal Plot 2) the program will prompt you to select the data file that should be linked to each object. If there is only one data file open, the program will assume that this is the source for the object.

See the figure below for an example of a finished report.

Figure 6.14
Example of a Completed Custom Report in Word
Setting Up Options

Once a report object has been inserted into a template it can be moved anywhere on the page that you wish. You can also set up various options associated with that particular report object. For example, if you have inserted a Parameter Block object, you can choose which parameters to include. Some options are applicable to all objects, such as whether or not you want a box around the object and the line weight of the box, font, etc.

This section provides basic instructions on setting options for the objects. For details on a particular option, highlight the menu item and press F1 or click the associated dialog's help button.

1. Highlight the desired object to format or choose Edit/Select All from the menu.

2. Right click to display the pop-up menu or select the desired option from the Edit menu. (The functions that do not apply to this object will be grayed out.)

3. Choose the desired options from the dialog displayed and click OK.

Additional set-up features:

• You can choose to have all inserted objects line up exactly with the grid by selecting Edit/Snap to Grid.

• You can set up certain program options that will apply to all inserted objects and to the layout of the template window by selecting File/Options.

• You can layer the objects on top of each other and place a specific object behind another by highlighting the object and selecting Edit/Send to Back.

• You can lock an object in its current position on the page by highlighting the object and selecting Edit/Position Locked.

• To remove an object, highlight it, then select Edit/Delete from the menu.

• To copy an object, highlight it, then select Edit/Copy from the menu.

• To paste an object, highlight it, copy it (see above), then select Edit/Paste from the menu.
• To change the file number source of an object, highlight it, then select Edit/File Number from the menu.

For more detailed information see the remainder of this chapter or consult the online help in the program.
Using the Custom Report Editor File Menu

The File menu (shown here) is used to open a template file and perform various functions such as closing any open files, setting up options, saving and printing files, etc. See the following table for a description of the menu items available.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Use the New menu item to create a new template file.</td>
</tr>
<tr>
<td>Open</td>
<td>Use the Open menu item to open an existing report template file.</td>
</tr>
<tr>
<td>Close</td>
<td>Use the Close menu item to close the current report template file.</td>
</tr>
<tr>
<td>Save</td>
<td>Use the Save menu item to save the current custom report template to a template file. The template files are saved with the extension .uat. The program will place the template files in the report directory specified on the Main Options - Directory Page.</td>
</tr>
<tr>
<td>Save As</td>
<td>Use the Save As menu item to save the current custom report template with a new name or in a new location. The template files are saved with the extension .uat. The program will place the template files in the report directory specified on the Main Options - Directory Page unless a different directory is specified.</td>
</tr>
</tbody>
</table>

*Table 6.3 Custom Report Editor File Menu*

*(table continued)*
### Table 6.3

**Custom Report Editor**

**File Menu (cont'd)**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export to Word</td>
<td>Use the Export to Word menu item to open the report template file in the Microsoft Word® program. Once it is opened in that program, all of the functions in Microsoft Word will be available to edit the report further as desired.</td>
</tr>
<tr>
<td>Word Template</td>
<td>Use the Word Template function to base your custom report, when it is generated, on an existing Microsoft Word® template file. When this menu item is selected you can browse for and select a Word (.dot) file using the Word Template window.</td>
</tr>
<tr>
<td>Next Report Page</td>
<td>Use the Next Report Page function to select the filename of another Universal Analysis template file to be used as the next page of the custom report. This option links two or more templates together to produce one report.</td>
</tr>
<tr>
<td>Options</td>
<td>Use this menu item to access the Custom Report Options window that allows you to select settings for the program. The types of options available are: set up for the object box, format of the editor grid, units used in the printed report, number of report copies, and various spreadsheet options. See the next section for more details.</td>
</tr>
<tr>
<td>Print</td>
<td>Use this command to print a document. This command presents a Print dialog box where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you specify the printer and its connection. You can also specify the page orientation of both the Custom Report Editor template and the final printed custom report.</td>
</tr>
</tbody>
</table>
Setting Up the Custom Report Options

You can set up default options that will apply to both the Custom Report Editor program and the way that objects are formatted when first inserted using the Custom Report Options window. If you set up these options from this dialog, you can save yourself time when each new custom report template is created.

**NOTE:**

These default options will not be applied to any existing report template. They will only be applied to a new report template that is created after the options are set up.

If you want to individually change the options applying to a specific object, highlight that object, right click to display the pop-up menu and change the desired option.

Follow these instructions to set up the Custom Report Editor program:

2. Select the desired default conditions that will apply to the final printed report:

   - **Automatic**: Check this box to have the program automatically print a custom report when a template name is selected from the View/Custom Report menu.

     If this option was checked when the report template was saved, the custom report will automatically print to the specified report destination when the template filename is selected from the View/Custom Report menu.

     If this box was not checked when the report template was saved, selecting the template filename from the View/Custom Report menu list will open that custom report in Microsoft Word®, but not automatically print it.

   - **Show Report Creation**: Check this box to have the program show the creation of a custom report in Microsoft Word® regardless of whether the custom report is printed automatically.

     If this option was checked when the report template was saved, the custom report is shown in Microsoft Word whenever the custom report is printed either automatically or manually.

     If this box was not checked when the report template was saved, the custom report is not shown in Microsoft Word before it is printed either automatically or manually.

   - **Measurement Units**: Click the arrow to the right of the list to select the measurement units to be used in the Custom Report Editor program. These measurement units will apply to the box line thickness, grid spacing and grid origin, which are all selected on the Custom Report Options window.

   - **Copies**: Enter the number of copies that will be automatically printed when the checkbox Automatic is selected on the Custom Report Options window.

   - **Paper Size**: Click the arrow to the right of the list to select the paper size to be used when the custom report is printed.

   - **Orientation**: Select the radio button desired to print your reports vertically (portrait) or horizontally (landscape).
3. Select the desired default options that will apply to any spreadsheet objects that are inserted into the report template. Please note that these options will not be displayed on the template, they will appear in the final printed report:

- **Show Grid**: Check this box to show a grid on your final custom report when a Microsoft Excel® spreadsheet object is inserted in a new template.

- **Auto Fit Columns**: Check this box to automatically provide the best fit for the columns and rows generated on your final custom report when a Microsoft Excel® spreadsheet object is inserted in a new template.

- **Text Alignment**: Select the alignment of the text contained in the cells of a Microsoft Excel® spreadsheet when it is placed in a custom report. Choose from general, left, center, or right text alignment.

- **Start Column**: Enter the number of the first column that should receive entries when a Microsoft Excel® spreadsheet is generated in a custom report.

- **Start Row**: Enter the number of the first row that should receive entries when a Microsoft Excel® spreadsheet is generated in a custom report.

**NOTE:**

The Start Column and Start Row items are best used when you have an Excel template that you want to pull data into. For example, you may have set up pre-defined columns with certain information in them and want to insert the Universal Analysis-generated spreadsheet to fit that template. So you may not want to start a column 1, you may want to start at column 2, leaving column 1 for the pre-defined information.

4. Set up the Custom Report Editor grid that is displayed. Select from the following options:

- **Visible (Editor Grid)**: Check this box to have a dotted grid displayed on the Custom Report Editor window. This grid help you align the object boxes when creating a template.

- **Horizontal Spacing (of Grid)**: Enter the desired numerical value for the amount of space left horizontally between grid dots. (In order to see the grid, you must check the Editor Grid Visible box.)

- **Vertical Spacing (of Grid)**: Enter the desired numerical value for the amount of space left vertically between grid dots.
• **Horizontal Origin (of Grid):** Enter the desired numerical value for the horizontal origin of the grid on the Custom Report Editor window. For example, if you enter the horizontal origin of 0.2 inches, the grid will start 0.2 inches down on the template page. This option can be used to set a top margin for the custom report.

• **Vertical Origin (of Grid):** Enter the desired numerical value for the vertical origin of the grid on the Custom Report Editor window. For example, if you enter the vertical origin of 0.2 inches, the grid will start 0.2 inches from the left side of the template page. This option can be used to set a left side margin for the custom report.

**NOTE:**
You can select the units used for the grid entries above from the Measurement units list on the top left side of this window.

5. Choose the desired default options that will affect the object boxes that can be inserted into your custom report from the following:

• **Visible in Report:** Check this box to make the object box lines appear around the perimeter of the inserted object in the final Microsoft Word® custom report. For example, if this is checked, a box will be drawn around a Normal Plot in the final custom report.

• **Transparent:** Check this box to make the background of an object transparent or "see-through" for any objects behind it in the final Microsoft Word® custom report. For example, if you check this box for a Text object, you can position the text label over a curve and the curve will show through the background of the text characters. Leave this box blank to make an object opaque.

**NOTE:** The **Transparent** setting does not apply to Microsoft Excel® Spreadsheets. They must always remain opaque.

• **Snap to Grid:** Check this box to have the object boxes automatically aligned with the grid dots when inserted. The boxes will "snap" to line up with the grid dots. This function is good for aligning object boxes more precisely. Leave this box blank to be able to move the object boxes anywhere on the template page. The boxes can be positioned between grid dots, if desired.

• **Line Color:** Click on the arrow to the right of the list to select the desired color for the object box line that will be displayed and printed in the final custom report when exported to Microsoft Word®. (This color will not be displayed on the report template.)

• **Line Thickness:** Enter the desired thickness for the object box line that will be displayed and printed in the final custom report when exported to Microsoft Word®. (This color will not be displayed on the report template.)
**NOTE:** You can select the units used for the Line Thickness entry from the Measurement units list on the top left side of this window.

6. Click OK to apply these options to this session only or click Save to save these options to the initialization file for the program.

**NOTE:** The Default button will recall the default factory settings for this dialog.

---

**Using the Custom Report Editor Edit Menu**

The **Edit** menu (shown here) is used to make changes to an existing report template. You can cut, copy, paste, delete, and select all report objects; you can make changes to specific characteristics of a report object; and you can make the objects snap to the grid or lock their position.

Select (highlight) the report object(s) to be edited and then choose the desired function from the menu. See the table below for a brief description of the first six menu items. The remaining menu items require more extensive explanations and are explained further in this section after the table.

**NOTE:** To make global changes to report object parameters, which will be applied each time a new object is inserted, select **File/Options** from the menu and make changes using the **Custom Report Options** window.

---

**Table 6.4 Custom Report Editor Edit Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Undo</strong></td>
<td>Use the Undo option to cancel the last action performed.</td>
</tr>
<tr>
<td><strong>Cut</strong></td>
<td>Use the Cut option to remove information and place it on the clipboard for retrieval by the Edit/Paste option.</td>
</tr>
<tr>
<td><strong>Copy</strong></td>
<td>Use the Copy option to copy the information to the clipboard for retrieval by the Edit/Paste option.</td>
</tr>
<tr>
<td></td>
<td><em>(table continued)</em></td>
</tr>
</tbody>
</table>
### Table 6.4

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Use the Paste option to retrieve any information placed on the clipboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Use the Delete option to delete the selected report object.</td>
</tr>
<tr>
<td>Select All</td>
<td>Use the Select All option to select (highlight) all of the report objects displayed.</td>
</tr>
</tbody>
</table>

Please refer to the next several pages for information regarding the remaining Edit menu items.

---

**Editing Box Properties for the Report Objects**

After inserting a report object you can make changes to the box around the perimeter from the Edit menu.

**NOTE:** To make changes to the box that will be in effect each time a new report object is inserted, select File/Options and make the changes on the Custom Report Options window.

Follow these instructions to edit the report object box:

1. Select the report object desired on the template.

2. Select Edit/Box from the menu or right click and select Box from the pop-up menu. The Box Options window (shown here) is displayed.
3. Choose the desired options that will affect the selected object box to be inserted into your custom report from the following:

- **Visible in Report**: Check this box to make the object box lines appear around the perimeter of the inserted object in the final Microsoft Word® custom report. For example, if this is checked, a box will be drawn around a Normal Plot in the final custom report.

- **Position Locked**: Check the Position Locked box to make the select report object stay in its current position. You will notice that the position entry fields are grayed out when this box is checked-this it to prevent moving the object. This locks the object in position, even if you select Edit/Select All and attempt to drag all of the object boxes—the locked box will stay in its position.

- **Line Color**: Click on the arrow to the right of the list to select the desired color for the object box line that will be displayed and printed in the final custom report when exported to Microsoft Word®. (This color will not be displayed on the report template.)

- **Line Thickness**: Enter the desired thickness for the object box line that will be displayed and printed in the final custom report when exported to Microsoft Word®. (This color will not be displayed on the report template.)

4. Enter/edit the exact position of the report object in inches:

- **Top**: Enter the amount of inches from the top of the page that you would like the report object to be positioned. For example, if you enter 2 inches here, the box will be positioned two inches down from the top of the page.

- **Left**: Enter the amount of inches from the left side of the page that you would like the report object to be positioned. For example, if you enter 2.25 inches here, the box will be positioned two and one half inches from the left side of the page.

- **Height**: Use this field to enter the length of the report object box-this value will set the height of the box in inches. For example, if you enter 4 inches here, the report object will be four inches long when printed.
Getting Reports

- **Width**: Use this field to enter the width of the report object box—this value will set the width of the box in inches. For example, if you enter 4 inches here, the report object will be four inches wide when printed.

5. Click the OK button when finished. The box options will be shown on the final custom report.

Editing Fonts for the Report Objects

Select the **Edit/Font** option to access the **Font** window (shown here), which allows you to select a font, font type, font size, font color, and effects that will be applied to the highlighted report object.

To change the font to all report objects at once, select **Edit/Select All** from the menu, then select **Edit/Font** or right click and select **Font** from the pop-up menu. Then the font specifications chosen will apply to all highlighted report objects.

Editing Parameters for the Report Objects

Select this option to edit the parameters of the report object. The window that is displayed when **Edit/Params** is selected depends on the report object being edited.

- **Results Report Object**—displays the **Result Options** window. See page 6-6 for information.

- **Data Table Report Object**—displays the **Data Table Limits** window. See page 6-7 for information.

- **Parameter Report Object**—displays the **Parameters Options** window. See the next page for information.

- **Method Log Object**—editing parameters function is not available.
Creating a Custom Report Template

- Plot Object—displays the Plot Options window. See page 6-38 for information.

- Image Object—displays the Select Image File window. See page 6-46 for information.


Editing Parameter-Type Report Objects

Use this window to selectively choose the parameters that you want to display in your finished custom report. Follow these instructions:

1. Highlight the desired parameter report object box on the report template.

2. Select Params from the Edit menu or from the pop-up menu. The Parameter Options window is displayed as seen below.

3. Click in the square box next to the parameter(s) that you want to include in your custom report. You can click the All button to select all of the parameters listed or click the None button to select no parameters. As each parameter is selected the name is displayed in the Arrange parameters area.

![Parameter Options](image)

Figure 6.14
Custom Report Parameter Options Window
4. Highlight each parameter in turn and set it up individually as desired:
   (a) Show the parameter name by checking Show name, if desired.
   (b) List multiple numerical values vertically by checking List vertical, if desired and applicable.

5. Arrange the parameters in the list by highlighting the parameter name and clicking the Move Up or Move Down button.

6. Remove any undesired parameters by highlighting it and clicking the Delete button or unchecking the box next to its name.

5. Click the OK button when finished.

**Editing Plot-Type Report Objects**

To edit the header, axis, footer, etc. that will be placed on the Normal or Overlay Plot included in the custom report follow the steps below:

1. Highlight the desired plot report object(s) on the template.

2. Select **Params** from the **Edit** menu or from the pop-up menu. The **Plot Options** window seen below is displayed.

![Plot Options Window](Image)

*Figure 6.16
Plot Options Window*
3. Check the options that you want to appear in the heading on the printed plot: Sample, Size, Method, Comment, Module, File, Operator, Run Date, Instrument, or Directories. You can also click on the buttons to select All or None of these header options.

4. Check the options that you want to appear on each axis (Y1 to Y4 and X) of the exported plot: Axes names, tick labels, or tick marks. You can also click on the buttons to select All or None of these header options.

5. Select the radio button for the desired header type: Standard, Custom, Blank, or No Header.

6. Check the frame option if you want the plot to be printed with a boxed frame around it.

7. Check the options that you want to appear in the footer on the exported plot: Exotherm direction and/or Program version.

8. If you are exporting your plot to an HPGL plotter, perform the following steps: (a) Select the desired pen setting from the drop-down list. (b) Enter the pixel width of the pen.

9. Click the OK button.

**Editing Text-Type Objects**

To edit the text that will be included in the custom report follow the steps below:

1. Highlight the desired text report object on the template.

2. Select **Params** from the **Edit** menu or from the pop-up menu. The **Report Text** window seen below is displayed.

### Custom Report Universal Analysis

![Report Text](image-url)
3. Make the desired changes to the text or font.

4. Use the Clipboard button to import any text from the clipboard, if desired.

5. Apply the desired Text alignment or Fill color from the drop-down list of choices.

6. Click the OK button when finished.

Editing the File Number of a Report Object

To enter or change the file number that is used to generate the selected (highlighted) report object follow the steps below. The files are numbered in the order that they are opened.

1. Highlight the desired report object on the template.

2. Select File Number from the Edit menu or from the pop-up menu. The File Number window shown here is displayed.

3. Enter the desired file number.

4. Click the OK button when finished.

Editing the Overlay Number of a Report Object

To edit the number of the curve overlay plot inserted as an object in a custom report follow these instructions: First highlight the curve overlay object, then either select Edit/Overlay Number or right click and select Overlay Number. The Overlay Number window is displayed to allow you to change the plot number that will be used when the custom report is output.

**NOTE:** Enter zero (0) for the current overlay plot (the last overlay plot accessed). Zero is the default.
Editing a Spreadsheet Report Object

To edit the parameters of a Microsoft Excel® spreadsheet object on the current template follow these steps:

1. Highlight the desired spreadsheet object(s) on the template.

2. Select Spreadsheet Options from the Edit menu or from the pop-up menu. The Spreadsheet Options window shown here is displayed.

3. Select the desired options that will apply to the highlighted spreadsheet object(s). Please note that these options will not be displayed on the template, they will appear in the final printed report:

4. Enter the location and name of a Microsoft Excel® spreadsheet template file, if you want to place the spreadsheet report into an existing Excel template for the final custom report. NOTE: You can browse for the Excel template file by clicking the Browse button at the bottom of the window.

5. Click the OK button when finished.

Layering the Report Objects

You can place one report object behind another, effectively layering them by using the Send to Back menu item found in the Edit menu. Just highlight the report object that should be behind another and select Edit/Send to Back.

For example, you can insert a plot report object, then insert a text report object to go on top of the plot when printed. If the plot report object ends up on top, just highlight it and select Edit/Send to Back and the text object will be printed on top of the plot object.

When you create a template, one report object can become hidden behind another. Use Send to Back to bring the hidden object forward so that you can reposition it by dragging and dropping it.
Snapping Objects to the Grid

Select (check) **Edit/Snap to Grid** from the Custom Report Editor menu to have the object boxes automatically aligned with the grid dots when inserted. The boxes will “snap” to line up with the grid dots. This function is good for aligning object boxes more precisely. This option may also be set using the **Custom Report Options** window.

This function toggles between checked (on) and unchecked (off). Uncheck this menu item to be able to move the object boxes anywhere on the template page. The boxes can be positioned between grid dots, if desired.

Locking an Object’s Position

Select (check) the **Edit/Position Locked** menu item to make the selected report object stay in its current position. You will notice that the position entry fields are grayed out when this box is checked—this it to prevent moving the object. This locks the object in position, even if you select **Edit/Select All** and attempt to drag all of the object boxes, the locked box will stay in its position.

This function toggles between checked (on) and unchecked (off). Leave this menu item unchecked to move the report object box at will.

Creating a Custom Report with Multiple Files

When you export a file that contains multiple file numbers to Microsoft Word® (by selecting **File/Export to Word** or clicking the button on the tool bar), the **Select File** window (shown here) is displayed. This window enables you to direct the program to the filename to be used for each file number in the template. You do not have to numerically select the files according to the order in which they were opened.
Creating a Custom Report Template

The title of the window reflects the file number to be applied—for example, if you have a template that uses files numbered 1 and 2, the window displayed when the report is exported will prompt you to “Select File 1” and then “Select File 2.”

1. Click on the filename that corresponds to the file number displayed in the window title bar.

2. Click the OK button when finished. If there are multiple file numbers used in the template, a window will be displayed for each file number. When all file numbers have been accounted for, the custom report is generated in Word.

Using the Custom Report Editor Insert Menu

Use Insert menu shown here (or the tool bar buttons) to insert a variety of report objects into a custom report template. You can then resize, move, and format the objects as desired and save them to a template file.

Universal Analysis generates custom report documents by directly running Microsoft Word® and Microsoft Excel® from within Universal Analysis. Each report object inserted in the template file is dynamically created at run time and inserted into a single integrated Word document. Once the Word document is created, you can edit any spreadsheets within the document by double-clicking on the object to open Excel with Word.

NOTE: To make global changes to report object parameters, which will be applied each time a new object is inserted, select File/Options from the menu and make changes using the Custom Report Options window.

For information on the contents of a particular report object, see the explanations earlier in this chapter in the section “Getting Results Information.”
Getting Reports

Inserting a Results Report Object

Select **Insert/Results/Report** from the Custom Report Editor menu to insert an object into the template that represents the results of your analysis in a written report form.

When you select this item, the object block is inserted into the template. It can then be moved, resized, and formatted as desired.

Inserting a Results Spreadsheet Object

Select **Insert/Results/Spreadsheet** from the Custom Report Editor menu to insert an object into the template that represents the results of your analysis in a Microsoft Excel® spreadsheet.

When you select this item, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

When the custom report is dynamically created in Microsoft Word®, the spreadsheet can be further edited and modified by double clicking to start Microsoft Excel®.

Inserting a Data Table Report Object

Select **Insert/Data Table/Report** from the Custom Report Editor menu to insert an object into the template that represents the data table in a written report form. When you select this item, the **Data Table Limits** window is displayed. After you enter and accept the values on this window, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

The data table report shows the sample information and raw data points from the data file. For multiplexed data, such as frequency or amplitude, a separate table is generated for each multiplexed value.

Inserting a Data Table Spreadsheet Object

Select **Insert/Data Table/Spreadsheet** from the Custom Report Editor menu to insert an object into the template that represents the data table in a Microsoft Excel® spreadsheet form. When you select this item, the **Data Table Limits** window (see page 6-7) is displayed. After you enter and accept the values on this window, the object block is inserted into the template. It can be moved, resized, and formatted as desired.
Creating a Custom Report Template

The data table spreadsheet shows the sample information and raw data points from the data file. For multiplexed data, such as frequency or amplitude, a separate table is generated for each multiplexed value.

Inserting a Parameter Report Object

Select **Insert/Parameter/Report** from the Custom Report Editor menu to insert an object into the template that represents a report listing of the experimental parameters (which were used when obtaining the data stored in the data file).

When you select this item, the **Parameter Options** window (see page 6-34) is displayed to allow you to select the parameters to be included. After selecting the parameters and clicking OK, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

Inserting a Parameter Spreadsheet Object

Select **Insert/Parameter/Spreadsheet** from the Custom Report Editor menu to insert an object into the template that represents, in a Microsoft Excel® spreadsheet form, the experimental parameters (which were used when obtaining the data stored in the data file).

When you select this item, the **Parameter Options** window (see page 6-34) is displayed to allow you to select the parameters to be included. After selecting the parameters and clicking OK, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

Inserting a Method Log Object

Select **Insert/Method Log** from the Custom Report Editor menu to insert an object into the template that represents a report listing the method segments that were used to obtain the data file. Each experimental method is made up of a group of segments, which are preprogrammed instructions that are sent to the analytical instrument.

When you select this item, the object block is inserted into the template. It can be moved, resized, and formatted as desired.
Getting Reports

Inserting a Normal Plot Object

Select Insert/Plot/Normal from the Custom Report Editor menu to insert an object into the template that represents a normal plot of the current state of the plotted data file.

When you select this item, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

Inserting an Overlay Plot Object

Select Insert/Plot/Overlay from the Custom Report Editor menu to insert an object into the template that represents a curve overlay plot, which was generated using the Graph/Overlay functions. See Chapter 4 for information on creating a curve overlay plot.

When you select this item, the object block is inserted into the template. It can be moved, resized, and formatted as desired.

Inserting an Image File Object

Select Insert/Image from the Custom Report Editor menu to locate and select a graphics file to insert into your custom report template.

When you select this item, the Select Image File window (shown here) is displayed to allow you locate the desired file. When you click the Open button, the object block is inserted into the template. It can be moved, resized, and formatted as desired.
Inserting a Text Object

Select **Insert/Text** from the Custom Report Editor menu to enter or import text that will be inserted as a report object into your custom report template, then printed on your custom report.

When you select this item, the **Report Text** window (shown here) is displayed to allow you to enter text or import it from the clipboard. After entering/ obtaining the text you can click the font button to format it. To place the text in a particular position, choose from the Text alignment drop-down list. You can also choose a Fill Color from the list. This will be used to fill in the text block on the final report with the chosen color. When you click the OK button, the object block is inserted into the template. It can be moved, resized, and formatted as desired.
Using the Custom Report Editor Tool Bar

The tool bar contains buttons that allow you to perform some of the major functions available in the menus. See the table below for the button and its function.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>Used to locate and open an existing report template file.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>Used to save a report template file.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>Used to export the current custom report to Microsoft® Word.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>Used to print the report.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>Used to insert an analysis results report.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>Used to insert an analysis results report in spreadsheet form.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>Used to insert a data table report.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Image" /></td>
<td>Used to insert a data table report in spreadsheet form.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /></td>
<td>Used to insert a parameter block report.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Image" /></td>
<td>Used to insert a parameter block report in spreadsheet form.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Image" /></td>
<td>Used to insert a method log.</td>
</tr>
<tr>
<td><img src="image12.png" alt="Image" /></td>
<td>Used to insert a normal plot.</td>
</tr>
<tr>
<td><img src="image13.png" alt="Image" /></td>
<td>Used to insert a curve overlay type of plot.</td>
</tr>
<tr>
<td><img src="image14.png" alt="Image" /></td>
<td>Used to locate and insert a graphics image from a graphics file.</td>
</tr>
<tr>
<td><img src="image15.png" alt="Image" /></td>
<td>Used to enter text to insert in your template.</td>
</tr>
</tbody>
</table>
Chapter 7
Getting Help

Introduction ................................................................................................. 7-3
Context-Sensitive Help ............................................................................... 7-3
Help Menu Options .................................................................................... 7-3
Obtaining a Printed Manual ....................................................................... 7-6
Contacting TA Instruments ........................................................................ 7-7
  United States: ......................................................................................... 7-7
  Overseas: ............................................................................................... 7-7
Introduction

There are several different types of help that you can get for the Universal Analysis program—context-sensitive help within the program, help from the Help menu, and help from the TA Instruments company itself.

This chapter provides you with some information regarding the types of help available.

Context-Sensitive Help

Most Windows® programs contain some form of help for their programs. You may be already familiar with these types of help from the use of other applications. For detailed information on the help available within the Thermal Advantage programs, refer to the Getting Started Guide that you received when you purchased the program.

In general, context-sensitive help refers to help that is available for in a specific context within the use of the program. For example, when you have the Data File Information window open in Universal Analysis, you will notice that a Help button is available on that window. Clicking on that button brings up a help topic specifically dealing with the open window. Context-sensitive help is also generally available by pressing the F1 key on your keyboard when an item (button, field, etc.) in question is highlighted.

Help Menu Options

Universal Analysis also contains a Help menu on the main menu. This allows access to several different types of help.

The Universal Analysis Help menu is used to access help and product information. Select Help from the main menu and the menu shown here is displayed.

- **Help Topics** opens a table of contents specific to the current program. See the figure on the next page for an example. You can use the contents, index, or find functions to locate information.
**Getting Help**

**Universal Analysis for Windows NT**

Introducing TA Instruments powerful tool for analyzing data obtained from any of the following instruments:

- DSC (Differential Scanning Calorimeter)
- High-Temperature DTA (Differential Thermal Analyzer)
- DMA (Dynamic Mechanical Analyzer)
- SDT (Simultaneous Differential Technique) Analyzer
- TGA (Thermogravimetric Analyzer)
- TMA (Thermomechanical Analyzer)
- DEA (Dielectric Analyzer)
- μTA (Micro Thermal Analysis)

Using Universal Analysis you take any combination of signals for plotting and analyzing. You can select the type and number of curves, region to be graphed, the type of transition analysis, which transitions to analyze, and the limits of transitions.

See also: **Using the Main Menu**

---

**Figure 7.1**

**Help Topics**

- **How To?** opens an online help document that provides step-by-step instructions on how to perform certain functions in the Universal Analysis program.

- **User Manual** opens an online instructional manual that contains step-by-step instructions on the use of the Universal Analysis program.

- **Glossary** opens an online alphabetic glossary of terms commonly used in thermal analysis. See the figure on the next page.

- **About Universal Analysis** displays the copyright notice, software key information, and version number for your copy of *Thermal Advantage* Universal Analysis.
Figure 7.2

TA Instruments Glossary

-A-
Select any entry listed under the letter A by clicking on the term.

Abort segment
AC/DC (Air, Compressor, Accessory)
address
air bearings
air cool
Air Cool segment
air filter regulator
Obtaining a Printed Manual

If you wish to use a hard copy manual to learn how to use the Universal Analysis program, you can print the manual you are viewing now by selecting **File/Print** from the Acrobat Reader main menu. This displays the default printer window and allows you to print some or all of this manual.

**NOTE:**

If you print this entire manual, it could take some time, depending upon the speed of your printer and computer.

If you prefer, you can contact TA Instruments for information on how to purchase a hard copy manual directly from the company. See the next page for information.
Contacting TA Instruments

To obtain information or place an order, use the telephone numbers and fax numbers listed below for the TA Instruments office closest to you.

United States:

TA Instruments, Inc.
109 Lukens Drive
New Castle, DE 19720
Telephone: 1-302-427-4000 or 1-302-427-4040
Fax: 1-302-427-4001

HELPLINE—U.S.A.
For technical assistance with current or potential thermal analysis applications, please call the Thermal Analysis Help Desk at 1-302-427-4070.

SERVICE—U.S.A.
For instrument service and repairs, please call 1-302-427-4050.

Overseas:

TA Instruments Ltd.
Europe House, Bilton Centre
Cleeve Road
Leatherhead, Surrey KT22 7UQ
England
Telephone: 44-1372-360363
Fax: 44-1372-360135

TA Instruments GmbH
Max-Planck-Strasse 11
D-63755 Alzenau
Germany
Telephone: 49-6023-9647-0
Fax: 49-6023-9647-77

TA Instruments Belgium
A Division of Waters s.a./n.v.
Raketstraat 60
B-1130 Brussels
Telephone 32-2- 706 00 80
Fax 32-2- 706 00 81
Getting Help

TA Instruments The Netherlands
A Division of Waters Chromatography B.V.
Florijnstraat 19
4879 AH Etten-Leur
Telephone 31-76- 508 72 70
Fax 31-76- 508 72 80

TA Instruments Japan
No. 5 Koike Bldg.
1-3-12 Kitashinagawa
Shinagawa-Ku, Tokyo 140
Japan
Telephone: 813/3450-0981
Fax: 813/3450-1322

TA Instruments France
B.P. 608
78056 Saint-Quentin-Yvelines
Cedex
France
Telephone: 33-1-30-48 94 60
Fax: 33-1-30-48 94 51

TA Instruments Spain
Waters Cromatografia, S.A.
División TA Instruments
28108 Alcobendas
Madrid, Spain
Telephone: 34-91-661-8448
Fax: 34-91-661-0855

TA Instruments Australia
Unit 3
38-46 South Street
Rydalmere NSW 2116
Australia
Telephone: 61-29-9331-705
Fax: 61-29-8981-455

TA Instruments Italy
Division of Waters SpA
via Achille Grandi 27
20090 Vimodrone (MI), Italy
Telephone: 39-02-27421-1
Fax: 39-02-250-1827
Chapter 8
Autoanalysis

Introducing Autoanalysis .............................................. 8-3
Description of Macros ................................................. 8-3
What is a Macro Variable? ............................................. 8-5
Naming Variables ....................................................... 8-5
Defined Variables ..................................................... 8-5

Using the Macros Menu ................................................. 8-6

Creating a New Macro .................................................. 8-10

Toggling Between Capture On/Off ................................. 8-12

Tips on Capturing Macros ............................................. 8-13

Editing a Macro .......................................................... 8-15
Using the Macro Edit Menu ........................................... 8-16
Cutting a Step .......................................................... 8-16
Copying a Step .......................................................... 8-16
Pasting a Step .......................................................... 8-17
Deleting a Step .......................................................... 8-17
Deleting Steps From a ................................................. 8-18
Certain Position to the End .......................................... 8-18
Deleting All Steps ...................................................... 8-18
Modifying a Step ....................................................... 8-18
Watching the Macro List .............................................. 8-20

Using the Macro Insert Menu ....................................... 8-22
Inserting an Initialization Step ...................................... 8-22
Inserting Dialogs ...................................................... 8-23
Inserting an Assign Clipboard Step .............................. 8-27
Inserting an Assign Variable Step ............................... 8-28
Inserting a Test Variable Step ..................................... 8-30
Inserting Jumps ........................................................ 8-32
Inserting a File Name ................................................ 8-32
Inserting Beeps ....................................................... 8-34
Inserting Delays ........................................................ 8-34
Inserting a Wait OK Step ........................................... 8-35
Inserting a Wait Accept Limits Step ............................. 8-35
Inserting a Close All Files Step .................................... 8-35
Inserting a Stop Macro Step ........................................ 8-36
Inserting an Exit Program Step ..................................... 8-36

Running a Macro ........................................................ 8-37
Stopping a Running Macro .................................................. 8-38

Debugging a Macro .......................................................... 8-38

Managing Macros .............................................................. 8-39
   Selecting/Opening a Macro .............................................. 8-39
   Copying a Macro .......................................................... 8-39
   Deleting a Macro .......................................................... 8-40
   Importing Macros ......................................................... 8-41
   Saving a Macro ........................................................... 8-42
   Loading a Different Macro File ......................................... 8-42

What is an Autoqueue? ....................................................... 8-43
   How the Autoqueue Works .............................................. 8-43
   How Autoanalysis Affects the Autoqueue ......................... 8-44
   Universal Analysis Program .......................................... 8-44
   What is the Autoqueue Log? ............................................ 8-44

How is an Autoqueue Made? .............................................. 8-45
   Creating an Autoqueue Automatically .............................. 8-45
   Creating an Autoqueue Manually .................................... 8-46

Using the Autoqueue File Menu ........................................... 8-48
   Running the Autoqueue .................................................. 8-48
   Automatically Running the Autoqueue .............................. 8-48
   Importing an Autoqueue File ......................................... 8-49
   Exporting an Autoqueue File ......................................... 8-50
   Printing the Autoqueue ................................................. 8-50
   Print Setup for the Autoqueue ....................................... 8-50
   Clearing the Autoqueue Log .......................................... 8-50

Using the Autoqueue Edit Menu .......................................... 8-51
   Cutting Autoqueue Records .......................................... 8-51
   Copying Autoqueue Records ......................................... 8-52
   Pasting Autoqueue Records .......................................... 8-52
   Pasting Autoqueue Records at the End ............................ 8-53
   Deleting Autoqueue Records ........................................ 8-53
   Selecting All Autoqueue Records ................................... 8-54
   Modifying Autoqueue Records ....................................... 8-54
   Appending Autoqueue Records ...................................... 8-55

Using the Autoqueue Help Menu ......................................... 8-56

Appending/Modifying ...................................................... 8-57

Autoqueue Records ......................................................... 8-57
Introducing Autoanalysis

Autoanalysis is an option for the Universal Analysis program that is designed to streamline the data analysis process. Using Autoanalysis you can automatically retrieve the data files from completed experiments and perform a predetermined analysis without operator intervention (this is called Autoqueuing). When used in this fashion, Autoanalysis provides increased productivity, particularly when combined with a DSC or TGA autosampler.

Autoanalysis is based on the use of macros, which capture and store a series of data analysis steps that are later recalled and replayed upon command. These steps can include specialized features such as message boxes, pauses, branching, and beeps. These features can be valuable in the “semi-automated” mode. In a “semi-automated” mode the number of operator interactions required to perform an analysis is reduced. The interactions can be limited to those where operator judgment is critical (e.g., determination of peak integration limits), or to increase the ease-of-use (e.g., quality control using established procedures).

Autoanalyzing is the process where one or more multiple analysis records (containing the data filename, macro filename, and applicable macro) are added to an autoqueue and automatically processed. Analysis records may be added to the autoqueue either from the controller or manually through Universal Analysis (use the Macro/Autoqueue menu).

NOTE: When a macro is being executed, Universal Analysis must run in the foreground (e.g., switching to another program will result in an error in the macro).

Description of Macros

Macros are created, edited, and managed within the data analysis program. They may be executed two ways: either locally, within the analysis program, or from the controller. You can create up to 30 macros per macro file, each macro can contain up to 800 steps.

The macro functions provide the following features:

• You can “capture” almost all of the functions of the data analysis program in a macro for replay. This can include both typing keystrokes and mouse functions.

• You can define up to 30 available macros, each with up to 800 steps in a macro file.
• Any step within a macro can play another macro. (Therefore, the maximum number of steps available is actually $30 \times 800 = 24,000$ steps.)

• You can edit a macro as you build it or after the macro has been completed, without repeating all of the steps.

• You can set up a macro to contain specialized message boxes that ask you to make decisions as the macro runs.

• Macro functions can be accessed at any point in the analysis program by using the control keys shown in the menus. For example, you can turn on the capture function by pressing Ctrl+T on any window.

• Macros are stored as files. The default macro subdirectory for Universal Analysis is named \TA\Macros.

**NOTE:**

Universal Analysis is shipped with two demonstration macro files - WinUA.mac and Demo-Vxx.mac. These two files have the same contents. These files are used to demonstrate the macro functions and, in some cases, can be used with your own data files.

- If you already have a WinUA.mac file, when you installed the software, it was not replaced by the demo WinUA.mac file, just the Demo-Vxx.mac file was installed. You can review the macros contained in the demo WinUA.mac file by loading this file using Macro/Load and selecting the file. You can then use Macro/Import to import one or more of the demonstration macros into your own macro file.

- If you did not have a WinUA.mac file, both of the demo files will be installed and the macros contained in the WinUA.mac file will automatically be displayed in the macro menu.

To remove these demonstration macro files, select Macro/Delete All or selectively delete the unwanted macros.
What is a Macro Variable?

Macro variables provide the ability to store, manipulate, and test numbers inside an executing macro. Each variable can store a single floating-point number or an array of numbers. Up to 200 macro variables and/or array elements can be defined at one time. Three macro steps (Assign Variable, Assign Clipboard, and Test Variable) in the Insert menu of the Macro Editor provide access to the user defined variables.

Naming Variables

Use the following guidelines when entering the variable names:

- Variables names can only have alphabetic characters, numbers, underline character (underbar), and square brackets (to enclose an optional index which must be a simple variable name or number).

- The first character in a variable name must be alphabetic. Alphabetic characters are not case sensitive (i.e., Capital "A" is the same as lower case "a.")

- The variable name cannot exceed a total of 30 characters. Imbedded spaces are not permitted in macro variable names. A macro variable array element is specified by following the variable name with an array index enclosed in square brackets ("[<index>]”). The array index may be an integer constant or a simple variable name (no index).

Examples: X, Sum, Tg35, average[i], long_name_with_underbars, NameWithoutUnderbars, array_name[subscript], array_name[123], data_3[index_2]

Defined Variables

The running macro cannot have any more than 200 defined variables. This total includes both the current macro and any macros called from within that macro containing additional defined variables.

If a variable is never assigned a value in a running macro, then the variable is not considered to be defined and therefore is not counted as one of the 200 variables. Variables become defined at macro run time, only. All previous variables are set as undefined when a macro starts executing from the beginning.
Using the Macros Menu

The Macros menu, which can be accessed from the Universal Analysis main menu (shown below), contains options that let you create and edit macros that are used to automatically analyze data files. This automatic technique is called autoanalysis.

The menu items found on the Macros menu (shown here) or on the Macro Editor/Macros menu are described in the table below and detailed on the following pages.

### Table 8.1
**Macros Menu**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Displays the Macro Information window, which allows you to enter a name and description for the newest macro before you begin to capture the first step.</td>
</tr>
<tr>
<td>Open</td>
<td>Select the Open menu item to display a list of the existing macros to allow you to open a different macro to edit and/or execute.</td>
</tr>
<tr>
<td>Copy</td>
<td>Select the Copy menu item to copy the current macro information into a new macro. The Macro Information window is displayed to allow you to rename the copied macro.</td>
</tr>
<tr>
<td>Import</td>
<td>Select Import to import a macro that will be added to the current macro file. This function displays the Open (file) window. After you select the macro file to open, you will see the Macro Import window. Check the desired macro(s) to import to the current macro file and select OK.</td>
</tr>
</tbody>
</table>

*Table continued*
Table 8.1
Macros Menu
(continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Select Delete to delete the current macro.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Select Delete All to delete all of the macros contained in the current macro file. You can use this option to create a new, empty, macro file by selecting Save As, then renaming the file with a new name.</td>
</tr>
<tr>
<td>Information</td>
<td>Select Information to display the Macro Information window for the currently open macro.</td>
</tr>
<tr>
<td>New File</td>
<td>Select New File to create a new macro file. When you select this function, a new, empty macro file is set up in memory by deleting all currently-loaded macros. The Save As window is displayed. Enter a new name for your macro file, then click the Save button. You will then be ready to create new macros to be stored in this new macro file.</td>
</tr>
<tr>
<td>Load File</td>
<td>Select Load File to load a different macro file. This function displays the Open (file) window, allowing you to specify an existing macro file.</td>
</tr>
<tr>
<td>Save File</td>
<td>Select Save File to save all of the macros currently available (as seen in the list displayed next to Macro/Open) to the current macro file.</td>
</tr>
<tr>
<td>Save File As</td>
<td>Select Save File As to save all of the current macros to a macro file. This option is useful when you want to create a new macro file containing a specific set of macros that exist in the current file. When you select Save As, a window is displayed that allows you to select an existing macro file or create a new one. The filename that is shown when the window is opened is the one that is currently loaded.</td>
</tr>
<tr>
<td>Print</td>
<td>Use this command to print a macro. This command presents a Print dialog box, where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options.</td>
</tr>
</tbody>
</table>

*(table continued)*
Table 8.1
Macros Menu (continued)

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Setup</td>
<td>Use this command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you specify the printer and its connection.</td>
</tr>
<tr>
<td>Capture On/Off</td>
<td>Use the Capture On function to begin (checked) or stop (unchecked) the capture process to build to macro. The option toggles on and off. You can use either the Capture On menu option or the shortcut, Ctrl+T, to toggle the capture function on and off. For more details see “Capturing a New Macro” on page 8-9.</td>
</tr>
<tr>
<td>Run</td>
<td>Select Run or its shortcut, Ctrl + R, to execute, or run, the current macro. You can choose to begin at step 1 of the macro or continue the macro from its current position as seen in the Macro Editor window.</td>
</tr>
<tr>
<td>Single Step</td>
<td>Select Single Step (or its shortcut, Ctrl+G) to run the current macro one step at a time. When you choose Single Step, you will need to press any key (except Escape) to proceed to the next step in the macro. If the macro is not currently on the first step, you have the option to go to the beginning or continue the macro from its current position.</td>
</tr>
<tr>
<td>Execute</td>
<td>Select Execute to run (or execute) a macro that you select from the list of macros available in the current macro file. This function can be included as a macro step that executes another macro within the current macro.</td>
</tr>
<tr>
<td>Stop</td>
<td>Select Stop (or press the Escape key) to halt the currently executing macro. The process will stop immediately and a confirmation message will be displayed. To continue the macro, select Macros/Run. A message is displayed if you are not starting the macro from the first step. This message allows you to execute the macro beginning at the first step (select Yes) or from the current step (select No).</td>
</tr>
</tbody>
</table>

(table continued)
### Table 8.1

**Macros Menu (continued)**

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro Editor</td>
<td>Select <strong>Macro Editor</strong> (or its shortcut, Ctrl+E) from the <strong>Macros</strong> menu to display the <strong>Macro Editor</strong> window for the current macro. This window displays a list of all the steps contained in the macro as they are captured and provides valuable information when you capture, view, edit, and debug the macro steps. For more information see “Editing a Macro” on page 8-14.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>If the <strong>Macro Editor</strong> window gets covered up by another window, you can bring it back to the front by pressing Ctrl+E two times.</td>
</tr>
<tr>
<td>Autoqueue</td>
<td>Use this menu item to open the <strong>Autoqueue</strong> window, which is used to edit the autoqueue. For more information see “What is an Autoqueue?” on page 8-35 or “Using the Autoqueue Menu” on page 8-40.</td>
</tr>
</tbody>
</table>
Creating a New Macro

The first time that you create a macro requires patience along with trial-and-error, until you are able to create a macro that will perform all of the steps that you require, without error. Macros are based on keystrokes and mouse actions. With this in mind, it is important to remember that the success of a macro depends on starting the macro from the same position, and using the same conditions that were in place when the macro was created. Follow these basic steps to create a new macro.

1. Select Macros/New from the main menu. The Macro Information window is displayed.

![Macro Information Window]

**Figure 8.1**
Macro Information Window

2. Enter a name for your macro that will help you to remember what the macro will do if you run it (limit is 30 characters). For example: tga analyses

3. Enter a description of the steps that will be performed in your macro (limit 300 characters). You can recall the name and description at any time by selecting Macros/Information from the menu, when the macro is open.

4. Click the OK button. An almost empty Macro Editor window is displayed (as shown here) and the capture function is automatically turned on. The only step displayed is the last step of the macro. This step is automatically placed in each macro to signify the end and cannot be removed. **IMPORTANT:** From this point on, any operation that you perform will be captured in your macro, unless you turn the capture function off (use Macros/Capture On or Ctrl+T).
5. Proceed through the steps that you want to capture in your macro. Remember that each action you take is captured in the macro. But, you can go back later and edit any mistakes that are captured. **IMPORTANT**: Each new macro step that is captured will be inserted between the current (highlighted) step and the next step displayed on the Macro Editor window.

6. Turn off the capture function (uncheck Macros/Capture On or press Ctrl+T again) when you have finished capturing your steps.

7. Edit your macro as desired. You can insert message boxes, jumps, beeps, and other functions in your macro using the Insert menu. For more information on editing macros, turn to “Editing a Macro” on page 8-14. See the figure below for an example of a finished macro.

8. Test your new macro by selecting Run from the Macros menu.

![Macro Editor - tga analyses](image)

**Figure 8.2**

*Example of Finished Macro*
Toggling Between Capture On/Off

The Macros/Capture On function is used to begin (checked) or stop (unchecked) the capture process to build to macro. The option toggles on and off. You can use either the Capture On menu option or the shortcut, Ctrl+T, to toggle the capture function on and off.

**NOTE:**

The capture function will capture the end result of the changes made to a dialog. It will not capture the whole dialog. For more information, see “Tips on Capturing Macros” found on page 8-12.

When the capture function is on, a message appears in the lower left corner (status line) of the program to tell you that capturing is active, which macro is currently open, and the currently selected step in the macro.

**Shortcut Keys**

Ctrl+T
Tips on Capturing Macros

The successful completion of a macro, from beginning to end, depends on a continuous selection of steps that have a logical fit. Errors can arise due to changes in the state of the program. Listed below are some hints to help you produce a successful macro.

- **Macro Editor**: View the Macro Editor window when creating macros. This way you will be able to see what items are captured and have a better understanding how this process works.

- **Dialogs**: The capture function will capture only the changes made to a dialog. It will NOT capture the other selected (unchanged) items. To ensure the 'default state' of the dialog, you may want to select the desired items again. Many times this may involve (1) selecting a different item then (2) reselecting the desired item. [The extra step (1) may be deleted without affecting the macro.]

- **Program Settings, Parameters, Options, and Units**: To ensure that these settings are in the same state each time a macro is run, capture the following sequence: Select the desired settings window, select the Default button, then make the desired changes. You can also insert an initialize step in your macro to make sure your setting remain the same.

- **Labels**: When capturing moving or editing labels, it is important to make these changes right after you add them to the graph (versus after multiple analyses and annotations are displayed). The actual label location (mouse coordinates) may change from run to run, the previous mouse coordinates may not longer be valid. In order to capture a step that moves a label, it must be captured immediately using the most recent analysis result.

- **Menus**: It is always more reliable to select items from the standard menu or tool bar versus using their equivalent pop-up menu. For example, deleting an analysis can be accomplished either using Edit/Delete Results/Last from the standard menu or Delete Results from the analysis pop-up menu. The former is more reliable since exact label placement may vary from run to run.

- **Filenames**: When selecting specific files to be used in a macro, it is helpful to make sure that the path listed is not one that will be subject to change. The macro will not be able to locate a file if the path entered is no longer accurate.
• **Resolution**: Changes in computer resolution may alter the ability to perform macro steps involving mouse selection.

• **File Dialogs**: Functions which involve saving or opening a file (e.g., **Save Analysis**, **Save Session**, **Export Data File**, etc.), when captured in a macro routine, will stop at the file dialog and wait for the operator to select the desired path and filename. Once this window is dismissed the macro will proceed with the remaining steps. (If the autoanalyze record is added to the queue from the controller, then the macro will automatically continue on an "Open File" step.) You can insert a filename step after a "File Open" or "File Save" step to avoid this problem. For more information, see “Inserting a Filename” on page 8-25 to specify a filename.

• **Printing**: A macro containing the **File/Print** and **File/Print Setup** windows, will stop at these windows and wait for the operator to make the desired selections. Once this window is dismissed the macro will proceed with the remaining steps. [Tip: When printing to the default printer, use the Print tool bar button instead to obtain a continuous analysis macro because the tool bar button will not post a Print dialog that requires a click of the OK button to proceed.]

**NOTE:** To avoid losing your macros, periodically save them to the macro file (default selection is made on the **Main Options - Directory Page**. Before editing a macro, you may want to make a backup copy so that you can restore the original, if necessary.
Editing a Macro

Macros can be edited from Macro Editor window shown in the figure below. The editing process is normally done after you have captured the steps that you want to include in your macro. There are several editing functions that can be performed. Two menu options are available that allow you to change your macro—the Edit menu or the Insert menu. This section describes these menu options.

If your macro contains a "Jump to step x" function, then the step number parameter will be modified automatically to reflect the steps deleted or added.

NOTE:
Autoanalysis

Using the Macro Edit Menu

The Macro Edit menu (shown here) is used to copy, cut, and paste a step from one position to another, delete one or more steps, or modify a step that was already captured.

The following pages provide details on the steps needed to perform each one of the macro editing functions.

Cutting a Step

To remove a selected step from a macro and simultaneously copy it to the clipboard for retrieval by pasting, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Click on the macro step that you want to cut. To select multiple steps, hold down the Shift key while you click on the desired series of steps or click on a step and drag over a range of steps.

4. Select Edit/Cut from the menu (or press Ctrl+X). The step will be cut from the current macro list of steps and copied to the clipboard for retrieval, if desired.

Copying a Step

To copy a step from a macro to the clipboard for retrieval by pasting, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Click on the macro step that you want to copy. To select multiple steps, hold down the Shift key while you click on the desired series of steps or click on a step and drag over a range of steps.

4. Select Edit/Copy from the menu (or press Ctrl+C). The step will be copied to the clipboard for retrieval, if desired.

To copy a step from one macro to another macro, open the first macro, copy the desired step, then open the second macro and paste the step in at the desired position.
Pasting a Step

To insert a macro step, which was previously copied to the clipboard (using either Cut or Copy), into the macro at the selected place, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Cut or copy the desired macro step. To select multiple steps, hold down the Shift key while you click on the desired series of steps or click on a step and drag over a range of steps.

4. Click on the place where you want to insert the macro step.

5. Select Edit/Paste from the menu (or press Ctrl+V). The step will be copied from the clipboard at the numbered position selected.

Deleting a Step

To remove a step from a macro, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Click on the macro step that you want to delete. To select multiple steps, hold down the Shift key while you click on the desired series of steps or click on a step and drag over a range of steps.

4. Select Edit/Delete from the menu (or press Ctrl+D or press the Delete key). The step will be removed from the macro.
Deleting Steps From a Certain Position to the End

To remove the steps from a selected point to the end of the macro, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Select the first step that you want to remove.

4. Select Edit/Delete to End from the menu. All of the steps will be removed from the first step chosen to the end of the macro.

Deleting All Steps

To remove all of the steps from a macro, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.

3. Select Edit/Delete All from the menu. All of the steps will be removed from the macro.

Modifying a Step

You can modify macro steps that contain a text entry, insert parameter, cursor or mouse coordinate, checkbox or radio button selection, or color selection. You cannot, for instance, change a button selection; you must delete, then recapture these steps.

To modify a macro step, follow these steps:

1. Ensure that the macro you want to edit is active by opening the desired macro.

2. Select Macro Editor from the main Macros menu to display the Macro Editor window.
3. Select the macro step you want to modify. Select **Modify** from the **Macro Edit** menu or double click on the macro step. Depending upon the type of step you want to modify, a specific window (see the figures below for the different types of windows) is displayed.

4. Make the desired corrections and select **OK**. If you are uncertain as to how to proceed with the corrections on these modification windows, click the **Help** button for more information.

**Editing a Macro**

![Macro Mouse Position Window](image1)

![Macro Cursor Position Window](image2)

![Macro Checkbox Window](image3)

![Macro Text Window](image4)

![Macro Grid Window](image5)

![Macro Color Window](image6)

![Macro Extended Text Window](image7)

**Figure 8.4**

**The Different Modify Macro Windows**
Watching the Macro List

The Watch List function, selected from the **Macro Edit** menu is used after you have added variables to your macros. When you select **Edit/Macro List** from the **Macro Editor** window, a stay-on-top window is displayed to observe the variables that occur while a macro is running. This can help you to find out where problems exist within the macro steps.

The **Macro Watch List** window permits examination and modification of variables while a macro executes. The window is blank when it is first opened. The variable names to be "watched" are added to the watch list in the window. As the macro executes each step, any variables in the watch list are updated with their current values. A right click popup menu may be used to add and delete variable names from the list, or to modify the current value of a variable while the macro is stopped or single stepping. Variables which have not been assigned a value are shown as "Undefined." If a variable is never assigned a value in a macro then it is not considered to be one of the 200 maximum variables permitted. A variable becomes defined at macro run time, only. When a macro starts execution from the beginning of the macro, all macro variables are initialized as undefined.

![Macro Watch List Window](image)

**Figure 8.5**

**Macro Watch List Window**

To use this window:

1. Right click to display the pop-up menu. Select the desired option from the first three items on the menu:

   - **Add Variable**: This is used to access one variable from the list of variables that are available within the current macro. The Macro Watch Add Variable window is displayed to allow you to choose from the drop-down list of variables.

   - **Watch Macro**: This is used to access all of the variables found in the current macro.

   - **Watch All Variables**: This is used to access all of the variables found in all of the macros in the current macro file.
2. Run the macro. As it runs the variables will be assigned values that you can use to determine whether or not the macro is running as desired.

3. You can delete variables (select Delete Variable or Delete All Variables) or modify the values (select Modify Value) using the pop-up menu, as desired.

4. Close the window when finished.
Using the Macro Insert Menu

The **Macro/Insert** menu (shown here) is used to insert a variety of special options into an already-captured macro.

The following pages provide details on the steps needed to perform each one of the macro insert functions.

Inserting an Initialization Step

Sometimes when you run a macro you can encounter errors because the state of the program has changed since the macro was created and the macro will no longer operate correctly. You can insert a step that will open an initialization (.ini) file into your macro to help eliminate these problems.

Before you start to capture your macro, save the program settings to an initialization file, then load that .ini file. Insert an Initialize step using the saved .ini file as the first step in your macro. This will eliminate problems that can occur due to a change in settings or dialogs made before this macro is run.

To set up your initialization step, follow these steps:

1. Select **File/Options** from the main menu and access the **Main Options - Initialization Page**. Click the **Save As** button and rename the current .ini file.

2. Select **Macro/New**. The **Macro Information** window is displayed. Enter the macro name and description and click the **OK** button.

3. Select **Initialize** from the **Macro Insert** menu. The **Macro Initialize** window is displayed.

4. Use the **Browse** button to locate and select the .ini file created in step 1.
5. Click the OK button. The initialize step will be inserted as the first step in your macro.

6. Capture and save the macro steps desired.

7. Save the macro.

Inserting Dialogs

When you create a macro, you may want to add a message box that will help the person who runs the macro make decisions about the analysis or display a message providing important information about the macro. For example, a message box giving the allowable range for a specific analysis can be displayed, allowing comparison with the experimental result just obtained.

A dialog can be customized with several different options to make it perform the actions you desire.

To set up your macro dialog, follow these steps:

1. Open the desired macro.

2. Select the position in the macro steps for the message box to be inserted into.

3. Select Dialog from the Insert menu. The Macro Dialog window is displayed.

![Macro Dialog Window]

*Figure 8.7 Macro Dialog Window*
4. Enter the desired message text in the **Text** field. You can enter up to 10 lines of 60 characters each.

5. Click on the drop-down list button to display a list of the **Dialog types**. Select the desired type from the table below.

**Table 8.2**

**Macro Dialog Types**

<table>
<thead>
<tr>
<th>Dialog Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Information</strong></td>
<td>When you select this type of message, the word “Information” is displayed in the title bar of the dialog and the icon is displayed.</td>
</tr>
<tr>
<td><img src="autoanalysis.png" alt="Information Icon" /></td>
<td></td>
</tr>
<tr>
<td><strong>Confirmation</strong></td>
<td>When you select this type of message, the word “Confirmation” is displayed in the title bar of the dialog and the icon is displayed.</td>
</tr>
<tr>
<td><img src="autoanalysis.png" alt="Confirmation Icon" /></td>
<td></td>
</tr>
<tr>
<td><strong>Warning</strong></td>
<td>When you select this type of message, the word “Warning” is displayed in the title bar of the dialog and the icon is displayed.</td>
</tr>
<tr>
<td><img src="autoanalysis.png" alt="Warning Icon" /></td>
<td></td>
</tr>
<tr>
<td><strong>Error</strong></td>
<td>When you select this type of message, the word “Error” is displayed in the title bar of the dialog and the icon is displayed.</td>
</tr>
<tr>
<td><img src="autoanalysis.png" alt="Error Icon" /></td>
<td></td>
</tr>
<tr>
<td><strong>No Type</strong></td>
<td>When you select this type of message, no icon is displayed with your text.</td>
</tr>
</tbody>
</table>

6. Click on the drop-down list button to display a list of the **Message Responses** to the text contained in the message. Select the desired response from the list below.

- **OK**: When you select this type of response, the message dialog will display an OK and a Cancel button. After OK has been clicked, the chosen action will be initiated.

- **Yes**: When you select the “Yes” response, the message dialog will display a Yes, No, and Cancel button. After Yes has been clicked, the chosen action will be initiated.
• **No:** When you select the “No” response, the message dialog will display a Yes, No, and Cancel button. After No has been clicked, the chosen action will be initiated.

• **None:** When you select the “None” response, no buttons will be displayed on the message dialog. The dialog will close when the delay time has expired or when the window is closed by clicking in the upper right-hand corner.

**NOTE:**

If the person responding to your macro dialog chooses the button that is opposite of the response you are asking for (the expected response is Yes and they choose No) the macro will keep on going and will not perform the action you requested for your dialog. If Cancel is chosen on the macro dialog, the macro will stop running at that point.

7. Click on the drop-down list button to display a list of the **Actions** that will occur after the response chosen in step 6. Select the desired action shown in the table below. If you selected “Jump to macro step” as your action, continue with step 8. If you do not select this Jump type of action, skip to step 9.

**Table 8.3**

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Continue macro execution</strong></td>
<td>When you select this action, after the appropriate response has been selected, the macro will continue.</td>
</tr>
<tr>
<td><strong>Stop macro, wait for run</strong></td>
<td>When you select this action, after the appropriate response has been selected, the macro will stop and you must select Run from the Macro menu (or type Ctrl+R) to continue the macro.</td>
</tr>
<tr>
<td><strong>Stop macro, wait for Accept Limits</strong></td>
<td>When you select this action, after the appropriate response has been selected, the macro will stop and you must select the cursor limits on the curve and accept the limits. (In this case, the dialog replaces the standard Accept Limits function that can be captured during an analysis.)</td>
</tr>
<tr>
<td><strong>Stop macro, wait for next OK</strong></td>
<td>When you select this action the macro will stop the running of the macro to wait for the operator to press the OK button on a window. Once the OK button has been pressed, the macro will continue.</td>
</tr>
</tbody>
</table>

*(table continued)*
8. For a “Jump to macro step” action only: Type the number of the macro step that the program will jump to, after the message response has been clicked.

9. Check the Beep box, if you want to hear a beep when the message response has occurred.

10. Enter the Delay Time depending upon the response chosen in step 6 as follows:

    • If “None” is selected as a response in step 6, enter the desired Delay Time that the message dialog will be displayed.

    • If any response other than “None” is selected in step 6, you can enter a nonzero Delay Time to use the response chosen after the entered delay time has passed. You can enter a Delay Time of zero to cause the message to be displayed indefinitely while the program waits for a response to the dialog.

11. Select OK when completed. An example of a completed Macro Dialog window and an example of the resulting message dialog are shown in the figure on the next page.
Inserting an Assign Clipboard Step

When you create a macro, you may want to add a macro step that will copy the current value of a macro variable and/or a text string to the clipboard. This is useful for building custom annotations and tables that are placed on a plot or added to a report. To copy values to the clipboard:

1. Select (highlight) the desired position (step number) for the macro step insertion.

2. Select Insert/Assign Clipboard from the Macro Editor menu. The Assign Clipboard window is displayed.

Figure 8.9
Assign Clipboard Window
3. Enter a Variable name, if desired. A macro variable name may consist of up to 30 characters. The first character must be alphabetic. The remaining characters may be alphabetic, digits, or the underline (underbar) character. Imbedded spaces are not permitted in macro variable names. A macro variable array element is specified by following the variable name with an array index enclosed in square brackets ("[<index>]"). The array index may be an integer constant or a simple variable name (no index).

4. Enter the number of Significant figures for the copied value.

5. Check the Round to integer box, if you want to round the value to the nearest integer.

6. Enter a Text string of up to 30 characters, which will be appended to the end of the value when it is copied. If no variable name is specified, then only the text string is copied.

7. Check the Line terminator box, if you want to append an optional carriage return and line feed (<crlf>) line terminator to the copied text.

8. Click OK when finished. The step will be inserted at the selected position.

Inserting an Assign Variable Step

The Assign Variable macro step is used to store a numeric value into a macro variable. The numeric value to be assigned may come from a numeric constant, a number already stored in another macro variable, or a number loaded from the clipboard. The assign step can also be used to add, subtract, multiply, or divide the value of a variable by another value, or to apply a function (such as square root) to the value of a variable.

1. Select (highlight) the desired position (step number) for the macro step insertion.

2. Select Insert/Assign Variable from the Macro Editor menu. The Macro Assign window (shown on the next page) is displayed.

3. Enter a Variable name. A macro variable name may consist of up to 30 characters. The first character must be alphabetic. The remaining characters may be alphabetic, digits, or the underline (underbar) character. Imbedded spaces are not permitted in macro variable names. A macro variable array element is specified by following the variable name with an array index enclosed in square brackets ("[<index>]"). The array index may be an integer constant or a simple variable name (no index).
4. Click on the Operation drop-down list and select the function that will be applied to the value of the variable.

5. Enter the Value assigned to the variable.

**NOTE:**
If the operation is "Assign Clipboard (value)," then the value specifies the nth number found on the clipboard. If the operation is "Assign Clipboard (variable, value)" then the value specifies the nth number found on the clipboard after the first occurrence of the variable name on the clipboard.

6. Click OK when finished. The step will be inserted at the selected position.

**Operations**

Most of the operations listed in the drop-down list are straightforward mathematical functions. The operation "Clipboard (variable, value)" or "Clipboard (value)" is used to copy a specific number from a list copied to the clipboard and ignore the remaining numbers. For example, you can first copy the parameter block from the Report Editor to the clipboard. The first dimension of the sample size parameter can then be obtained from the clipboard by assigning a variable named "size," selecting "Clipboard (value)," and entering "1" as the value.

**Example:**

For an example of a macro that contains an **Assign Variable** step and the other steps needed to make this work, see the figure on the next page. See step #22 in the first example.
Figure 8.11
Macro Examples with Variables

Inserting a Test Variable Step

The Test Variable macro step is used to compare the current value of a macro variable with another variable or constant for conditional branching inside the macro. If the test condition is true then the macro will jump to the specified next step, otherwise macro execution will continue with the macro step immediately following the test variable step.

1. Select (highlight) the desired position (step number) for the macro step insertion.
2. Select **Insert/Test Variable** from the Macro Editor menu. The Macro Test window (see below) is displayed.

![Macro Test Window](image)

**Figure 8.12**
**Macro Test Window**

3. Enter the name of the Variable that will be tested for the condition.

4. Click on the Condition drop-down list and select the condition that will be applied to the value of the variable.

5. Enter the Value to test with.

6. Select the type of Action that will be applied when the condition is met from the drop-down list: Jump to start, Jump to end, or Jump to step.

7. If “Jump to step” is selected, enter the number of the Step that will jumped to.

8. Click OK when finished. The step will be inserted at the selected position. See the following for an example of a completed Macro Test window and resulting step.

**Example:**

The resulting **Test Variable** step is displayed in the macro step worded like this: “If peak_area > 30.0 Then Jump To Step 19.” This step was inserted in the first example macro, shown in the figure on the previous page (step #12), to make sure that the peak area obtained during the running of the macro is greater than 30.0.
Inserting Jumps

You can insert a macro step that will jump to a different step in the macro. This can be useful if you want the macro to repeat a step over again or to skip a set of steps. Select the desired position for the jump before selecting this option.

To insert a jump step into a macro follow these steps:

1. Open the desired macro.
2. Select the position that you want to insert a jump step into.
3. Select Jump from the Insert menu displayed on the Macro Editor window. The Macro Jump window is displayed.

![Macro Jump Window](image)

4. Select one of the following Jump To options from the drop-down list:
   - **Step**: When you select this option, the macro will jump to a step number that you have entered in the Jump Step field.
   - **Start**: When you select this action, the macro will jump to its first step and begin running again.
   - **End**: When you select this action, the macro will jump to its last step and end.
5. Enter the desired step that the macro will jump to, when it is run.
6. Select OK when completed. The jump will be inserted into the macro at the point selected.

Inserting a File Name

When you want to open or save a file as part of your macro operation, you will need to direct the program to the correct file and location. To consistently open or save the correct file, it is best to insert a filename and path into the macro.
Follow these steps to insert an File Name identification step into your macro:

1. Open the desired macro.

2. Capture the desired open or save function.

3. Select the desired step position for the File Name macro step. The position should be immediately after the “Open File” or “Save File” step.

4. Select **File Name** from the **Insert** menu found on the **Macro Editor** window. The **Macro File Name** window is displayed.

5. Choose one of the radio buttons: **Use default file name** (inserts the default filename that is displayed when the macro runs) or **File** (requires that you enter the path and filename for the desired data file or use the **Browse** button to locate and select a data file).

6. Check the **Overwrite existing file on save** box, if you want the system to replace the existing file with the new file that is created if the macro performs a save file function.

7. Select **OK**.
Inserting Beeps

You can setup your macro to alert the operator by inserting a beeping sound at a certain point in the macro's operation. To insert a beep, first select the desired step position for the beep. Then select **Insert/Beep** from the **Macro Editor** window. The beep step will be immediately inserted at the selected position.

To test your beeping sound, execute (or run) the macro.

Inserting Delays

You may want to customize your macro to allow some time between two steps in the macro. This could be a delay time to allow the person running the macro time to look at the analysis results, or time to turn on a printer, etc. When the delay time has passed, the macro will continue.

Follow these steps to insert a Delay step into your macro:

1. Open the desired macro.

2. Select the desired step position for the Delay macro step.

3. Select **Delay** from the **Insert** menu found on the **Macro Editor** window. The **Macro Delay** window is displayed.

4. Enter the time, in seconds, that you want the macro to pause before the next step is executed.

5. Select **OK**.
Inserting a Wait OK Step

You may want your macro to stop running and wait for the operator to give the approval to continue. To do this, select the position for the step using the Macro Editor window. Then select Insert/Wait OK. This will immediately insert a step that will stop the running of the macro to wait for the operator to press the OK button on a window. Once the OK button has been pressed, the macro will continue.

This step replaces the standard “Button OK...” step captured for a window. If you want to post a dialog that tells the operator to make certain selections on a window and press OK, it is best to use the Insert/Dialog function instead of the Insert/Wait OK function. When you set up the dialog, select “Stop macro, wait for next OK” as the action to get the desired results. See “Inserting Dialogs” on page 8-20 for more information.

Inserting a Wait Accept Limits Step

You may want your macro to stop running and wait for the operator to select analysis limits before the macro continues. To do this, select the position for the step using the Macro Editor window. Then select Insert/Wait Accept Limits. This will immediately insert a step that will stop the running of the macro to wait for the operator to choose Accept Limits from the analysis pop-up menu. Once the Accept Limits option has been selected, the macro will continue.

This step replaces the standard “Function Accept Cursor Limits” step captured as part of an analysis series of macro steps. If you want to post a dialog that tells the operator to select the desired analysis limits and select Accept Limits to continue, it is best to use the Insert/Dialog function instead of the Insert/Wait Accept Limits function. When you set up the dialog, select “Stop macro, wait for Accept Limits” as the action to get the desired results. See “Inserting Dialogs” on page 8-20 for more information.

Inserting a Close All Files Step

Select the Close All Files option to insert a macro step that will automatically close any open data files without prompting the person running the macro. If no files are currently open, the Close All Files step will have no effect.

This step is best placed at a point when you have finished all other operations on the open data files and need to either open a new file or complete the macro. If you have a macro that opens and then analyzes
and overlays a series of curves, then you can include the Close All Files step as an easy way to close all of the open files before the macro proceeds. You can also insert a macro dialog step before closing the files to ask if it is acceptable to close all files.

Inserting a Stop Macro Step

You may decide that you want the macro to completely stop during its execution to allow the operator to perform some action before manually restarting the macro. To insert a stop macro step, first select the desired step position for the stop. Then select Insert/Stop Macro from the Macro Editor window. The stop macro step will be immediately inserted at the selected position.

This insert option is helpful when you need to troubleshoot a problem macro. You can temporarily put a Stop step before the suspected problem area in a macro, then continue the macro by single stepping through the remaining steps to help you determine the cause of the problem.

To restart the macro you can perform the run, execute, or single step operation.

Inserting an Exit Program Step

You can insert a step in your macro that will cause the Universal Analysis program to close when desired. First select the position desired for the exit program step (usually the last step). Then select Insert/Exit Program from the menu on the Macro Editor window. The exit program step will be immediately inserted at the selected position. When the macro is run, any messages that are needed, such as the option to save any changes to the macros, will be displayed as usual.
Running a Macro

When you have finished capturing all of the steps that you want in your macro, you are ready to run it. The success of a macro depends on starting the macro from the same position and using the same conditions that were in place when the macro was created. (See “Tips on Capturing Macros” on page 8-12 for information.)

There are four ways to run a macro.

- **Macros/Run (Ctrl+R):** Runs the current macro, as seen in the **Macro Editor** window.
- **Macros/Execute:** Displays a list of all of the macros contained in the current macro file. This allows you to select one from the list.
- **Macros/Single Step:** Runs the current macro, as seen in the Macro Editor window, one step at a time. You must press any key (except Escape) to proceed to the next step.
- **Autoanalyzing:** Automatically runs the macro contained in the autoqueue. See “Using Macros to Autoanalyze Data” or “What is an Autoqueue?” in this chapter for more information.

If the macro is not at the beginning, you will see the following message:

Choose Yes to start at the beginning of the macro or No to start the macro from its current (highlighted) step.

**NOTE:** When a macro is being executed, Universal Analysis must run in the foreground (e.g., switching to another program will result in an error in the macro).
Stopping a Running Macro

To stop a running macro simply press the Escape key or select Macros/Stop from the menu.

To restart a macro after it has been stopped, select Macros/Run or Macros/Execute (or Macros/Single Step to move through the macro one step at a time).

Debugging a Macro

After you have finished capturing a macro, you may run it only to find that it does not execute the way you expected. Errors can occur with the macro process due to the following:

- A change was made in the state of the program. A dialog or option may have been changed and that change affects the way the program operates.

- Editing was done to the macro that has resulted in a now incorrect sequence of macro steps for the current state of the program.

- An insert option is not referencing the correct step number, is positioned in an improper place, or was inserted to replace a step that was not removed.

- When a macro was being executed, Universal Analysis was not run in the foreground (e.g., switching to another program will result in an error in the macro).

One of the ways to debug a macro is to observe the point in the macro file where an error is reported.

- Open the macro and display the Macro Editor window. Run the macro. If you encounter an error when the macro runs, the macro will halt at the point of the error. The step above the highlighted one is the step that couldn’t be executed. Make sure that the step displayed can be conducted based on the current state of the program.

- Temporarily insert a Stop Macro step just ahead of the problem. When the macro execution stops, proceed through the macro, one step at a time from the stopping point, using the Single Step function to locate the problem. When you use the Single Step function, the highlighted step as shown in the Macro Editor is the next step to be executed. The executing step is the step before the highlighted one.
Managing Macros

After a macro has been created and edited, you can take whole macros and perform various functions with them. Most of these functions affect the current macro file only.

The following pages provide details on how to perform the following functions on your macros:

- Selecting/Opening a Macro
- Copying a Macro
- Deleting a Macro
- Importing Macros
- Saving a Macro
- Loading a Different Macro File.

Selecting/Opening a Macro

Only one macro can be open at any time. To open the desired macro, first load the desired macro file. Then select the Macros/Open to display a list of the existing macros in the current file. Just click on the macro you want to open and the steps will be displayed in the Macro Editor window. Now you can add to the macro, edit it, run it, etc.

Copying a Macro

When you copy a macro using the Macros/Copy function, you are actually duplicating the macro under a different name and description. You cannot use this option to selectively copy steps from one macro into another because all steps are duplicated. To copy steps from one macro to another, use the copy and paste options in the Edit menu. To duplicate a macro, select Macros/Copy. The Macro Information window is displayed to allow you to rename the copied macro.
Deleting a Macro

To remove one or more macros from a macro file, you can use one of the following options: **Macros/Delete** or **Macros/Delete All**.

- **Macros/Delete**: Select Delete to delete the current macro. A message box is displayed to confirm removal of this macro.

- **Macros/Delete All**: Select Delete All to delete all of the macros contained in the current macro file. A message is displayed to confirm deletion of all macros in the file. You can use this option to create a new, empty, macro file by selecting Save As, then renaming the file with a new name.

**NOTE:**

If you select Save (rather than Save As) after using Delete All, you will overwrite the current macro file with a new, empty, macro file.

To remove only the macro steps in a selected macro, use the Edit/ Delete All function in the Macro Editor menu.
Importing Macros

You can place macros within other macro files by importing them using the Macros/Import option as follows:

1. Load the macro file that you want to alter.

2. Select Macro/Import to display the Open Macro File window.

   ![Open Macro File Window](image)

   **Figure 8.16**
   *Open Macro File Window*

   3. Locate the macro file that contains the macro you want to import.

   4. Click OK. The Macro Import window is displayed as seen here. Use this window to select the macro(s) that you want to import and add to the current macro file.

   ![Import Macros Window](image)

   **Figure 8.17**
   *Figure Macro Import Window*
5. Check the desired macro(s) to import. You can use the All button to check all of the macros or the None button to uncheck all of macros.

6. Then select OK. The new macro(s) will be added to the list of macros contained in the current file, provided there is enough room in the macro file (30 maximum macros per file).

To view the additions, use Macros/Open or Macros/Execute to display a pop-up list of the macros in the current file.

**NOTE:** Universal Analysis can only open one macro file at a time. A maximum of 30 macros can be contained in any one macro file. Make sure that you do not exceed this limit when importing macros into your current macro file.

**Saving a Macro**

You can save the a macro to the current macro file using one of two options: Save or Save As.

- **Macros/Save:** Select Save to save the all of the macros currently available (as seen in the list displayed next to Macro/Open) to the currently loaded macro file. To load a different macro file, select Macros/Load.

- **Macros/Save As:** Select Save As to save all of the current macros to a selected macro file. This option is useful when you want to create a new macro file containing a specific set of macros that exist in the current file. When you select Save As, a window is displayed that allows you to select an existing macro file or create a new one. The filename that is shown when the window is opened is the one that is currently loaded. After using Save As, the macro file becomes the currently-loaded macro file.

**Loading a Different Macro File**

If you want to load a different macro file from the one currently loaded (the default macro file is selected on the Main Options - Directory Page), use the Macros/Load option. When you select this function, the Open (file) window is displayed, allowing you to specify an existing macro file to load.
What is an Autoqueue?

Autoanalyzing is the process where one or more multiple analysis records (containing the data filename, macro filename, and applicable macro) are added to an autoqueue and automatically processed. Analysis records may be added to the autoqueue either from the controller or manually through Universal Analysis (use the Macro/Autoqueue menu to display the Autoqueue window).

![Autoqueue Window](image)

Figure 8.18
Autoqueue Window

How the Autoqueue Works

When a record is added to the autoqueue from the controller, a message box is displayed (see figure below) asking if you wish to process the autoqueue (autoanalyze) at this time.

![Autoqueue Message](image)

Figure 8.19
Process Autoqueue Message

If you select No, then the record will be added to the autoqueue, but not processed. If you select Yes, then the record will be added to the autoqueue and the queue will begin to process starting with the first entry. If no response to this message box is made, after 60 seconds it will be assumed that Yes is the response and the autoqueue will be processed.

NOTE: If you decide not to autoanalyze when the message is displayed, you can manually run the autoqueue using File/Run from the Autoqueue window or you can wait until another record is added to the queue from the controller and the message is displayed again.
How Autoanalysis Affects the Universal Analysis Program

Because processing the autoqueue takes over the operation of the Universal Analysis program, the state of that program when the autoqueue is processed affects the way it will be handled.

- **Universal Analysis Closed**—If the program is closed when the autoqueue is run, then after the last record has been processed (autoanalyzed), the program will be closed again.

- **Universal Analysis Open**—If the program is open when the autoqueue is run, then after the last record has been processed (autoanalyzed), the program will be left open.

**NOTE:** To stop autoanalysis of the autoqueue, press the Escape key.

**NOTE:** When a macro is being executed, Universal Analysis must run in the foreground (e.g., switching to another program will result in an error in the macro).

What is the Autoqueue Log?

When a record is processed through the autoqueue, it is added to the **Autoqueue Log** (shown in the figure below). An indicator is displayed with each record to let you know whether the record was processed successfully or not. An “OK” is displayed when the record was processed successfully and double exclamation marks “!!” are displayed when an error was encountered. If an analysis record cannot be processed due to an error, then the next record in the queue will be processed.

![Autoqueue Log](image-url)
How is an Autoqueue Made?

The *Thermal Advantage* software can be used to create an autoqueue file for autoanalysis of your data files in two ways—either automatic generation of the autoqueue or manual creation of the autoqueue. The following pages provide instructions needed for both methods.

Creating an Autoqueue Automatically

*Thermal Advantage* has been designed to allow you to take advantage of a technique that can be used to completely automate the collection and analysis of multiple data files. This Autoanalyze technique can be set up to automatically run as follows:

1. **Create an Analysis Macro:**

   The first thing you need to do is to open the Universal Analysis program to create the macro that will be used to analyze your data files. For this macro to work successfully, it must start with an “Open File” step (File/Open). When you create the macro you should use a file similar to the type to be autoanalyzed (e.g., DSC, MDSC, TGA, etc.). Later, when the experiment is complete, the autoanalysis record (containing the finished data filenames) will be appended to the autoqueue.

2. **Set Up Autoanalysis in Instrument Control:**

   Open the Instrument Control program for the desired instrument. Set up your experiment as you normally would. Access the Experimental Parameters window (for Autosamplers, use the Sequence Page). At the bottom of the window, check the Autoanalyze box, use the Browse button to select the macro file desired, then select the macro you created in step (1) above. After you have finished setting up the experiment(s) and loaded the sample(s), start the experiment. As the controller finishes performing the experiment, it will create the record and add it to the autoqueue. See the Instrument Control online manual or *User Reference Guide* for more information.

When a record is added to the autoqueue from the controller, a message box (shown here) is displayed asking if you wish to process the autoqueue (autoanalyze) at this time. If you select...
No, then the record will be added to the autoqueue, but not processed. If you select Yes, then the record will be added to the autoqueue and the queue will begin to process starting with the first entry. If no response to this message box is made, after 60 seconds it will be assumed that Yes is the response and the autoqueue will be processed beginning with the first record. The results will be collected in the Autoqueue Log.

Creating an Autoqueue Manually

You can also use existing data files to manually create and run an autoqueue. This is a good way to take a collection of similar data files and perform the same analysis on each one.

(1) Create an Analysis Macro:

The first thing you need to do is to open the Universal Analysis program to create the macro that will be used to analyze your data files. For this macro to work successfully, it must start with an "Open File" step (File/Open). When you create the macro you should use a file similar to the type to be autoanalyzed (e.g., DSC, MDSC, TGA, etc.). Later, when the experiment is complete, the autoanalysis record (containing the finished data filenames) will be appended to the autoqueue.

(2) Manually Create an Autoqueue:

Open the Universal Analysis program. Select Macros/Autoqueue to open the Autoqueue window (shown in the figure on the next page). This window should be empty if there are no records currently in the autoqueue. If there are records in the autoqueue already, you can either delete them or append your new records to the existing list.

![Autoqueue Window](image)

Figure 8.21
Autoqueue Window
To create a new record, select **Edit/Append** from the **Autoqueue** menu. The **Autoqueue Parameters** window (shown in the figure below) is displayed. Use the Browse button to locate the first data file you want to add to the queue. Use the second Browse button to locate the macro file used in step (1) on the previous page. Click on the arrow next to the list of macros and select the macro created in step (1). Click the OK button. Your new record will be created and appended to the list (if any) in the autoqueue. You can reorder the list of records using the cut and paste options found in the **Edit** menu.

![Autoqueue Parameters Window](image)

**Figure 8.22**
*Autoqueue Parameters Window*

When you have finished adding all the records that you want, select **File/Run** from the **Autoqueue** menu. The data files will be automatically processed (autoanalyzed) beginning with the first record. The results will be collected in the Autoqueue Log.

**NOTE:**

To stop autoanalysis of the autoqueue, press the Escape key.
Using the Autoqueue File Menu

When you select Macros/Autoqueue from the main menu, the Autoqueue window is displayed. This shows you a list of the records available in the autoqueue. You can then perform various functions on these records using the Autoqueue menus, File and Edit. Use the Autoqueue Help menu to access help for the autoqueue functions. The File menu (shown here) is used to perform various functions using the entire autoqueue file (AutoQ.txt).

The following pages describe, in detail, what you need to do to use the Autoqueue File functions.

Running the Autoqueue

To process (autoanalyze) the records contained in the autoqueue, beginning with the first record, select File/Run from the Autoqueue window. Each record will be processed using the data file and macro named. The results of the analysis will be gathered into the Autoqueue Log.

**NOTE:** To stop autoanalysis of the autoqueue, press the Escape key.

Automatically Running the Autoqueue

The File/Auto Run menu item toggles on and off (check/uncheck) to select or cancel the time out feature used for automatic processing (autoanalysis) of the autoqueue records. The Auto Run feature works as follows:

**With Universal Analysis Open:**

- If Auto Run is checked, the Autoqueue Process message that appears (shown here), prompting you to process new records added to the autoqueue, will automatically time out after 60 seconds and the autoqueue records will be processed. When you check this option, Universal Analysis will be taken over (after the time out) to allow the autoanalysis of the autoqueue records.
• If **Auto Run** is not checked, the Autoqueue Process message that appears, prompting you to process new records added to the autoqueue, will not time out after 60 seconds. The message will be displayed indefinitely, until you select either Yes or No. This allows you to continue to work in Universal Analysis when No is the response to the message.

**With Universal Analysis Closed:**

The **Auto Run** feature has no effect. The controller will automatically open Universal Analysis and process the autoqueue when needed.

**Importing an Autoqueue File**

To import records from an exported (and renamed) autoqueue file into the autoqueue (AutoQ.txt), use the **Import** menu item. When you select **File/Import**, the **Import Autoqueue Records** window is displayed. This allows you to locate and open an exported autoqueue file. The imported records will be appended to the bottom of the existing records.

**NOTE:** There can only be one autoqueue file (AutoQ.txt). This is why an exported autoqueue file must be renamed.

---

**Figure 8.23**

**Import Autoqueue Records Window**
Exporting an Autoqueue File

To export the autoqueue file to save it for later recall or reuse, use the File/Export menu item. When you select Export, an Export Autoqueue Records window is displayed, allowing you to rename and save the autoqueue file. (This window is very similar to the Import Autoqueue Records window shown on the previous page.) You must rename the exported autoqueue file because there can only be one autoqueue file (AutoQ.txt).

To add the exported records back into the autoqueue, use the Autoqueue File/Import menu item.

Printing the Autoqueue

Use the File/Print command to print the autoqueue records. This command presents a Print dialog box where you may specify the range of pages to be printed, the number of copies, the destination printer, and other printer setup options. The format of the printed plot is determined by the current settings for the Printer Destination on the Export Plot window.

Print Setup for the Autoqueue

Use the File/Print Setup command to select a printer and a printer connection. This command presents a Print Setup dialog box, where you specify the printer and its connection.

Clearing the Autoqueue Log

Use the File/Clear Log command to delete all entries in the autoqueue log.
Using the Autoqueue Edit Menu

When you select Macros/Autoqueue from the main menu, the Autoqueue window is displayed. This shows you a list of the records available in the autoqueue. You can perform various functions on these records using the Autoqueue menus, File and Edit. Use the Autoqueue Help menu to access help for the autoqueue functions. The Edit menu (shown here) is used to perform various editing functions on the autoqueue records.

The following pages describe, in detail, what you need to do to use the Autoqueue Edit functions.

Cutting Autoqueue Records

To remove a selected record(s) from an autoqueue and simultaneously copy it to the clipboard for retrieval by pasting, select Edit/Cut from the Autoqueue window. This process of cutting and pasting can be used to rearrange the records contained in the autoqueue. The records are processing beginning with the first record in the list when File/Run is selected from the Autoqueue menu.

Shortcut Keys
Ctrl+X

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Click on the record(s) that you want to cut. (Use Edit/Select All to cut all records.)

3. Select Edit/Cut from the menu (or press Ctrl+X). The record will be cut from the autoqueue list and copied to the clipboard for retrieval, if desired. (Use Paste or Paste At End to retrieve the record on the clipboard.)
Copying Autoqueue Records

To copy a record(s) from the autoqueue to the clipboard for retrieval by pasting, use the Edit/Copy menu item on the Autoqueue window.

Shortcut Keys
Ctrl+C

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Click on the record(s) that you want to copy. (Use Select All to copy all records.)

3. Select Edit/Copy from the menu (or press Ctrl+C). The record will be copied to the clipboard for retrieval, if desired. (Use Paste or Paste At End to retrieve the record on the clipboard.)

Pasting Autoqueue Records

To insert a record, which was previously copied to the clipboard (using either Cut or Copy), into the autoqueue at the selected place, use the Edit/Copy menu item on the Autoqueue window.

Shortcut Keys
Ctrl+V

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Cut or copy the desired record. (Use Select All to copy all records.)

3. Click on the place where you want to insert the record(s).

4. Select Edit/Paste from the menu (or press Ctrl+V). The record will be copied from the clipboard at the numbered position selected.
Using the Autoqueue Edit Menu

Pasting Autoqueue Records at the End

To insert the record, which was previously copied to the clipboard (using either Cut or Copy), into the autoqueue at the end of the list of records, use the Edit/Paste At End menu item.

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Cut or copy the desired record(s). (Use Select All to cut/copy all records.)

3. Select Edit/Paste At End from the menu. The record(s) will be copied from the clipboard to the end of the list of records in the autoqueue.

Deleting Autoqueue Records

To delete the selected record use Edit/Delete from the Autoqueue menu. (If you want to copy a record to the clipboard rather than delete it, use the Edit/Cut option in the Autoqueue menu.)

Shortcut Key
Delete

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Click on the desired record to select it. (Use Select All to select all records.)

3. Select Edit/Delete from the menu (or press the Delete key). The record(s) will be deleted from the list of records in the autoqueue.
Selecting All Autoqueue Records

Use the **Edit/Select All** option to highlight all of the records contained in the autoqueue. You can then cut, copy, or delete all of the records.

**Shortcut Key**

Ctrl + A

To select all records follow these steps:

1. Select **Autoqueue** from the main **Macros** menu to display the Autoqueue Window.
2. Choose **Edit/Select All** to select all records.
3. Select the desired operation from the **Autoqueue Edit** menu.

Modifying Autoqueue Records

To edit a record use the **Edit/Modify** function. You can use this option to change the data file, macro file, or macro used in a particular record.

To modify a record, follow these steps:

1. Select **Autoqueue** from the main **Macros** menu to display the Autoqueue Window.
2. Click on the desired record.
3. Select **Edit/Modify** from the menu. The **Autoqueue Parameters** window is displayed to allow you to select a different data file, macro file, or macro to be used in the record. Make the desired changes, then click on OK.
Appending Autoqueue Records

To add a record to the end of the list in the autoqueue, use the Edit/Append function. You can use this option to change the data file, macro file, or macro used in an appended record.

To append a record, follow these steps:

1. Select Autoqueue from the main Macros menu to display the Autoqueue Window.

2. Select Edit/Append from the menu. The Autoqueue Parameters window is displayed to allow you to select a different data file, macro file, or macro to be used in the record or to add the record as it is shown.

![Autoqueue Parameters Window]

3. Select OK when the record appears as desired, the new record will be appended to the end of the list of records.
Using the Autoqueue Help Menu

Universal Analysis also contains a Help menu on the Autoqueue window. This allows access to several different types of help.

Select Help from the Autoqueue window and the menu shown here is displayed.

- Help Topics opens a table of contents specific to the current program. You can use the contents, index, or find functions to locate information.

- Help on Autoqueue displays the help available on how to use the Autoqueue functions.
Appending/Modifying Autoqueue Records

After you have created an Autoqueue for autoanalysis purposes, you can go back and change the records to suit your needs. Perhaps you might like to change the macro that the files will use or run the same files on a different macro. You can also append a new record to the end of the autoqueue using the steps below.

NOTE:
Some of these procedures have already been described in this chapter. This material is repeated here to show you the different ways to modify autoqueue records.

To append or change a record, follow these steps:

1. Select Macros/Autoqueue to open the Autoqueue window. You should see a list of the current records in the Autoqueue.

2. Select (highlight) the record you wish to change.

3. Select Edit/Modify from the menu (or select Edit/Append). The Autoqueue Parameters window is displayed.

4. Use the Browse button to locate the first data file you want to include in the record.

5. Use the second Browse button to locate the macro file desired.

6. Click on the arrow next to the list of macros and select the macro desired.

7. Edit the comment text, if desired. This information is for display purposes only. The comment usually (by default) reflects the date and time the record was added to the autoqueue. It can be edited as desired.

8. Click the OK button. Your record will be created or modified and placed in the autoqueue according to the function already chosen. (A modified record does not have a change in position. An appended record is added to the end of the list.)

When you have finished adding/modifying all the records that you want, select File/Run from the Autoqueue menu. The data files will be automatically processed (autoanalyzed) beginning with the first record. The results will be collected in the Autoqueue Log.

NOTE:
To stop autoanalysis of the autoqueue, press the Escape key.
Index

A

About Universal Analysis 7-4
Accept Limit 5-5
Acrobat Reader 7-6
Adjust Results 1-13
All 1-13
Alpha at X 5-24
Alpha Fit X1 5-26
Alpha X1 to X2 5-25

analysis
adjusting results 5-68 to 5-69
alpha at X 5-24
alpha fit X1 to X2 5-26
alpha X1 to X2 5-25
basic steps 5-3
curve value at X/Y 5-55
dimension change 5-27
integrate peak 5-28 to 5-38
modify size 5-19
using graphic finish 5-23
using graphic limits 5-21
using graphic start 5-22
using manual limits 5-20
onset point 5-39
oxidation time/temperature 5-40
peak max 5-38
purity 5-41, 5-43
partial area options 5-45
purity calculation page 5-46
results label page 5-49
results plot page 5-48
range 5-7 to 5-10
entering limits 5-7
full 5-7
selecting a cycle 5-8
selecting a frequency 5-9
removing results 5-69

analysis (cont’d)
residue 5-18
running integral 5-36, 5-53
setting additional parameters 5-67
setting options 5-58 to 5-68
special areas 5-64
signal max 5-38
slope 5-52
step/glass transition 5-12
choosing midpoint 5-60
choosing step change options 5-61
temperature/time at Weight % 5-16
using markers 5-10
weight at temperature/time 5-17
weight change 5-14
weight loss temperature/time 5-17

Analysis pop-up menu 5-5
Analyze menu 5-4
Annotate 1-12
annotations 4-15
repositioning 4-16

appending
records 8-55, 8-57

area correction factor 5-46
Area Percent 5-37, 5-54

Arrange Icons 2-33
array index 8-28

arrow
in annotations 4-15

ASCII format 2-26
Auto Configure 4-38

Auto Page
configuring 4-51
Index

Auto Run 8-48
Auto Scale New Data 4-12
Autoanalysis
  description 8-3
autoanalysis 8-6
automatic mode 5-12, 5-29
autoqueue 8-3
  adding records 8-45
  appending records 8-57
  creating 8-45
  creating automatically 8-45 to 8-46
  creating manually 8-46
  cutting records 8-51
  description 8-43
  exporting 8-50
  file 8-49
  how it works 8-43
  importing records 8-49
  modifying 8-57
  processing message 8-43
  printing 8-50
  processing 8-48
  running 8-48
  running automatically 8-48
  stop processing 8-47
Autoqueue Edit Menu 8-51
Autoqueue File Menu 8-48
Autoqueue Log 8-44, 8-47
  clearing 8-50
Autoqueue Parameters window 8-47
Autoqueuing 8-3
axes
  stacking on graph 4-7
Axes Page
  configuring 4-47
axis
  transformation 4-37
axis differentiators 4-25
axis names
  editing font 3-9
Axis-1,2,3 1-13
Axis/Axes 4-20

B

baseline
  adding 2-23
  linear 5-30
  sigmoidal 5-31
  sigmoidal horizontal 5-31
  sigmoidal tangent 5-32
  subtracting 2-23
  types 5-28
Baseline File 4-32
Binary format 2-26
buttons
  setting 3-5

C

Calculate peak onset versus 5-63
capture on/off 8-12
  tips on capturing 8-13
Cascade 2-32
cell constant 2-5, 2-6
Clipboard 4-54
Close 1-9
Close All 1-9
Close All Files
  inserting a step in a macro 8-35
close button 1-5
colors
  choosing 4-19 to 4-21
comments 2-6

Common Scale 4-6

case-sensitive help 7-3

copies 6-30

Copy Plot 1-12

copying
  file settings 2-7
  macros 8-39

crystallinity
  percent 5-65

cure
  percent 5-65

Curve 4-10

curve. See also graph
  labeling point 5-55
  selecting 5-3

Curve Value at X/Y 5-55

Curves 4-20

curves
  offsetting 4-52
  overlaying 4-38 to 4-54
  rotating 4-35
  smoothing 4-32

Curves Page
  configuring 4-44

Custom Report Editor
  Edit menu 6-33 to 6-42
  editing parameter-type report objects 6-37
  editing plot-type report objects 6-38
  editing text-type report objects 6-39
  example of completed report 6-24
  File menu 6-27 to 6-33
  Insert menu 6-43 to 6-48
  inserting results report object new 6-22
  printing custom report 6-28

Custom Report Editor (cont’d)
  saving a template 6-27
  setting up grid 6-31
  setting up options 6-25
  setting up printed report options 6-30
  setting up program options 6-29 to 6-33
  starting 6-22

Custom symbol list 4-20

D

data
  analyzing for purity 5-43
  choosing limits 2-18
    temperature 2-19
    with cursors 2-19
  choosing spacing between points 4-20
  collecting for purity analysis 5-42
  multiplexed 2-22, 6-7
    selecting amplitude 2-22
    selecting frequency 2-22
  set up for analysis 2-18 to 2-23
  setting limits 2-7
  showing table of 6-7

data file
  entering information 2-5 to 2-9
  graph area 1-5
  saving 2-25

data file window
  title bar 1-5

data files
  combining 2-23 to 2-25

Data Limits 4-10

data limits
  full range 2-19

Data Table 6-7
  increment 6-7
Index

designing macros 8-38
Delete Peak 5-36
Delete Results 1-13
differentiation
  choosing 4-20
Digits 4-20
Dimension Change 5-27

E
Edit Amplitude List 1-14
Edit Frequency List 1-14
Edit menu
  using 1-12
Edit menu (Report Editor) 6-16
editing
  macros 8-15 to 8-37
Enter Limits 5-7
Exact Scaling X/Y 4-6
Exclude Data 1-13
executing a macro 8-37
Exit 1-11
exotherm
  direction 2-5, 2-6, 2-8 to 2-13
expansion coefficient 5-26
export
  plots 4-54
  setting up options 3-20
Export Data File 1-10
Export Plot 1-10
Export Plot Page 3-20
exporting
  autoqueue file 8-50
  data files 2-25

F
file
  copying settings 2-7
  saving 2-25
File and Plot Signals 2-25
File menu (Report Editor) 6-14
file number 6-40, 6-42
File Signals Only 2-25
files
  switching between 2-9 to 2-10
Flat Buttons 3-5
Fly-over Help 3-5
font 6-36
Font Page 3-8
Font Window 3-11
fonts
  changing 3-8
footer
  editing font 3-10
format
  ASCII 2-26
  binary 2-26
  for plot exporting 4-55
  spreadsheet 2-26
Full Range 5-7

G
General equation 5-65
Glass Transition 5-12
Index

<table>
<thead>
<tr>
<th>Glossary</th>
<th>7-4</th>
</tr>
</thead>
<tbody>
<tr>
<td>graph. <strong>See also</strong> plot</td>
<td>4-19</td>
</tr>
<tr>
<td>choosing settings</td>
<td>4-19</td>
</tr>
<tr>
<td>enlarging area</td>
<td>4-3</td>
</tr>
<tr>
<td>parts of</td>
<td>3-9</td>
</tr>
<tr>
<td>graph area</td>
<td>1-5</td>
</tr>
<tr>
<td>Graph menu</td>
<td>4-9</td>
</tr>
<tr>
<td>graphs</td>
<td>4-15 to 4-19</td>
</tr>
<tr>
<td>customizing</td>
<td>4-3</td>
</tr>
<tr>
<td>Grid at all ticks</td>
<td>4-20</td>
</tr>
<tr>
<td>Grid at labeled ticks</td>
<td>4-20</td>
</tr>
<tr>
<td>Grid Page</td>
<td>4-50</td>
</tr>
<tr>
<td>configuring</td>
<td>4-50</td>
</tr>
<tr>
<td>Half extrapolated tangents</td>
<td>5-61</td>
</tr>
<tr>
<td>Half height</td>
<td>5-60</td>
</tr>
<tr>
<td>Half minor axis tick</td>
<td>4-52</td>
</tr>
<tr>
<td>Half width</td>
<td>5-60</td>
</tr>
<tr>
<td>header</td>
<td>3-9</td>
</tr>
<tr>
<td>editing font</td>
<td>3-9</td>
</tr>
<tr>
<td>heat capacity</td>
<td>2-15, 5-59</td>
</tr>
<tr>
<td>heat of fusion</td>
<td>5-42</td>
</tr>
<tr>
<td>Heat per mole</td>
<td>5-65</td>
</tr>
<tr>
<td>help</td>
<td>7-3</td>
</tr>
<tr>
<td>context-sensitive</td>
<td>7-3</td>
</tr>
<tr>
<td>fly-over type</td>
<td>1-6</td>
</tr>
<tr>
<td>Help menu</td>
<td>7-3</td>
</tr>
<tr>
<td>Help menu (Autoqueue)</td>
<td>8-56</td>
</tr>
<tr>
<td>Help menu (Report Editor)</td>
<td>6-20</td>
</tr>
<tr>
<td>Help Topics</td>
<td>7-3, 8-56</td>
</tr>
<tr>
<td>Hotlines</td>
<td>xiv</td>
</tr>
<tr>
<td><strong>I</strong></td>
<td></td>
</tr>
<tr>
<td>Ignore Breaks in Data</td>
<td>4-12</td>
</tr>
<tr>
<td>importing</td>
<td>8-7, 8-41</td>
</tr>
<tr>
<td>macros</td>
<td>8-7, 8-41</td>
</tr>
<tr>
<td>increment</td>
<td>6-7</td>
</tr>
<tr>
<td>Inflection</td>
<td>5-12, 5-60</td>
</tr>
<tr>
<td>Insert menu (Report Editor)</td>
<td>6-19</td>
</tr>
<tr>
<td>inserting initialization step</td>
<td>8-22 to 8-23</td>
</tr>
<tr>
<td>macros</td>
<td>8-35</td>
</tr>
<tr>
<td>inserting Wait OK step</td>
<td>8-35</td>
</tr>
<tr>
<td>inset view</td>
<td>4-26</td>
</tr>
<tr>
<td>characteristics</td>
<td>4-26</td>
</tr>
<tr>
<td>creating</td>
<td>4-26 to 4-31</td>
</tr>
<tr>
<td>setting up</td>
<td>4-28</td>
</tr>
<tr>
<td>Instrument Parameters</td>
<td>4-9</td>
</tr>
<tr>
<td>instrument parameters</td>
<td>2-14</td>
</tr>
<tr>
<td>modifying</td>
<td>2-14</td>
</tr>
<tr>
<td>MDSC</td>
<td>2-14</td>
</tr>
<tr>
<td>Integral</td>
<td>5-37, 5-54</td>
</tr>
<tr>
<td>Integrate Peak</td>
<td>5-28 to 5-38</td>
</tr>
<tr>
<td>Integration Weight Selection</td>
<td>5-64</td>
</tr>
<tr>
<td>inverted running integral</td>
<td>5-54</td>
</tr>
<tr>
<td><strong>L</strong></td>
<td></td>
</tr>
<tr>
<td>Label at X,Y</td>
<td>5-57</td>
</tr>
<tr>
<td>Last</td>
<td>1-13</td>
</tr>
<tr>
<td>legend</td>
<td>3-10</td>
</tr>
<tr>
<td>editing font</td>
<td>3-10</td>
</tr>
<tr>
<td>repositioning</td>
<td>4-24</td>
</tr>
</tbody>
</table>
Index

Legend Page
  configuring  4-49

legends
  creating  4-22

Letters  4-20

License Agreement  iii

Licensing Agreement  ii

limits
  choosing data limits  2-18

line types
  choosing  4-19 to 4-21

Linear Transform X Axis  4-31

Linear Transform Y Axis  4-31

linear transformation  4-37

loading
  macros  8-42

M

Macro Information window  8-10

macros  8-3
  capturing dialogs  8-13
  capturing labels  8-13
  capturing menus  8-13
  capturing print step  8-14
  capturing settings  8-13
  copying  8-39
  copying a step  8-16
  creating a new one  8-10 to 8-12
  cutting a step  8-16
  debugging  8-38
  deleting  8-40
  description  8-3
  editing  8-15 to 8-37
    cutting a step  8-16
    deleting a step  8-17 to 8-18
    deleting all steps  8-18
    deleting from a step to the end  8-18
    modifying a step  8-18 to 8-20
    pasting a step  8-17
  editing menu  8-16 to 8-22

macros (cont’d)
  importing  8-41
  inserting
    assign variable  8-28
    beeps  8-34
    clipboard variables  8-27
    delays  8-34
    dialogs  8-23 to 8-27
    dialogs, actions  8-25
    dialogs, message responses  8-24
    dialogs, types  8-24
    exit program step  8-36
    file names  8-32
    initialization step  8-22 to 8-23
    jumps  8-32
    stop macro step  8-36
    Wait OK  8-35
  loading  8-42
  managing  8-39
  menu  8-6
    Copy  8-6
    Delete All  8-7
    Import  8-7
    Macro Editor  8-9
    Print Setup  8-7
    Single Step  8-8
    Stop  8-8
  number available  8-3
  number of defined variables  8-5
  opening  8-39
  pasting a step  8-17
  running  8-37 to 8-38
  saving  8-42
  selecting  8-39
  stopping  8-38
  tips on capturing  8-13
  turning capture function on/off  8-12
  variables  8-5

Macros/Save  8-42

Macros/Save As  8-42

main menu
  description  1-5
  description of options  1-7
  using  1-7

Thermal Advantage Universal Analysis Operator’s Manual
Main Options
  Data Page 3-14
  Directories Page 3-22
  Export Plot Page 3-20
  Font Page 3-8
  Initialization Page 3-24
  Other Page 3-18
  Pop-up Menu Page 3-7
  Tool Bar Page 3-3

Major axis tick 4-52

Managing
  macros 8-39

Manual 4-5

Manual
  obtaining printed 7-6

Manual Limits 5-5

Manual mode 5-12, 5-29

Manual Onset tangent selection 5-62

Manual Rescaling 4-7

Manual Setup 4-38

Manual tangent selection 5-58

Markers
  activating 5-11
  moving 5-11
  tips on using 5-10

Maximize button 1-5

Maximum
  peak 5-38
  signal 5-38

MDSC
  modifying instrument parameters 2-14
  phase correction 2-15 to 2-18

Menu (cont’d)
  Autoqueue File menu 8-48
  Autoqueue Help menu 8-56
  Edit 1-7
  File 1-7
    description 1-9
    using 1-9 to 1-12
  Graph 1-7
    using 4-9
  Help 1-8, 7-3, 8-56
  Macro Edit 8-16 to 8-22
  Macro Insert 8-22 to 8-39
  Macros 8-6
  pop-up (main)
    customizing 3-6
  Rescale 1-7
    using 4-5 to 4-8
  Tools 1-8
    using 4-31
  View 1-8, 6-4
  Windows 1-8

Menus
  capturing filenames 8-13

Method 2-5, 2-6

Method Log 6-10

Microsoft Excel® 6-41

Microsoft Word® template 6-28

Midpoint 5-59

Midpoint
  choosing 5-60

Minimize button 1-5

Minor axis tick 4-52

Modify Size 5-19

Modifying
  autoqueue records 8-57

Module Type 2-5

Multicolor table 4-23

Multicolor text 4-23
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>N</strong></td>
</tr>
<tr>
<td>No area</td>
</tr>
<tr>
<td>No grid</td>
</tr>
<tr>
<td>No symbols</td>
</tr>
<tr>
<td>Notes, Cautions, and Warnings</td>
</tr>
<tr>
<td>Notes, cautions, and warnings</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>O</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>object. See report object</td>
</tr>
<tr>
<td>offset</td>
</tr>
<tr>
<td>auto</td>
</tr>
<tr>
<td>Onset</td>
</tr>
<tr>
<td>Onset Point</td>
</tr>
<tr>
<td>Onset/Peak Integration Page</td>
</tr>
<tr>
<td>Open</td>
</tr>
<tr>
<td>opening a macro</td>
</tr>
<tr>
<td>operations</td>
</tr>
<tr>
<td>assign variable</td>
</tr>
<tr>
<td>operator</td>
</tr>
<tr>
<td>options</td>
</tr>
<tr>
<td>setting up export</td>
</tr>
<tr>
<td>setting up print</td>
</tr>
<tr>
<td>Options (Graph)</td>
</tr>
<tr>
<td>Options (Main)</td>
</tr>
<tr>
<td>Options menu</td>
</tr>
<tr>
<td>Other Page</td>
</tr>
<tr>
<td>Overlay</td>
</tr>
<tr>
<td>overlaying</td>
</tr>
<tr>
<td>curves</td>
</tr>
<tr>
<td>adding curves</td>
</tr>
<tr>
<td>options</td>
</tr>
</tbody>
</table>

| Oxidation induction time (OIT) | 5-40 |
| Oxidation temperature (OT) | 5-40 |
| Oxidation Time/Temp | 5-40 |

<table>
<thead>
<tr>
<th><strong>P</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Block</td>
</tr>
<tr>
<td>parameter block</td>
</tr>
<tr>
<td>editing</td>
</tr>
<tr>
<td>parameters</td>
</tr>
<tr>
<td>modifying instrument</td>
</tr>
<tr>
<td>MDSC</td>
</tr>
<tr>
<td>saving for program</td>
</tr>
<tr>
<td>Params Same As</td>
</tr>
<tr>
<td>partial area analysis options</td>
</tr>
<tr>
<td>partial area page</td>
</tr>
<tr>
<td>peak</td>
</tr>
<tr>
<td>integration</td>
</tr>
<tr>
<td>deleting</td>
</tr>
<tr>
<td>linear baseline</td>
</tr>
<tr>
<td>perpendicular drop</td>
</tr>
<tr>
<td>running integral</td>
</tr>
<tr>
<td>setting options for</td>
</tr>
<tr>
<td>setting special areas for</td>
</tr>
<tr>
<td>sigmoidal horizontal</td>
</tr>
<tr>
<td>sigmoidal tangent</td>
</tr>
<tr>
<td>tangent</td>
</tr>
<tr>
<td>onset</td>
</tr>
<tr>
<td>peak integration</td>
</tr>
<tr>
<td>additional</td>
</tr>
<tr>
<td>first time</td>
</tr>
<tr>
<td>Peak Max</td>
</tr>
<tr>
<td>penalty factor</td>
</tr>
<tr>
<td>Percent crystallinity</td>
</tr>
<tr>
<td>Percent cure</td>
</tr>
</tbody>
</table>
Percent of axis range 4-52
Perpendicular Drop 5-34
phase correction
   MDSC 2-15 to 2-18
   range 2-16
phase lag 2-15, 2-16
plot
   creating legends 4-22
   exporting
      formats used 4-55
      to clipboard 4-55
   heading 4-48
   rescaling
      using zoom box 4-3 to 4-4
   setting up export options 3-20
Plot Full Range 4-11
Plot Heading Page
   configuring 4-48
Plot Legend 4-11
Plot Signals Only 2-25
point labeling 5-55
Poisson's Ratio
   modifying instrument parameters 2-15
pop-up menu
   customizing 3-6
Pop-up Menu Page 3-7
Previous Limits 4-5
Print 1-10
print
   preview 4-57
   setting up options 3-26
Print Preview 1-11
Print Setup 1-10
print setup 4-57
   for autoqueue 8-50
printing
   manual 7-6
   plots 4-57
program
   introduction 1-3
   options 3-3
   saving parameters 3-27
purge gas 2-17
Purity analysis 5-41 to 5-52
purity calculation page 5-46
R
range
   analysis 5-7 to 5-10
records
   added to autoqueue 8-45
   appending 8-55, 8-57
   copying for autoqueue 8-52
   deleting from autoqueue 8-53
   importing 8-49
   modifying 8-54, 8-57
   pasting to autoqueue 8-52, 8-53
   printing 8-50
   processing 8-47
   selecting all 8-54
Refresh 4-10
Remove Analysis 1-9
Remove Shifts 4-31
Reopen 1-9
report
   adding to one file 6-19
   data table 6-7
   editing text font 3-10
   method log 6-10
   parameter block 6-9
   results of analysis 6-4
   setting up options for custom reports 6-30
   setting up options for custom
      spreadsheets 6-31
Index

Report Editor program
  File menu 6-14
  Help menu 6-20
  Insert menu 6-19
  menu 6-14
  report heading 6-20
  using 6-14 to 6-21

Report Heading 6-20

report object
  aligning 6-42
  box 6-32
  editing file numbers 6-40
  editing font 6-36
  editing parameters 6-36
  editing parameters for spreadsheets 6-41
  editing position 6-35
  inserting data table report type 6-44
  inserting data table spreadsheet type 6-44
  inserting image type 6-46
  inserting method log type 6-45
  inserting normal plot type 6-46
  inserting overlay plot type 6-46
  inserting parameter report type 6-45
  inserting parameter spreadsheet type 6-45
  inserting results report type 6-44
  inserting results spreadsheet type 6-44
  inserting text type 6-47
  locking position 6-42
  send to back 6-41

rescale
  reversing 4-4
  using zoom box 4-3

Rescale menu
  using 4-5 to 4-8

Residue 5-18

results
  editing font 3-10
  results label page 5-49
  results labels for purity analysis 5-50
  results plot options 5-48
  Results Report 6-4

Rotate 4-31
  rotating curves 4-35
  running a macro 8-37 to 8-38

Running Integral 5-36, 5-53
  types
    area percent 5-54
    inverted 5-54
    normal 5-54
    normalized 5-54

S
  sample name 2-5
  sample size 2-5
  sample weight
    modifying 5-19
    restoring 5-19
  Save Analysis 1-9
  Save Session 1-9
  saving
    macros 8-42
  Select 1-13
  Select All Labels 1-12
  Select Cycle 5-8
  Select Frequency 5-9
  selecting a macro 8-39
  settings
    copying 2-7
  Shift 4-31
  shifting curves 4-33
  Show Tool Bar 3-5
  Sig Horizontal 5-31
  Sig Tangent 5-32

I-10 Thermal Advantage Universal Analysis Operator’s Manual
<table>
<thead>
<tr>
<th>Term</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>sigmoidal horizontal baseline</td>
<td>5-31</td>
</tr>
<tr>
<td>signal</td>
<td></td>
</tr>
<tr>
<td>determining maximum</td>
<td>5-38</td>
</tr>
<tr>
<td>Signal Max</td>
<td>5-38</td>
</tr>
<tr>
<td>signals</td>
<td></td>
</tr>
<tr>
<td>selecting</td>
<td>2-10 to 2-12</td>
</tr>
<tr>
<td>size</td>
<td></td>
</tr>
<tr>
<td>restoring</td>
<td>5-19</td>
</tr>
<tr>
<td>Slope</td>
<td>5-52</td>
</tr>
<tr>
<td>Smooth</td>
<td>4-31</td>
</tr>
<tr>
<td>smoothing</td>
<td>2-11</td>
</tr>
<tr>
<td>smoothing interval</td>
<td>4-32</td>
</tr>
<tr>
<td>software</td>
<td></td>
</tr>
<tr>
<td>license</td>
<td>iii</td>
</tr>
<tr>
<td>spacing</td>
<td></td>
</tr>
<tr>
<td>choosing</td>
<td>4-20</td>
</tr>
<tr>
<td>Special Area Page</td>
<td>5-64</td>
</tr>
<tr>
<td>spread sheet format</td>
<td>2-26</td>
</tr>
<tr>
<td>spreadsheet object</td>
<td>6-41</td>
</tr>
<tr>
<td>spreadsheet objects</td>
<td>6-31</td>
</tr>
<tr>
<td>spreadsheet view</td>
<td></td>
</tr>
<tr>
<td>4-13 to 4-14</td>
<td></td>
</tr>
<tr>
<td>characteristics</td>
<td>4-13</td>
</tr>
<tr>
<td>copying values into rows, columns, regions</td>
<td>4-14</td>
</tr>
<tr>
<td>modifying cell values</td>
<td>4-13</td>
</tr>
<tr>
<td>selecting rows, columns, regions</td>
<td>4-13</td>
</tr>
<tr>
<td>Stack Axes</td>
<td>4-6</td>
</tr>
<tr>
<td>stacked axes</td>
<td></td>
</tr>
<tr>
<td>example</td>
<td>4-7</td>
</tr>
<tr>
<td>step change</td>
<td>5-61</td>
</tr>
<tr>
<td>Step change between</td>
<td>5-59</td>
</tr>
<tr>
<td>Step Transition</td>
<td>5-12</td>
</tr>
<tr>
<td>setting options for</td>
<td>5-58</td>
</tr>
<tr>
<td>Step Transition Page</td>
<td>5-58, 5-61</td>
</tr>
<tr>
<td>stopping a macro</td>
<td>8-38</td>
</tr>
<tr>
<td>Subcurves</td>
<td>4-20</td>
</tr>
<tr>
<td>symbol type</td>
<td></td>
</tr>
<tr>
<td>choosing</td>
<td>4-20</td>
</tr>
<tr>
<td>symbols</td>
<td></td>
</tr>
<tr>
<td>choosing</td>
<td>4-19 to 4-21</td>
</tr>
<tr>
<td>editing font</td>
<td>3-10</td>
</tr>
<tr>
<td>spacing</td>
<td></td>
</tr>
<tr>
<td>coarse</td>
<td>4-20</td>
</tr>
<tr>
<td>every point</td>
<td>4-20</td>
</tr>
<tr>
<td>fine</td>
<td>4-20</td>
</tr>
<tr>
<td>medium</td>
<td>4-20</td>
</tr>
<tr>
<td>using in curves</td>
<td>4-25 to 4-26</td>
</tr>
<tr>
<td>TA Instruments</td>
<td></td>
</tr>
<tr>
<td>contacting</td>
<td>7-7</td>
</tr>
<tr>
<td>phone numbers</td>
<td>xiv</td>
</tr>
<tr>
<td>Tangent</td>
<td>5-35</td>
</tr>
<tr>
<td>Temp/Time at Weight %</td>
<td>5-16</td>
</tr>
<tr>
<td>Temperature Base</td>
<td>2-24</td>
</tr>
<tr>
<td>template</td>
<td></td>
</tr>
<tr>
<td>creating</td>
<td>6-23</td>
</tr>
<tr>
<td>editing object boxes</td>
<td>6-34</td>
</tr>
<tr>
<td>editing objects</td>
<td>6-33</td>
</tr>
<tr>
<td>example</td>
<td>6-23</td>
</tr>
<tr>
<td>exporting report to Word</td>
<td>6-28</td>
</tr>
<tr>
<td>formatting</td>
<td>6-25</td>
</tr>
<tr>
<td>tick labels</td>
<td></td>
</tr>
<tr>
<td>editing font</td>
<td>3-10</td>
</tr>
<tr>
<td>Tile</td>
<td>2-31</td>
</tr>
<tr>
<td>Time Base</td>
<td>2-23</td>
</tr>
<tr>
<td>Time of Day format</td>
<td>3-18</td>
</tr>
<tr>
<td>title bar</td>
<td></td>
</tr>
<tr>
<td>data file window</td>
<td>1-5</td>
</tr>
<tr>
<td>title bar icon</td>
<td>1-5</td>
</tr>
</tbody>
</table>
Index

V

van’t Hoff equation 5-41, 5-43

variable
definition 8-5, 8-28
naming 8-5
operations 8-29
testing 8-30

V

V

W

Wait Accept Limits
inserting in a macro step 8-35

Weight At Temp/Time 5-17

Weight Change 5-14

Weight Loss Temp/Time 5-17

window
parts of 1-4
Report Editor 6-4

window title bar 1-5

windows
arranging 2-31
sizing 2-31

Windows menu
using 2-31

W

W

x

X Axis 4-10

Y

Y Axis 4-10

y-axis
selecting 4-14 to 4-17

Year format 3-19

Z

zoom box
example 4-3
using to rescale 4-3

Zoom Out 4-5